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Product description

The Oncomine™ Precision Assay GX (Cat. No. A46291) enables simultaneous detection of biomarkers
across 50 genes, including key targets within EGFR, BRAF, KRAS, ALK, ROS1, NTRK, RET, HER2,
and others, from solid tissue and liquid biopsy samples. The Oncomine™ Precision Assay GX uses

a synchronous approach for detecting prevalent fusion isoforms and potential novel fusions. The
following types of gene fusions can be detected using FusionSync™ Detection Technology.

* Targeted designs for known fusion isoforms, including prevalent isoforms such as EML4-ALK,
ETV6-NTRKS, and KIF5B-RET.

* Novel combinations of any driver and partner genes included in the panel.

* Novel fusion isoforms of key driver genes using the exon tiling imbalance method.
Each kit provides the targeted pan-cancer panel and library reagents sufficient to perform up to
32 sequencing reactions on the Genexus™ Integrated Sequencer, using the GX5™ Chip (see “Contents
and storage” on page 10). Additional Genexus™ Integrated Sequencer reagents and supplies must
be ordered separately (see “Required materials not supplied for use with the Genexus™ Integrated
Sequencer” on page 12).
This user guide provides the following instructions.

* How to use the Oncomine™ Precision Assay GX to perform a Sample to Result next-generation
sequencing (NGS) run on the lon Torrent™ Genexus™ Purification System for nucleic acid isolation,
followed by sequencing on the Genexus™ Integrated Sequencer.

* How to use the Oncomine™ Precision Assay GX to perform a Nucleic Acid to Result next-
generation sequencing (NGS) run on the Genexus™ Integrated Sequencer.

* How to perform data analysis of the sequencing run.

IMPORTANT! When using the Oncomine™ Precision Assay GX, genomic coverage of the assay does
not ensure that all variants present in those genomic regions will be detected by the assay.

The Genexus™ Purification System automates the extraction and quantification of nucleic acids from
various tissue types for use on the Genexus™ Integrated Sequencer. With a single touch point and
10 minutes of hands-on time, the Genexus™ Purification System can extract both DNA and RNA
sequentially from FFPE lysates (lon Torrent™ Genexus™ FFPE DNA and RNA Purification Kit) and
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Product description

from cell-free plasma from whole blood samples (lon Torrent™ Genexus™ Cell-Free Total Nucleic Acid
Purification Kit). When connected to the Genexus™ Integrated Sequencer, the lon Torrent™ Genexus™
Software streamlines the NGS workflow by integrating the sample-to-result workflow within a single
software system.

The Oncomine™ Precision Assay GX includes the following features.
* Compatibility with both FFPE tissue and plasma sample types
¢ Compatibility with as little as 20 ng nucleic acid input per pool from cfTNA samples

* Detection of hotspot mutations (substitutions, insertions, and deletions), copy number variations
(CNVs), and gene fusions across 50 cancer driver genes in the FFPE assay and cfTNA assay
workflows.

* FFPE assay workflow can also report non-hotspot mutations detected in the sample, when using
FFPE assay definition file (ADF) w3.4.2. Non-hotspot mutation detection is not enabled for earlier
FFPE assay ADF versions or any cfTNA assay ADF versions. For more information see “Oncomine™
Precision Assay GX” on page 171.

* Sensitive and specific low-level variant detection using lon AmpliSeq™ HD chemistry

Oncomine™ Precision Assay GX User Guide 9
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Contents and storage

Contents and storage

The Oncomine™ Precision Assay GX (Cat.

No. A46291) includes the OPA Pool 1 panel, Genexus™

Strip 1, and Genexus™ Strip 2-HD sufficient for up to 32 reactions. The OPA Pool 1 panel is provided in
8 pairs of tubes, where each tube pair contains one tube with forward (FWD) primers and one tube with
reverse (REV) primers. If needed, the Genexus™ Library Strips 1 and 2-HD combo kit (Cat. No. A40255)

can be ordered separately.

Contents

Carrier color Amount Part No. Storage

OPA Pool 1

FWD primers (position 1, amber tube)

Magenta 8 x 2 tubes!'l, | A44350 | -30°C to -10°C

REV primers (position 2, natural tube) 50 pl/tube

Genexus™ Library Strips 1 and 2-HD (Cat. No. A40255)

Genexus™ Strip 12 Light red 8 strips A46812 2°C to 8°C
Genexus™ Strip 2-HD! Violet 8 strips A46814 | -30°Cto -10°C

[ 4 reactions/tube pair
@l 4 reactions/strip

The maximum number of samples that can be analyzed per kit depends on the assay workflow

performed.

Workflow

# of samples

Simultaneous DNA- and RNA-based variant analysis | up to 16 FFPE tissue samples

(one DNA reaction and one RNA reaction per sample)

DNA-only or RNA-only variant analysis

up to 32 FFPE tissue samples

Cell-free TNA variant analysis
(combined DNA and RNA)

up to 24 plasma samples

Genexus™ Controls

Contact support for information about controls for the Oncomine™ Precision Assay GX.

10
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Workflow overview

Oncomine™ Precision Assay GX workflow

Enter samples (page 34)

Enter samples in the Genexus™ Software to assign sample names and
provide other information such as sample collection date, gender, type,
and disease category. An assay is assigned to each sample.

Plan a run (page 35 or page 38) N

Runs that are planned in Genexus™ Software contain the settings that are
used in library preparation, templating, sequencing, and analysis, including
sample information and plate location, assays, and barcodes.

Prepare samples

* Genexus™ FFPE DNA and RNA Purification—See Chapter 5,
“Genexus™ FFPE DNA and RNA Purification protocol”.

® Genexus™ Cell-Free Total Nucleic Acid Purification—See Chapter 6,
“Genexus™ Cell-Free Total Nucleic Acid Purification protocol”.

Note: You can also prepare samples manually. Proceed to the next step.

Dilute the samples and load the sample plate
(page 98)
Note: This step is not required for Sample to Result runs.

Quantify and dilute the nucleic acid samples, then load samples and
controls (optional) onto the sample plate.

Load the sequencer and start a run (page 109)

Follow the step-by-step instructions on the sequencer touch screen to load
the sample plate and consumables in the Genexus™ Integrated Sequencer.

Review results (page 126) m -

Review data and results in Genexus™ Software.

Oncomine™ Precision Assay GX User Guide 11
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This chapter lists the reagents, supplies, and materials needed to operate the Genexus™ Purification
System and Genexus™ Integrated Sequencer, and provides consumables ordering and storage
information. Reagents and supplies can be ordered as kits and starter packs, but most consumables
can also be ordered individually as your needs require.

Note: Consumables that have catalog numbers are orderable. Components that have part numbers
cannot be ordered individually.

Genexus™ Integrated Sequencer

Components Cat. No.

Genexus™ Integrated Sequencer A45727

Required materials not supplied for use with the Genexus™
Integrated Sequencer

12

Genexus™ Integrated Sequencer reagents and supplies can be ordered as kits and starter packs. In
addition, most consumables can also be ordered individually. This section provides information about
the various ordering options.

Note: Consumables that have catalog numbers are orderable. Components that have part numbers
cannot be ordered individually.

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates
that the material is available from fisherscientific.com or another major laboratory supplier. Catalog
numbers that appear as links open the web pages for those products.

Oncomine™ Precision Assay GX User Guide
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Required materials not supplied for use with the Genexus™ Integrated Sequencer

lon Torrent™ Genexus™ Barcodes 1-32 HD are supplied in a plate containing 32 dual barcodes.

Item

Label color

Cat. No.

Quantity

Storage

Genexus™ Barcodes 1-32 HD

Purple

A40261

1 plate

15°C to 30°C

Genexus™ Templating Strips 3-GX5™ and 4

lon Torrent™ Genexus™ Templating Strips 3-GX5™ and 4 (Cat. No. A40263) are ordered as kits with

8 pairs of strips per Kkit.

Component Carrier color | Part No. | Quantity per kit Storage
Genexus™ Strip 3-GX5™ Brown A46815 8 strips 2°C to 8°C
Yellow A46816 8 strips -30°C to -10°C

Genexus™ Pipette Tips

lon Torrent™ Genexus™ Pipette Tips (Cat. No. A40266) are ordered in packs of 12 racks each. The
number of pipette tip racks that are required for your experiment depends on the number of reactions
and the sample type. For the Oncomine™ Precision Assay GX, 1 rack is sufficient for up to 6 reactions

for FFPE samples or 2 reactions for cfTNA samples.

ltem

Cat. No.

Quantity

Storage

Genexus™ Pipette Tips

A40266

12 racks

15°C to 30°C

Genexus™ Conical Bottles

Genexus™ Conical Bottles (Cat. No. A40275) are installed in the sequencing reagents bay and serve as
reservoirs for nucleotide reagent dilutions. For information on when and how to replace the bottles, see

the Genexus™ Integrated Sequencer User Guide (Pub. No. MAN0017910).

Component

Quantity

Storage

Genexus™ Conical Bottles

5 bottles

15°C to 30°C

Oncomine™ Precision Assay GX User Guide
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Required materials not supplied for use with the Genexus™ Integrated Sequencer

Genexus™ Primer Pool Tube Holder

The Genexus™ Primer Pool Tube Holder (Cat. No. A40004840) is used to help prevent the lifting of
Genexus™ Primer Pool Tubes during a sequencing run.

Item Cat. No. Quantity

Genexus™ Primer Pool Tube Holder A40004840 1

GX5™ Chip and Genexus™ Coupler

The GX5™ Chip and Genexus™ Coupler (Cat. No. A40269) are ordered as a set that contains two chips
and two couplers. For the Oncomine™ Precision Assay GX, 1 chip is sufficient for sequencing up to
6 cfTNA samples, 16 FFPE DNA+RNA samples, or 32 FFPE DNA-only or RNA-only samples.

Component Part No. | Quantity Storage

GX5™ Chip 100081364 | 2 chips |15°C to 30°C

ion torrent 6%xAOxO+%

Genexus™ Coupler 100081252 | 2 couplers

14 Oncomine™ Precision Assay GX User Guide
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General laboratory supplies and reagents

Genexus™ Sequencing Kit

The lon Torrent™ Genexus™ Sequencing Kit (Cat. No. A40271) provides reagents and solutions sufficient
to sequence up to 2 full chips.

Component Part No. Quantity Storage

Genexus™ Cartridge A40272 2 cartridges -30°C to -10°C

Genexus™ Bottle 2 A40273 4 bottles 15°C to 30°C

Genexus™ Bottles 1 and 3 A40274 2 bottles each
(4 bottles total)

General laboratory supplies and reagents

Item Source
MicroAmp™ EnduraPlate™ Optical 96-Well Clear Reaction Plates with Barcode 4483352, 4483354
Thermo Scientific™ Adhesive PCR Plate Foils AB0626
Microcentrifugel'] MLS
2-, 20-, 200-, and 1,000-pL pipettes and appropriate filtered tips MLS
Nuclease-free microcentrifuge tubes, 1.5-mL or 1.7-mL MLS
Vortex mixer with a rubber platform MLS
Gloves, powder-free nitrile MLS
Ice buckets and ice —
Nuclease-free water, molecular biology grade MLS
Isopropyl alcohol, 70% solution MLS
Wipes, disposable lint-free MLS
DNAZap™ PCR DNA Degradation Solutions AM9890
RNaseZap™ RNase Decontamination Solution AM9780

Oncomine™ Precision Assay GX User Guide 15
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Genexus™ Furification System

(continued)

Item Source
RNase AWAY™ Surface Decontaminant 7005-11
(Optional) Uninterruptible Power Supply (UPS)[2] MLS

[ Must fit standard 0.2- and 1.5-mL microcentrifuge tubes and generate 15,000 x g. To convert the RPMs of your centrifuge to RCF in
units of gravity, see tools.thermofisher.com/content/sfs/brochures/TR0040-Centrifuge-speed.pdf.

' For laboratories that experience frequent power outages or line voltage fluctuations, we recommend that you use an uninterruptible
power supply that is compatible with 2500 W output or higher.

Genexus™ Purification System

The Genexus™ Purification System (Cat. No. A48148) includes the following components.

Components Part. No.
Genexus™ Purification System A47646
Genexus™ Purification System Install Kit A485491

' Not available for separate purchase.

Reagents and supplies for use with the Genexus™ Purification System

Genexus™ Purification System reagents and supplies can be ordered as kits and starter packs, but
most consumables can also be ordered individually as your needs require.

Note: Consumables that have catalog numbers are orderable. Components that have part numbers
cannot be ordered individually.

lon Torrent™ Genexus™ FFPE DNA and RNA Purification Kit

The lon Torrent™ Genexus™ FFPE DNA and RNA Purification Kit (Cat. No. A45539) includes the
following subkits sufficient for 48 sequential DNA and RNA isolations from FFPE curls or slides.

IMPORTANT! Store all kit components in the upright orientation.

Component Part No. Storage
Genexus™ FFPE DNA and RNA Purification A45532 15°C to 30°C
Genexus™ Nucleic Acid Quantitation A45538 2°Cto 8°C
Genexus™ Purification Supplies 2 A45574 15°C to 30°C

16 Oncomine™ Precision Assay GX User Guide
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Genexus™ Furification System

Genexus™ FFPE DNA and RNA Purification kit

The Genexus™ FFPE DNA and RNA Purification kit (Part No. A45532) includes sufficient reagents and
consumables for 48 sequential DNA and RNA isolations.

IMPORTANT! Store all kit components in the upright orientation.

Component Quantity Storage

FFPE DNA and RNA Purification Plate 1 4 plates 15°C to 30°C
FFPE DNA and RNA Purification Plate 2 4 plates

12-Well Tip Comb 4 each

DNase (yellow cap) 115 uL

DNase Buffer (blue cap) 4x1.2mL

Proteinase K (red cap) 1.2mL

FFPE Protease Buffer 15 mL

Genexus™ Nucleic Acid Quantitation kit

The Genexus™ Nucleic Acid Quantitation kit (Part No. A45538) includes sufficient consumables for
48 DNA and 48 RNA quantitations.

IMPORTANT! Store all kit components in the upright orientation.

Component Quantity Storage
Quantitation Platel] 4 plates 2°C to 8°C
Quantitation Tubel?! 4 each 15°C to 30°C

[ Store the Quantitation Plate in the dark to prevent photobleaching of the preloaded reagents.
[l Can be stored at 15°C to 30°C upon receipt.

Genexus™ Purification Supplies 2 kit

The Genexus™ Purification Supplies 2 kit (Part No. A45574) includes sufficient consumables for

48 isolations.

Component Quantity Storage
48-Well Nucleic Acid Archive Plate 4 plates 15°C to 30°C
48-Well Nucleic Acid Archive Plate Seal 4 each
Purification Tip Cartridge 8 each

Oncomine™ Precision Assay GX User Guide 17
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Genexus™ Furification System

lon Torrent™ Genexus™ Cell-Free Total Nucleic Acid Purification Kit

The lon Torrent™ Genexus™ Cell-Free Total Nucleic Acid Purification Kit (Cat. No. A45542) includes the

following subkits sufficient for 24 cell-free total nucleic acid (cfTNA) isolations from whole blood or
cell-free plasma samples.

IMPORTANT! Store all kit components in the upright orientation.

Component Part No. Storage
Genexus™ Cell-Free Total Nucleic Acid Purification A45535 15°C to 30°C
Genexus™ Nucleic Acid Quantitation A45538 2°Cto 8°C
Genexus™ Purification Supplies 1 A45529 15°C to 30°C

Genexus™ Cell-Free Total Nucleic Acid Purification kit

The Genexus™ Cell-Free Total Nucleic Acid Purification kit (Part No. A45535) includes sufficient reagents
and consumables for 24 cell-free total nucleic acid (cfTNA) isolations.

IMPORTANT! Store all kit components in the upright orientation.

Component Quantity Storage

Cell-Free Total Nucleic Acid Purification Plate 1 4 plates 15°C to 30°C
Cell-Free Total Nucleic Acid Purification Plate 2 4 plates

Cell-Free Total Nucleic Acid Purification Plate 3 4 plates

6-Well Tip Comb 4 each

12-Well Tip Comb 4 each

Proteinase K (red cap) 1.2mL

cfTNA Lysis/Binding Solution 4 x 85 mL
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Genexus™ Nucleic Acid Quantitation kit
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Recommended materials not supplied for use with the Genexus™ Furification System

e

The Genexus™ Nucleic Acid Quantitation kit (Part No. A45538) includes sufficient consumables for

48 DNA and 48 RNA quantitations.

IMPORTANT! Store all kit components in the upright orientation.

Component Quantity Storage
Quantitation Platel] 4 plates 2°C to 8°C
Quantitation Tubel?! 4 each 15°C to 30°C

[ Store the Quantitation Plate in the dark to prevent photobleaching of the preloaded reagents.

[l Can be stored at 15°C to 30°C upon receipt.

Genexus™ Purification Supplies 1 kit

The Genexus™ Purification Supplies 1 kit (Part No. A45529) includes sufficient consumables for

48 isolations.

Component Quantity Storage
48-Well Nucleic Acid Archive Plate 4 plates 15°C to 30°C
48-Well Nucleic Acid Archive Plate Seal 4 each
Purification Tip Cartridge 4 each

Recommended materials not supplied for use with the

Genexus™ Purification System

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates that
the material is available from fisherscientific.com or another major laboratory supplier.

ltem

Source

Equipment

Bench top microcentrifuge

Cole-Parmer EW-17414-06
Eppendorf 022620304

1,000 pL Multichannel Pipette

MLS

Oncomine™ Precision Assay GX User Guide
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Recommended materials not supplied for use with the Genexus™ Furification System

(continued)
ltem Source
For use with Genexus™ FFPE DNA and RNA Purification Kit

Sorvall™ ST 8 Small Benchtop Centrifuge (or equivalent)], with 75007200
Thermo Scientific™ M10 Microplate Swinging Bucket Rotor (or 75005706
equivalent)?, and
Sealed Bucket; Capacity: 4 Standard or 2 Midi-Deepwell plates (Set of 2)

. 75005721
(or equivalent)

S50441A

Economy Lab Incubator (2, 60°C and 90°C)

fisherscientific.com

Heating block (2, 60°C and 90°C) MLS
Precision™ General Purpose Water Bath (or equivalent) MLS
Equipment and consumables for AutoLys M FFPE sample extraction[®
AutoLys M Tubes and Caps kit A38738
AutoLys M Tube Rack A37955
AutoLys M Tube Locking Lid A37954
AutolLys M TubelLifter or A37956
AutolLys M Tube Pliers A38261

Tubes, plates, and other consumables

MicroAmp™ EnduraPlate™ Optical 96-Well Clear Reaction Plates with
Barcode

4483354, 4483352

Adhesive PCR Plate Foils AB0626
RNAJater™ Stabilization Solution AM7020
RNaseZap™ RNase Decontamination Solution AM9780
CitriSolv™ Clearing Agent 22-143-975
Xylene MLS
Ethanol, 100% MLS

[ Centrifuge must achieve an RCF of 2000 x g, have a swinging bucket rotor and accommodate deepwell plates.

2] Swinging bucket rotor must carry deepwell plates in the landscape orientation (see page 48).

Bl For use with the Genexus™ FFPE DNA and RNA Purification Kit.
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Recommended materials for nucleic acid isolation,
quantification, and quality control

Item Source
Manual nucleic acid isolation
MagMAX™ Cell-Free Total Nucleic Acid Isolation Kit A36716
MagMAX™ FFPE DNA/RNA Ultra Kit A31881
RNaseZap™ RNase Decontamination Solution AM9780, AM9782, AM9784
Nucleic acid quantification
Qubit™ 4 Fluorometerl!l and one or more of the following kits: Q33238
* Qubit™ dsDNA HS Assay Kit (DNA samples) Q32851, Q32854
¢ Qubit™ RNA BR Assay Kit (RNA samples) Q10210, Q10211
Nucleic acid quality control
Agilent™ 2100 Bioanalyzer™ Instrument and one or more of the following kits: G2939BA
* Agilent™ High Sensitivity DNA Kit (cfTNA/FFPE DNA samples) 5067-4626
* Agilent™ RNA 6000 Nano Kit (FFPE RNA samples) 5067-1511
(Agilent)
(FFPE DNA samples only) Agilent™ 4200 TapeStation™ System and one or G2991AA
more of each of the following kits: 5067-5589
¢ Agilent™ D5000 Reagents
) 5067-5588
* Agilent™ D5000 ScreenTape (Agilent)

[ Qubit™ 2.0 Fluorometer and later are supported.

Recommended sample controls

ltem Source
FFPE DNA
Horizon™ Structural Multiplex FFPE Reference Standard HD789 (Horizon)
EGFR Gene-Specific Multiplex Reference Standard (FFPE) 5% AF HD300 (Horizon)
KRAS Gene-Specific Multiplex Reference Standard (FFPE) HD301 (Horizon)
Seraseq™ Lung & Brain CNV Mix, + 3 copies 0710-0414 (SeraCare)
Seraseq™ Breast CNV Mix, + 6 copies 0710-0412 (SeraCare)
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Recommended sample controls

(continued)
ltem Source

FFPE RNA

Seraseq™ FFPE Tumor Fusion RNA v4 Reference Material 0710-0496 (SeraCare)
Seraseq™ FFPE NTRK Fusion RNA Reference Material 0710-1031 (SeraCare)

cfTNA

Horizon™ Multiplex | cfDNA Reference Standard Set HD780 (Horizon)
Thermo Scientific™ AcroMetrix™ Multi-Analyte ctDNA Plasma Control A 957563
Thermo Scientific™ AcroMetrix™ Multi-Analyte ctDNA Plasma Control B 957564
Thermo Scientific™ AcroMetrix™ Multi-Analyte ctDNA Plasma Control C 957565
Thermo Scientific™ AcroMetrix™ Multi-Analyte ctDNA Plasma Control D 957566
Thermo Scientific™ AcroMetrix™ Multi-Analyte ctDNA Plasma Control E 957567
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Procedural requirements

IMPORTANT!
. Do NOT combine the contents of OPA Pool 1 tubes. Forward and reverse primers must

remain separate, until they are combined by the Genexus™ Integrated Sequencer as part of the
on-instrument library preparation workflow.

. Do NOT store the OPA Pool 1, Genexus™ Strip 1, and Genexus™ Strip 2-HD on the Genexus™

Integrated Sequencer for more than 24 hours before starting an instrument run.

Use only the reagents and supplies that have been validated for the Oncomine™ Precision Assay
GX. For a list of validated reagents and supplies, see Chapter 2, “Reagents, supplies, and required
materials”.

Use good laboratory practices to minimize cross-contamination of products. Keep all tubes sealed
until immediately before loading onto the Genexus™ Integrated Sequencer.

Use controls to identify or rule out reagent contamination. For a list of validated controls, see
“Recommended sample controls” on page 21.

Do not freeze-thaw the OPA Pool 1. Thaw only the number of panel tubes that are required for
a given experiment. Discard unused panel tubes after they are thawed. Store panels at —-30°C to
-10°C.

Note: One OPA Pool 1 tube pair (one tube with forward primers and one tube with reverse primers)
is sufficient for preparing up to 4 libraries.
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Guidelines for FFPE samples

For core needle biopsies and fine needle aspirates, macrodissection is not recommended due to
the limiting tissue section surface areas.

Necrotic samples: Up to 75% necrotic tissue in the region of interest does not appear to interfere
with the assay. However, we recommend that you macrodissect highly necrotic areas or select
alternate samples if possible.

Nucleic acid integrity is important for sample performance. Factors such as age of the block,
fixation process used, and sample source can impact the quality of the extracted nucleic acid.

Nucleic acid yield can be impacted by overall tissue area. If an initial extraction leads to insufficient
concentrations for DNA and RNA, repeat the extractions with more material whenever possible.

We recommend that you extract sufficient nucleic acid from samples to enable repeat sequencing
runs, if possible. This recommendation also applies to cfTNA from plasma samples.

Guidelines for RNA

Wear clean gloves and a clean lab coat.
Change gloves whenever they may be contaminated.
Open and close all sample tubes carefully. Avoid splashing or spraying samples.

Clean lab benches and equipment (including gloves, tube racks, pipettes, centrifuges, and
vortexers) with an RNase decontamination solution before and after use.

Work in a designated RNase-free pre-PCR area.
Keep RNA on ice or in a -30°C to —10°C chilled benchtop cold box during use.
Do not vortex RNA. Flick 4 times to mix, then pulse centrifuge to collect.

Guidelines for panel and reagent use and handling

24

Keep OPA Pool 1 panel tubes capped until immediately before loading in the Genexus™ Integrated
Sequencer.

Thaw positive controls on ice or at 4°C for up to 2 hours. After the positive controls are completely
thawed, vortex on a platform vortexer, then centrifuge to collect tube contents. Return to ice or 4°C
before loading into the sample plate.

IMPORTANT! Ensure that contents of the control tubes are completely thawed before adding to
the sample plate.

Equilibrate Genexus™ Strip 1, Genexus™ Strip 2-HD, and Genexus™ Strip 3-GX5™ at room
temperature for 30 minutes before loading in the sequencer.

Thaw Genexus™ Strip 4 on ice or at 4°C for 30 minutes.

IMPORTANT! Ensure that strip contents are completely thawed before loading in the sequencer.
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Guidelines for preventing contamination

* \Vortex thawed library and templating strips on a platform vortexer to dissolve precipitate and
dislodge air bubbles. After vortexing, centrifuge the strips to collect tube contents using the
Genexus™ Strip Centrifuge Adapter to hold strips during centrifugation.

IMPORTANT! Inspect the bottom of tube 3 of the Genexus™ Strip 2-HD for white precipitate
before loading it in the sequencer.

Note: For information about using the Genexus™ Strip Centrifuge Adapter, see “Centrifuge library
and templating reagent strips using the Genexus™ Strip Centrifuge Adapter” on page 112.

¢ \Verify consistency of reagent volumes across strips and panel tubes by visually inspecting them
two at a time after centrifugation. For instructions, see “Centrifuge library and templating reagent
strips using the Genexus™ Strip Centrifuge Adapter” on page 112. Alternatively, use the strip
volume guide images provided page 174 to check appropriate fill volumes of strip tubes.

* Keep thawed panel, Genexus™ Strip 4, and the sample plate on ice or at 4°C until ready to use or
load in the sequencer.

* Do not freeze-thaw the OPA Pool 1 panel tubes. Thaw only the number of panel tubes that are
needed for an instrument run. Discard unused panel tubes after they are thawed. Store panel tubes
at —-30°C to -10°C.

Note: One OPA Pool 1 panel tube pair (one tube with forward primers and one tube with reverse
primers) is sufficient for preparing up to 4 libraries.

* Do not combine the contents of OPA Pool 1 panel tubes. Forward and reverse primers must remain
separate, until they are combined by the sequencer as part of the on-instrument library preparation
workflow.

* Do not store OPA Pool 1 panel tubes or reagent strips on the sequencer for more than 24 hours
before starting an instrument run.

Guidelines for preventing contamination

We recommend following these guidelines to prevent cross-contamination of samples and controls
between and within sequencing runs.
Personal protective equipment

* Wear a laboratory coat that is reserved for sequencing work and is laundered frequently. If
possible, change to a fresh laboratory coat before setting up a run, or use new sleeve covers.

¢ Wear fresh gloves to load the instruments, including during the loading of the sequencing chip and
coupler. Do not remove gloves to install the sequencing chip.

* Change gloves between dispensing positive controls and no-template control (NTC) in sample plate
wells.
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Equipment and instrument cleaning

If you are preparing samples and sample plates in a PCR cabinet or laminar flow hood
(recommended), illuminate the hood with UV light for at least 15 minutes before use.

Before a run, decontaminate equipment or bench surfaces where samples or sample plates are
handled. Use DNAZap™ and either 1) the RNaseZap™ RNase Decontamination Solution or 2) the
RNase AWAY™ Surface Decontaminant reagent. Follow manufacturer instructions for the proper
storage and use of each decontamination reagent. Alternatively, a 10% solution of commercial
bleach can be used for decontaminating working areas and equipment. Follow with wiping of
surfaces with wipes moistened with 70% isopropanol or 70% ethanol.

Before and after a run, sequentially wipe the deck surface of the Genexus™ Purification System
and Genexus™ Integrated Sequencer with lint-free wipes moistened with the two DNAZap™
decontamination solutions followed by wipes moistened with either 1) the RNaseZap™ RNase
Decontamination Solution or 2) the RNase AWAY™ Surface Decontaminant reagent. Follow with
wiping of deck surfaces with wipes moistened with 70% isopropanol or 70% ethanol, or with
prepared alcohol wipes. The robotic pipettor arm of each instrument can also be cleaned in this
manner.

IMPORTANT! Do not spray decontamination solution or alcohol solution directly onto deck
surfaces or into deck openings. Instead, use a lint-free wipe moistened with solution to clean
surfaces. Do not use bleach to decontaminate instrument surfaces as it can cause corrosion of the
metal surfaces.

After a sequencing run has completed, ensure that you cover the PCR amplification plate with a foil
seal before removing it from the instrument to prevent library contamination.

Workflow tips

26

After dispensing a positive control or sample (if applicable) in a sample plate well, do not pass
the end of the used tip over wells intended for other samples or NTC. This practice minimizes the
chance of depositing microdroplets in adjacent wells.

If you dilute samples on the sample plate and vortex the plate after sealing, apply the foil seal
tightly between wells using an adhesive film applicator before vortexing to prevent contamination
between wells. To prevent spillage, use a PCR plate holder while sealing.

Before disposal, close or cap used sample and positive control tubes to avoid creation of aerosols.
Avoid touching the foil seals of the reagent strips, barcode plate, and sample plate.
When loading the sequencer deck for a run, install the sample plate last.

After a run, immediately seal the PCR amplification plate with a foil seal before removing the plate
from the PCR amplification station. Sealing the plate before removal helps prevent contamination of
libraries if libraries are recovered for reuse.
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Requirements for nucleic acid isolation, quantification,
quality control, and input amount

For automated nucleic acid isolation using the Genexus™ Purification System, see Chapter 6,
“Genexus™ Cell-Free Total Nucleic Acid Purification protocol” or Chapter 5, “Genexus™ FFPE DNA
and RNA Purification protocol”.

For verified kits to use for manual isolation, quantification, and quality control of nucleic acid
samples, see “Recommended materials for nucleic acid isolation, quantification, and quality
control” on page 21.

Use the Qubit™ Fluorometer with the Qubit™ dsDNA HS Assay Kit for quantifying DNA samples.
Use the Qubit™ Fluorometer with the Qubit™ RNA BR Assay Kit for quantifying RNA samples.

Use the Agilent™ 2100 Bioanalyzer™ with the Agilent™ High Sensitivity DNA Kit for quality control of
cfTNA samples.

Use the Agilent™ 2100 Bioanalyzer™ with the Agilent™ High Sensitivity DNA Kit or the Agilent™
4200 TapeStation™ System with the Agilent™ D5000 Reagents and Agilent™ D5000 ScreenTape for
quality control of FFPE DNA samples.

Use the Agilent™ 2100 Bioanalyzer™ with the Agilent™ RNA 6000 Nano Kit for quality control of
FFPE RNA samples.

Quantification methods such as densitometry (for example, using a NanoDrop™ spectrophotometer)
are not recommended, because they are not specific for DNA or RNA. Use of these methods can
lead to gross overestimation of the concentration of sample nucleic acid, under-seeding of the
target amplification reaction, and low library yields.

Ensure that the input nucleic acid concentration is in the verified range.

Table 1 Sample concentration requirements

Sample type Optimal nucleic acid concentration Verified nucleic acid concentration range
FFPE DNA 0.67 ng/uL 0.33-1 ng/uL
FFPE RNA
cfTNA 1.33 ng/pL 0.33-2.67 ng/pL

IMPORTANT! For samples with concentrations less than the recommended minimum of
0.33 ng/uL, there is an increased incidence of false-positive SNV or Indel calls.

The Genexus™ Integrated Sequencer requires 20 pL total volume loaded into the sample input plate
(15 pL of sample with 5-yL overage due to dead volume).
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For optimal assay performance, load 13.4 ng of nucleic acid input for each solid tumor sample and
26.6 ng of nucleic acid input for each liquid biopsy sample onto the instrument deck to account
for instrument dead volume (Table 2). At optimal nucleic acid concentrations, the instrument uses
10 ng of nucleic acid for solid tumor samples and 20 ng of input for liquid biopsy samples for each
sequencing reaction.

Table 2 Sample input requirements

Sample type On-deck input requirement!(!] Assay input
Solid tumor 13.4 ng (Optimal) 10 ng (Optimal)
(FFPE DNA or RNA) 6.6 ng—20 ng (Verified range) 5-15 ng (Verified range)
Liquid biopsy 26.6 ng (Optimal) 20 ng (Optimal)
(cfTNA) 6.6 ng-53.4 ng (Verified range) 5-40 ng (Verified range)

[ Assay input plus overage.

Before each use of the kit

28

Thaw assay reagents as indicated:

Thaw OPA Pool 1 at room temperature for at least 30 minutes and keep on ice until immediately
before loading onto the Genexus™ Integrated Sequencer.

Equilibrate Genexus™ Strip 1, Genexus™ Strip 2-HD, and Genexus™ Strip 3-GX5™ at room
temperature for at least 30 minutes before loading onto the Genexus™ Integrated Sequencer.

Thaw Genexus™ Strip 4 on ice or at 4°C for at least 30 minutes and keep on ice until immediately
before loading onto the Genexus™ Integrated Sequencer.

IMPORTANT! Ensure that the strip contents are completely thawed before installing in the sequencer.

When thawed, gently tap tubes and strips on the benchtop to remove any bubbles and collect the
contents at the bottom of each tube. For information about preparing all reagents and consumables for
loading onto the instrument, see “Before you begin” on page 109.

Note: If tapping fails to dislodge a bubble, you can dislodge large bubbles using the technique that is
described in “Before you begin” on page 109.
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Guidelines for Genexus™ Integrated Sequencer operation

Oncomine™ Precision Assay GX User Guide

Follow guidance that is provided by Genexus™ Software when you plan a run to determine which
consumables must be loaded and which consumables can be reused from a previous run.

Follow guidance that is provided by the software when you plan a run to determine how many
samples can be run with a given assay or assays in an instrument run. The number of samples that
can be included in a sequencing run depends on multiple factors.

Limiting factor

Description

The number of available
barcodes in the barcode
plate

The maximum number of available barcodes per run is 48.

IMPORTANT! When libraries are prepared on the Genexus™ Integrated
Sequencer, each target amplification reaction for a sample requires a
unique barcode.

Maximum number of
target amplification
reactions per run

One library strip pair has the reagents necessary for 6 target amplification
reactions, or 6 barcodes. With a maximum of 8 library strip pairs loaded, a
maximum of 48 samples can be run using an assay with one primer pool.

The number of primer
pools per assay

Given the limits of 48 target amplification reactions, and 48 available
barcodes, the number of samples in a run multiplied by the total number of
primer pools in the assays that are used in a run cannot exceed 48.

For one single-pool assay, a maximum of 48 samples can be run on a
single chip. If you are using 2 assays with two primer pools each, you can
sequence a maximum of 12 samples in a run. Similarly, for one assay with
4 primer pools, you can sequence a maximum of 12 samples in a run, if the
minimum read count per sample allows it.

The number of unused
lanes on an installed chip

A maximum of 4 lanes are available on a single GX5™ Chip.
A maximum of 4 lanes are available on a single GX5™ Chip or GX7™ Chip.

The minimum read count
per sample for an assay

The minimum read count per sample parameter is set during assay
creation.

Two assays cannot share a chip lane, so a maximum of 4 assays can be run per chip.

The assays that are used in a single run must use the same chemistry (lon AmpliSeg™ or lon
AmpliSeg™ HD), and have compatible cycling parameters to allow amplification in the instrument
thermal cycler. The thermal cycler has two independently controlled heating zones. After you select
an assay, Genexus™ Software restricts the list of available assays to use in the run to those that are
compatible with the selected assay or assays.

One library strip pair is needed for each primer tube position 1-8 that is filled in a run.

One template strip pair is needed for each chip lane that is used in a run.

Consumables are configured to support sample batch sizes in multiples of six samples. The most
efficient use of consumables occurs when samples are run in multiples of six.

If a chip installed in a sequencer has unused lanes, do not remove it unless you are sure that
you want to replace it with a new chip. After a partially used chip has been removed from the
sequencer, it cannot be reinserted and reused. The sequencer cannot track lane usage after chip

removal.
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Precautions

* You can remove a chip in one of the following situations.

— After all the lanes of a chip are used in a run, the chip shuttles to the install position and you
are asked to remove the used chip.

— When you select a run plan that requires more lanes than are available on the installed chip,
you are asked to remove the partially used chip, and the sequencer performs a post-chip
clean. In addition, you need to remove consumables from the lower sequencing reagents bay,
even if only a single lane of the chip was used.

* The Genexus™ Integrated Sequencer can track used and unused barcodes in barcode plates
enabling you to swap plates between runs if needed, and reload a partially used barcode plate for a
run if a sufficient number of barcodes is available on the plate.

IMPORTANT! Do not write or mark on the foil seal of the barcode plate. The instrument vision
system will be unable to distinguish used wells from unused wells, which can result in a run failure.

¢ Before loading pipette tip boxes in the sequencer before a run, ensure that you remove the lids
from the tip boxes.

* After loading in the sequencer, reusable consumables, such as barcode plate, chips, and
sequencing reagents bay components, must be used within 14 days for optimal results.

* An assay that is selected in a Library to Result run cannot include library batches that share a
library with the same barcode. However, two different assays in a run can include a barcode in
common, because assays are run in separate lanes of a chip.

¢ |f desired, manually dilute samples to the required concentration to avoid loss of sample due to the
required volume overages during automated dilution.

Precautions

Avoid nucleic acid contamination

IMPORTANT! A primary source of contamination is spurious nucleic acid fragments from previous
sample processing steps. Do not introduce amplified DNA into the work area where the instrument is
located.

Avoid chip damage

IMPORTANT! To avoid possible damage to the chip due to electrostatic discharge, ground yourself
before picking up a chip or placing a chip on a surface such as a lab bench. For example, touch the
metal trim on the chip compartment before inserting or removing a chip from the chip clamp.

Avoid strong electromagnetic radiation

WARNING! Do not use the instrument in close proximity to sources of strong electromagnetic
radiation (for example, unshielded intentional RF sources), as these sources can interfere with proper
operation.
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Precautions

Protection by equipment

A WARNING! The protection that is provided by the equipment can be impaired if the instrument is
operated outside the environment and use specifications, the user provides inadequate maintenance,
or the equipment is used in a manner that is not specified by the manufacturer (Thermo Fisher
Scientific).
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Runs plans that are created in Genexus™ Software contain the settings that are used in sample
purification, library preparation, templating, sequencing, and analysis, including sample information and
plate location, assays, and barcodes. Run plans are used to track samples, consumables, and chips
throughout purification, library preparation, templating, sequencing, and data analysis.

For more information about run planning, see the Genexus™ Software 6.8 User Guide (Pub. No.
MANO0026409) or the software help system.
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Types of Oncomine™ Precision Assay GX runs

The type of run that you plan depends on your instrument configuration, assay, and sample type.

Genexus™ Software guides you step-by-step through the process to set up a run. The software prompts
you to select required information and consumables, then provides a printed run setup guide to help
you load consumables on the Genexus™ Integrated Sequencer and the Genexus™ Purification System, if
applicable.

Table 3 Types of runs for use with the Oncomine™ Precision Assay GX

Run type Description
Sample to An integrated run for sequential and automated nucleic acid purification, quantification,
Result and sequencing. This run type requires the Genexus™ Purification System to be connected

to the sequencer.

Nucleic Acid to | A sequencing run that starts with purified nucleic acid samples of known concentration
Result as input. Purified nucleic acids can be isolated and quantified using the Genexus™
Purification System in stand-alone configuration. Alternatively, you can use other manual
purification and quantification kits to isolate purified nucleic acid samples. For a list of
recommended kits, see “Recommended materials for nucleic acid isolation, quantification,
and quality control” on page 21.

For more information about planning other types of runs, see the Genexus™ Software 6.8 User Guide
(Pub. No. MANOD026409) or the software help system.

System-installed assays for use with the Oncomine™
Precision Assay GX

An assay is a reusable experimental design that contains the settings and parameters for sample
purification, library preparation, templating, controlling the sequencing run, analyzing, and reporting the
results. Assays also define the panels, kits, and chips that are used in a run, and specify the reference
files and threshold values for quality control and variant detection. The software files that include the
assay settings and parameters are packaged in a ZIP file called an assay definition file (ADF).

An assay can be used to plan many runs and plays an important role in enabling rapid throughput
across the purification and sequencing instruments. Assays help reduce the chance of errors, because
information is stored and then applied to runs instead of entered manually for each run.

The following system-installed assays are available in the Genexus™ Software 6.8 or later for use with
the Oncomine™ Precision Assay GX. Each system-installed assay is configured with settings that are
optimized for a specific sample type.

Note: We recommend updating your Genexus™ Software to the latest available versions of the system-
installed assays. Previous versions of the assay do not have all the functionality available in Genexus™
Software 6.8. For more information, contact your field service representative. For information about
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how to perform software and assay package updates, see the Genexus™ Software help system or the
Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409).

Assay name Sample type
Oncomine™ Precision - GX5 - w3.4.2 - Liquid Biopsy cfTNA cfTNA
Oncomine™ Precision - GX5 - w3.4.2 - Combined - Solid Tumor - DNA DNA
Oncomine™ Precision - GX5 - w3.4.2 - Combined - Solid Tumor - Fusions RNA
Oncomine™ Precision - GX5 - w3.4.2 - Combined - Solid Tumor - DNA and Fusions DNA and RNA

The Genexus-Oncomine-Precision-GX5-w3.4.2-Combined-SolidTumor-DNAandFusions_SW_6.8 assay
definition file (ADF) contains 3 assays: DNA and Fusion, DNA, Fusion.

You can use the system-installed assays in your run plan without change. To modify any assay
settings, you can copy the system-installed assay that best represents your sequencing experiment
and sample type, then edit assay settings if needed. To modify a system-installed assay with custom
settings, see the Genexus™ Software help system or the Genexus™ Software 6.8 User Guide (Pub. No.
MANO0026409).

The Oncomine™ Precision - GX5 - w3.4.2 - Liquid Biopsy cfTNA assay includes resequencing by
default. Resequencing is repeat sequencing of the same DNA template a second time using a different
dNTP flow order. For more information about resequencing and sequencing flow order, see the
Genexus™ Software help system or the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409).

Enter samples in the Genexus™ Software

34

In Genexus™ Software, the data and attributes that characterize a purified nucleic acid—or a specimen
that requires nucleic acid purification and quantitation—to be sequenced are called samples.

Before you plan a run in the Genexus™ Software, you must first enter sample information in the software
to assign sample names and provide other information.

For more information about creating and managing samples, see the Genexus™ Software help system.

Genexus I lon Torrent Dashboard Samples Runs Results Assays (il 8 o3
Manage Samples
Filter Samplesby.. *  Selected Samples: 0 s TP Manage Tags  + Create 5

Sample Name b d Tags b 4 CreatedOn  + ge Attributes n Category T Sample Type hd

1. Sign in to Genexus™ Software.

2. In the menu bar, click Samples » Create Sample, select an Application Category, complete the
required fields and any optional fields, then click Save.
The new sample is listed in the Manage Samples screen and is available to use in a run plan.

* To create a Sample to Result run, proceed to “Plan a Sample to Result run” on page 35.
¢ To create a Nucleic Acid to Result run, proceed to “Plan a Nucleic Acid to Result run” on page 38.
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Plan a Sample to Result run

You can plan runs for sequencing that start from various sample types. In Genexus™ Software, a run
that includes purification of nucleic acids from samples is called a Sample to Result run.

Planning a Sample to Result run is organized into steps: Setup, Assays, Samples, Purification, and
Review. You can view progress through the steps in the upper left corner of the Runs / Sample to
Result screen.

This procedure applies only if a Genexus™ Purification System is used with the Genexus™ Integrated
Sequencer.

Ensure that the following prerequisites are complete before you plan a Sample to Result run.

3.

Integrate a Genexus™ Purification System with the system.

Enter sample information into Genexus™ Software. For more information, see the “Enter samples in
the Genexus™ Software” on page 34.

The Genexus™ Cell-Free Total Nucleic Acid Purification assay has quantitation disabled by
default to preserve the sample. Quantitation requires 5 pL of the final eluted sample. To include
quantitation in cell-free TNA purification runs, create and install a custom assay. For more
information about creating a custom assay, see the Genexus™ Software help system or contact
your support representative.

In the menu bar, click Runs » Sample to Resulit.
You can also click -+ Sample to Result in the Runs / Manage Runs screen.

In the Setup step, enter or make the following selections.
a. In the Plan section, enter a unique name.
The name is limited to 50 characters and no spaces are allowed.

b. (Optional) In the Reporting (Optional) section, enable Generate Report to generate a variant
report that uses the default report template.

To create a report template, click Assays » Manage Presets, then in the Report Templates
tab, click + Add New.

c. Click Next.

If a chip is installed in the sequencer, the Chip View graphic in the lower left corner indicates
the lanes that are available for sequencing.

In the Assays step, select the Research Application of each assay that you want to use in the
run.

Use the 9P (Filter) tools in table column headings or the Filter Assays By list to find assays of
interest.

IMPORTANT! Ensure that you select the assay that corresponds with the sample type that you
use in the run. If you select the wrong assay when you plan a run, the instrument uses incorrect
settings during the run, resulting in invalid sequencing results. Available assays are listed in the
Assays / Manage Assays screen.

Only assays that are configured for Sample to Result runs are listed.
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After selecting an assay, the list is filtered to show compatible assays that can be selected and run
at the same time.

4. Click Next.

5. In the Samples step, select the checkbox next to each sample from the list that you want to run
with the assay, then in the Selected Assays pane, click Assign.
The Chip View updates to show the lanes to be used in the run. Lane usage is calculated based
on the number of samples (including a no template control or control sample, if selected) and
minimum reads per sample entered at assay setup. Green denotes a chip lane to be used in the
run containing assigned samples within lane capacity. If the minimum reads per sample x
number of samples exceeds the chip or lane well capacity, a dialog box appears after you
click Assign asking you to confirm that you want to continue. After confirmation, the Chip View
updates and shows the lane color as red instead of green. The run is allowed if the lane capacity is
exceeded, but you may not achieve the required reads per sample to pass QC metrics.

lon Torrent™ GX5™ Chip @ lon Torrent™ GX5™ Chip @

123 OPATNAL3S 3 OPATNA-L3.5 7
® Lane Samples @ Samples

Green lane color @ denotes lane usage and sample assignment within lane capacity. Red lane color @ denotes
sample assignment that exceeds lane capacity.

6. Select the Include NTC checkbox to include a no template control for the assay.

7. (Optional) Select the Control Sample checkbox to designate a sample as a positive control for the
assay.

8. If you selected more than one assay, repeat step 5 through step 7 for each assay added.
9. Click Next.

10. If needed, edit samples in one of the following ways, then click Next.

* (Click View & Remove, make your selections, then click Update.

* (Click Remove All, make your selections, then click Assign.
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11. In the Purification step, review and edit purification selections, then click Next.

Option Description
Protocol Select a protocol from the dropdown list for each purification kit.
Selection

Elution Vol. | Modify the elution volume within the allowable range, if needed.

(uL) Quantitation requires up to 5 pL of the eluted sample. If retesting is needed, up to 10 pL
of the eluted sample is used. If the expected sample yield is limiting, manual sample
quantitation may be preferred to preserve the sample. Alternatively, you can increase
the sample elution volume in the run plan before starting the purification.

Review? * Select the checkbox in the row of a purification kit to review the sample
concentrations after purification, before sequencing. This lets you review whether a
sample concentration is out of range for automated dilution or below the minimum
concentration needed threshold. You can then decide on a per sample-basis
whether to sequence the samples.

¢ Deselect the Review? checkbox in the row of a purification kit to exclude out
of range samples from sequencing. This option does not require you to review
samples during the run.

By default, the Review? function is enabled for FFPE assays and disabled for cfTNA
assays.

12. |n the Review step, review the run plan summary.

If desired, click Save & Print to print the run setup guide. Click Save to save the run without
printing.
The run plan summary lists the following details:

* The consumables that are needed for this run and the consumables that are installed and
ready to use

* How much sample volume to load
* Where to load samples and primer pool tubes
® Details about the assay
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Genexus |io (€3] Dashboard Samples Runs Results Assays

-]
]
]
X
o

@ Consumables Required For Purifi Batch 1
16 g

lon Tarrent™ GX5™ Chip

Pos. SempleMame  nput At Pos. Pos. Type Assay Name

() Run information () Table that lists the sample plate position, sample type,
@ List of consumables needed for the run volume to load, concentration, dilution factor, and assay for

(3 Chip view showing the lanes to be used in the run each sample

@ Positions in the sample plate to load the samples

Tip: Click Sequencing to expand the sequencing section of the run plan summary to view the
sequencing plans and required consumables.

Note: If you are using an assay with lon AmpliSeq™ HD library chemistry, the primer pool positions
show that HD primer pools occupy both rows.

If the Sample to Result run requires more than one purification batch (for example a Oncomine™
Myeloid v2 - GX5 - DNA and Fusions run) you can select which purification batch to run first. Or, if
there are multiple purification instruments integrated with one sequencer, select the instrument on
which to purify each batch.

After saving, the run appears in the Manage Runs screen in the run list with the name you
specified. Until a run plan is selected for use on the sequencer it can be edited. For information
about how to edit run plans, see the software help system, or the Genexus™ Software 6.8 User
Guide (Pub. No. MAN0026409).

After you select the run and load the purification instrument, the run is started on the instrument screen.

Plan a Nucleic Acid to Result run

You can plan a run for sequencing that starts with nucleic acid samples. In Genexus™ Software 6.6 and
later, a run that starts with nucleic acid samples is called a Nucleic Acid to Result run.

Planning a Nucleic Acid to Result run is organized into steps: Setup, Assays, Samples, Sample
Plate, and Review. You can view progress through the steps in the upper left corner of the
Runs / Nucleic Acid to Result screen.
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Plan a Nucleic Acid to Result run

Ensure that the following prerequisites are complete before you plan a Nucleic Acid to Result run.

3.

Identify the system-installed or custom assay to use in the run. For more information, see
the Genexus™ Software help system or the Genexus™ Software 6.8 User Guide (Pub. No.
MANO0026409).

Enter sample information into Genexus™ Software. For more information, see “Enter samples in the
Genexus™ Software” on page 34.

Quantify the sample concentration if you do not dilute sample concentrations manually to the target
concentration of the assay. For more information, see the Genexus™ Integrated Sequencer User
Guide (MANO017910).

In the menu bar, click Runs » Nucleic Acid to Result.

Note: Alternatively, you can click 4 Nucleic Acid to Result in the Runs / Manage Runs screen.

In the Setup step, enter or make the following selections.
a. In the Plan section, enter a unique name.
The name is limited to 50 characters and no spaces are allowed.

b. (Optional) In the Reporting (Optional) section, ensure that Generate Report is enabled to
generate a Variant Report using the default report template.

c. (Optional) In the Reporting (Optional) section, enable Upload BAM files to Server to upload
BAM files to another server.

Option Description
Upload BAM files In the dropdown lists that appear, select the target Genexus™
to another Genexus™ Software server and version.
Software server. To configure a Genexus™ Software account that you can use for

data uploads, click Set up Account. For more information, see the
Genexus™ Software help system.

Automatically upload data |In the dropdown lists that appear, select the lon Reporter™ Software
for further analysis with account and lon Reporter™ Software version.

lon Reporter™ Software. | To configure an lon Reporter™ Server account that you can use for
data uploads, click Set up Account. For more information, see the
Genexus™ Software help system.

d. Click Next.

In the Assays step, select one or more assays that you want to include in the run.
a. Use the Y (Filter) tools in table column headings to find assays of interest, if desired.

b. In the Application Type column for the assay of interest, select one or more application types,
such as DNA and Fusions or DNA, to include each selected application type for the assay in
the run plan.

After selecting an assay and the research application for the assay, the list is filtered to show
compatible assays that can be selected and run at the same time.

c. If more assays are included in the run, repeat substep 3b for each extra assay.
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d. Click Next.

4. Int

he Samples step, select the samples that you want to run with each application type of each

assay.
a. Select the checkbox next to each sample that you want to assign to the application type of an

b

0

d

assay, then in the Selected Assays pane, for the assay and application type that you want to
use for the selected samples, click Assign.

The Chip View updates to show the lanes used in the run. Lane usage is calculated based
on the number of samples (including a no template control, if selected) and the minimum
read counts per sample for the assay. For information about the GX5™ Chip lane usage for
the Oncomine™ Precision Assay GX, see “Lane usage by sample type” on page 176. Green
denotes a chip lane in the run containing assigned samples within lane capacity.

If the minimum reads per sample x number of samples exceeds the chip or lane well capacity,
a dialog box appears after you click Assign asking you to confirm that you want to continue.
After confirmation, the Chip View updates and shows the lane color as red instead of green.
The run is allowed if the lane capacity is exceeded, but you may not achieve the required
reads per sample to pass QC metrics. If needed, remove extra samples from the run as
described in substep 4c.

lon Torrent™ GX5™ Chip lon Terrent™ GX5™ Chip

OPA Fusions

OPA Fusions 8

w310 Samples

2
L

w310 g

- OPA DNA Fus 10
OPA DNA Fus 5 2.1.0 Samplas
@ WL

3
® Lane wi.1.0 Sainples

Green lane color () indicates lane usage and sample assignment within lane capacity. In this example, lane 1
was used in a previous run and is not available.

Red lane color (%) indicates sample assignment that exceeds lane capacity for lanes 3 & 4.

. If you selected more than one application type or assay, repeat substep 4a for each
application type for each assay in the run plan.

. If needed, edit samples in one of the following ways.
¢ (Click View & Remove, make the selections, then click Update.

* Click Remove All, to remove all sample assignments for all assays.

. If desired, for each application type of each assay in the run plan, select NTC to include a no
template control.
The Chip View updates to show the lanes used in the run for the included no template
controls.

. Click Next.
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5. In the Sample Plate step, review position assignments in the sample plate. Drag-and-drop
samples and no template controls to edit the location of samples and controls, if applicable.

a. If desired, enter the extraction kit barcode for one or more samples or controls. For a single
sample, in the row of the sample of interest, in the Kit Barcodes column, enter the extraction
kit barcode or control kit barcode, if applicable. For multiple samples or controls, select the
samples and controls, then click [ Assign Kit Barcodes. In the Assign Kit Barcodes dialog
box, enter the extraction kit barcode for the samples, and if applicable, enter the barcode for
the no template control.

b. Modify the concentration of samples, if needed. For a single sample, in the row of the sample
of interest, in the Conc. (ng/ul) column, edit the concentration.

To modify the concentration of multiple samples, select the samples of interest, then click
@ Edit Concentration. In the Bulk Edit dialog box, enter the concentration for all selected
samples, then click Submit. The concentration for each selected sample is updated to the
new value.

If a sample concentration is within the designated range, the instrument does not dilute the
sample during the run. Sample concentrations must be within 0.11-1,000 ng/uL and cannot
be higher than 1,024X of the target concentration. If a sample concentration is <1,024X of
the target concentration, the sequencer dilutes the sample to the target concentration during
the run. If a sample concentration is >1,024X of the target concentration, manually dilute the
sample to the target concentration before loading on the sample plate. For more information
about sample dilution, see “Dilute the samples (if needed) and load the sample plate” on
page 101.

Note: The sample volume that is required for library preparation is not adjustable. The volume
depends on the number of primer pools in the assay, sample type, and library chemistry. For
specific sample volumes to load onto the sample plate, see “Dilute the samples (if needed)
and load the sample plate” on page 101.

c. Ensure that sample plate information is correct, then click Next.

6. In the Review step, review the run plan summary, then click Save & Print to print the run setup
guide, if desired. Click Save to save the run without printing.

After saving, the run appears in the Manage Runs screen in the run list with the name you
specified.
After you select the run and load the sequencer, the run is started on the sequencer screen.

When the sequencing run is complete, you can recover the leftover volume from each library that was
prepared in the run. For more information to find, recover, and purify the leftover library preparations,
see the Genexus™ Integrated Sequencer User Guide (Pub. No. MANOO17910).
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Genexus™ FFPE DNA and RNA Purification workflow

Plan a purification run (page 44)
IMPORTANT! If performing a Sample to Result run, plan the run in the
Genexus™ Software. See “Plan a Sample to Result run” on page 35.

To purify samples for use in Nucleic Acid to Result runs or other
nonsequencing applications, run the Genexus™ Purification System in
standalone configuration. Add a new purification run plan or copy-edit an
existing purification run plan that best represents your experiment. Purification
run plans contain instrument settings that are used in sample purification.

Prepare samples from FFPE curls (page 50)
OR

Prepare samples from FFPE slides (page 52)

Samples are deparaffinized and digested with protease in preparation for
isolation of DNA.

Load the Genexus™ Purification System (page 55)

The puirification run plan is selected, and the run is initiated. The instrument
performs a UV cleaning, then reagents and consumables are loaded onto the
instrument.

Start the run (page 65)

After the sample plate, reagents, and consumables are loaded, the instrument
door is closed, and the run is started.

Depending on the number of samples purified, sample quantification adds up
to 2.5 hours to the run time.

Unload the purified nucleic acids (page 66)

If performing a Sample to Result run, remove the 96-Well Nucleic Acid Output
Plate and proceed to sequence the purified sample. Remove and seal the
48-Well Nucleic Acid Archive Plate, then store as directed.

If performing a Nucleic Acid to Result run or purifying nucleic acids in
standalone configuration for use in other downstream applications, remove and
seal the 48-Well Nucleic Acid Archive Plate, then store as directed or proceed
to sequence the purified sample.

Used reagents and consumables are removed from the instrument and the
instrument performs a UV cleaning.

< O O
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Plan a purification run (standalone configuration)

Note: If running the Genexus™ Purification System in integrated configuration, see “Plan a Sample to
Result run” on page 35 to plan a Sample to Result run in the Genexus™ Software.

In standalone configuration, plan a purification-only run through the instrument touchscreen. After
purification is complete, all purified samples are transferred to an archive plate for storage.

Add a purification run plan (standalone configuration)

Plan the run before you prepare samples and load the samples into the FFPE DNA and RNA Purification
Plate 1. However, experienced users can save time if you plan the purification run during the protease
digestion step of sample preparation.

1. Enter your username and password to sign in to the instrument.

2. Tap Run, then tap Add plan.

SFODEMOCO1

3. Tap in the entry box, enter a unique name for the run plan, then tap Done » Next.

4. Select the lon Torrent™ Genexus™ FFPE DNA and RNA Purification Kit, then tap Next.
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5. Select the appropriate purification protocol and software version in use, then tap Next.

If sequentially purifying DNA and RNA, select FFPE DNA RNA.
If purifying DNA only, select FFPE DNA.
¢ If purifying RNA only, select FFPE RNA.

6. Enable or disable Quantitation after Purification.
The Quantitation Plate is required even if Quantitation after Purification is disabled.
Disabling Quantitation after Purification may reduce the purification run time by up to 2.5 hours.

Run Options

Quantitat

Elution

Elution Volume RNA

7. Accept the default elution volume. If needed, select the desired elution volume from the dropdown
list, then tap Next.

8. (Optional) Change the number of samples and the sample details.

a. In the Manage Samples screen, deselect extra samples (for example, if you run only 10
samples, deselect samples 11 and 12).

b. Tap on a sample ID to select the sample.
c. Tap Edit, enter a new Sample ID and any Notes, then tap Save.

d. Repeat substep 8b and substep 8c for each additional sample.
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se

e. Click Next.

Manage Samples Edit Sample

Sample ID
0000001 2019-12-01
0000002 0 2019-12-01 Oianttaton

0000003 0 2019-12-01

0000004 0 2019-12-01 Elution Volume (uL):

0000005 0 2019-12-01

0000006 0 2019-12-01

9. (Optional) Import sample information.
Importing sample information overwrites the existing Sample ID and Notes information for each
sample selected.
In standalone configuration, prepare a CSV sample import file and save it to a USB drive to import
sample information. See page 175.

a.

46

In the Manage Samples screen, select the samples to import the sample information, then
tap Import.

In the Sample Import screen, tap Import to proceed.

Insert the USB drive that contains the sample import CSV file into the USB port on the front of
the purification instrument. In the Sample Import screen, select the USB drive, then navigate
to and select the sample import file.

(Optional) Tap Details to view the CSV file that lists the sample names to be imported.

. Tap Import, then in the Import Successful screen, tap OK.

The imported sample information is shown in the Manage Samples screen. If needed, edit
imported sample information as described in step 8.
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10. Review the Purification Run Plan Details. Tap Edit to change any of your selections, otherwise
tap Next.

Purification Run Plan Details Purification Run Plan

Plan ©

Pur

Quantitatior

The new purification run plan appears in the list of available Purification Run Plans.

To delete an existing run plan, see the Genexus™ Purification System User Guide (Pub. No.
MANO0018475).
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Prepare samples

Procedural guidelines

IMPORTANT! Store all kit components containing liquid in the upright orientation.

* Perform all steps at room temperature (15-30°C) unless otherwise noted.

* Thawing or storing on ice can be substituted with thawing or storing at 4°C (2-8°C refrigerator or
prechilled benchtop cold block).

* When mixing samples by pipetting up and down, avoid creating bubbles.

* Wear clean gloves and a clean laboratory coat.

¢ Change gloves whenever you suspect that they are contaminated.

* Open and close all sample tubes carefully. Avoid splashing or generating aerosols of the samples.

* When working with RNA:
— Use a positive-displacement pipettor and RNase-free pipette tips.

— Clean laboratory benches and equipment periodically with an RNase decontamination solution,
such as RNaseZap™ RNase Decontamination Solution (Cat. No. AM9780).

— Store RNA at -90°C to -70°C.

* Volumes for reagent mixes are given per sample. We recommend that you prepare master mixes for
larger sample numbers. To calculate volumes for master mixes, see the per-well volume and add
5-10% overage.

* Incubation at 60°C can be extended 1 hour (2 hr total time) to increase DNA vyields followed by the
90°C incubation for 1 hour.

* We recommend using a plate centrifuge that holds the AutoLys M Tube Rack in "landscape"
orientation.

@ Landscape orientation—recommended @ Portrait orientation—not recommended

Note: Place AutoLys M Tube Rack in the centrifuge with
the arrow on the cover pointing outward as shown.
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The plate chiller on the Genexus™ Purification System shuts off 60 minutes after run completion.

Remove the 96-Well Nucleic Acid Output Plate and 48-Well Nucleic Acid Archive Plate with
purified nucleic acids from the instrument within 1 hour of run completion. Proceed immediately
to sequencing or properly store the nucleic acids until use.

The Quantitation Plate requires equilibration to room temperature for at least 30 minutes before
use.

Before each use of the kit

We recommend the use of incubators when using AutoLys M Tubes.
Preheat incubators to 60°C and 90°C.
Prepare Protease Digestion and DNase Digestion solutions immediately before use.

Centrifuge purification plates for 30 seconds at 1,000 x g to collect the contents.

Materials required

Genexus™ FFPE DNA and RNA Purification (Part. No. A45532)
— FFPE DNA and RNA Purification Plate 1

— Proteinase K (red cap)
— FFPE Protease Buffer

Genexus™ Purification Supplies 2 (Part. No. A45574)
— AutoLys M Tubes and Caps

AutoLys M TubelLifter or Pliers
AutoLys M Tube Rack
Plate centrifuge

Incubators (see “Recommended materials for nucleic acid isolation, quantification, and quality
control” on page 21 for a list of recommended incubators)

Recommended input amount

Sample type Input range Recommended input amount

FFPE tumor resections 1 x 5 pym curl/slide to 1 x 10 pm curl/slide

4 x 10 ym curls/slides

FFPE fine needle aspirate (FNA)
FFPE core needle biopsy (CNB) 6 x 10 pm curls/slides

1x 5 pm curl/slide to 4 x 10 ym curls/slides
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Prepare 1X Protease Digestion Master Mix

Prepare the 1X Protease Digestion Master Mix immediately before use.

1.

3.

Invert the FFPE Protease Buffer and Proteinase K tubes supplied in the kit 5X each, then briefly
centrifuge.

In a 5-10-mL tube, prepare a 1X Protease Digestion Master Mix as indicated, where n is the
number of samples.

Component Volume per reaction
FFPE Protease Buffer (n+ 1) x 225 pL
Proteinase K (red cap) (n+1)x10 pL
Total volume (n+ 1) x 235 L

Vortex for ~5 seconds to mix, then briefly centrifuge to collect the contents.

Prepare FFPE curl samples with AutoLys M Tubes

50

Use AutoLys M Tubes to prepare FFPE samples. Alternatively, CitriSolv™ Clearing Agent, xylene, or an
equivalent method for removal of paraffin from the FFPE samples can be used to prepare samples. See
the Genexus™ Purification System User Guide (Pub. No. MAN0O18475).

Digest with Protease in AutoLys M Tubes

Note: To minimize the amount of time between protease digestion and starting the purification run on
the instrument, prepare the reagents and consumables that are required by the instrument during the
90°C incubation (step 6).

1.

2.

Label an AutoLys M Tube for each FFPE research sample.

Transfer each FFPE section curl from its storage tube to a separate labeled AutoLys M Tube.

a. Invert a labeled AutoLys M Tube over an uncapped storage tube containing the curl, then
carefully invert the 2 tubes together so that the storage tube is on top.

b. Tap or flick the storage tube so that the curl falls into the AutoLys M Tube.

If the curl adheres to the storage tube, gently grasp an edge of the curl with forceps, then transfer
it to the AutoLys M Tube. Clean the forceps between samples by rinsing with nuclease-free water,
followed by ethanol or wiping with ethanol wipes. Do not reuse the forceps without cleaning.
Alternatively, use sterile disposable forceps.

Cap the AutoLys M Tubes tubes, place the tubes in an AutoLys M Tube Rack, then centrifuge at
2,000 x g for 1 minute to collapse the curl before the addition of buffer.

Pipet 235 pL 1X Protease Digestion Master Mix into each labeled tube.

Ensure that the curls are submerged in the Protease Digestion Master Mix. If tissue adheres to the
side of the tube, use a sterile pipette tip to push the tissue into the solution.
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5. Securely recap each tube to limit evaporation, then incubate the capped tubes at 60°C for
=60 minutes in an AutoLys M Tube Rack.

Incubation at 60°C can be extended to 2 hours to increase DNA yields. We recommend that you
incubate low yielding samples such as core needle biopsy and fine needle aspirate samples for
2 hours to maximize yield.

6. Securely retighten each tube cap to limit evaporation, then incubate at 90°C for 60 minutes.

* |f using a single incubator, keep the sample in the incubator while the temperature increases.
Start timing when the temperature reaches 90°C.

* Set up the FFPE DNA and RNA Purification Plate 1 during the incubation.

* Prepare the reagents and consumables that are required by the instrument during the
incubation. See “Prepare the consumables” on page 55.

* Equilibrate the Quantitation Plate to room temperature during the incubation.

7. Allow samples to cool to room temperature for at least 10 minutes before proceeding to lift the
tubes.

8. Lift the tubes. The following steps describe use of the AutoLys M TubelLifter to process up to
24 samples simultaneously. Alternatively, AutoLys M Tube Pliers can be used to process tubes
individually.

a. Ensure that the AutoLys M TubelLifter lever is in Position A (straight up) and the slider is in
Position 1.

b. Slide the 24-well AutoLys M Tube Rack containing the lysed samples into the AutoLys M
TubelLifter.

c. Press the lever down from Position A to Position B, then remove the rack from the lifter.

For more information about use of the AutoLys M TubelLifter see the AutoLys M TubelLifter User
Guide (Pub. No. MANOO017676).

//‘\\

@ AutoLys M TubelLifter lever Position A @ AutoLys M TubelLifter slider positions 1 & 2
@ AutolLys M TubelLifter lever Position B
@ AutoLys M Tubelifter lever Position C
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9. Slide the AutoLys M Tube Locking Lid onto the rack, then centrifuge the samples at 2,000 x g for

10 minutes.

IMPORTANT! Ensure that the embossed arrow of the AutoLys M Tube Locking Lid points
away from the center of rotation (landscape orientation) when placed in the centrifuge. See the
Genexus™ Purification System User Guide (Pub. No. MANQOO18475).

10. Using the AutoLys M TubelLifter or AutoLys M Tube Pliers, separate the filter from the outer tube.

a. Adjust the position of the AutoLys M TubelLifter slider to Position 2.
b. Remove the AutoLys M Tube Locking Lid, then slide the rack into the AutoLys M TubeLifter.
c. Press the lever down from Position B to Position C.

Keep the samples on ice or at 4°C.

Proceed to “Load the instrument and start the run” on page 55.

STOPPING POINT If needed, transfer samples to a separate labelled 1.5-mL Eppendorf™ LoBind™ tube
and store at 4°C for up to 4 days or frozen at —-30°C to —10°C for up to 7 days.

Prepare FFPE slide samples with AutoLys M Tubes

Use AutoLys M Tubes for the preparation of FFPE samples. Alternatively, CitriSolv™ Clearing Agent,
xylene, or an equivalent method for removal of paraffin from the FFPE samples can be used to prepare
samples. See the Genexus™ Purification System User Guide (Pub. No. MAN0O018475).

Collect the tissue

1.

52

Label an AutoLys M Tube for each FFPE tissue sample.
Label each tube (cap and side) with its Sample ID using a marker that is resistant to ethanol.

Pipet 235 pL 1X Protease Digestion Master Mix into each labeled tube.

Pipet 2—4 pL of 1X Protease Digestion Master Mix from the labeled tube evenly across the fixed
tissue section on the slide to prewet the tissue section.

Larger sections may need an additional 2—4 pL of 1X Protease Digestion Master Mix.

Use a sterile disposable scalpel with a flat blade to scrape the tissue in a single direction, then
collect the tissue into a cohesive mass on the tip of the scalpel blade.
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5. Carefully insert the scalpel blade with the tissue mass
into the 1X Protease Digestion Master Mix in the
AutoLys M Tube. Rinse the tissue from the blade
into the buffer, then ensure that the entire mass is in
solution.

6. Remove and inspect the blade to ensure that no tissue
remains on it.

7. Inspect the slide to ensure that all the tissue is
removed (the slide should be translucent). Discard the
scalpel in a waste container for sharp objects.

8. Cap each tube securely, then gently flick the tube to mix and to immerse the tissue.

If the tissue adheres to the side of the tube, use a sterile pipette tip to push the tissue into the
solution.

Digest with protease

To minimize the amount of time between protease digestion and starting the purification run on the
instrument, prepare the reagents and consumables that are needed by the instrument during the 90°C
incubation (step 2).

1. Incubate at 60°C for =60 minutes in an AutoLys M Tube Rack.
Incubation at 60°C can be extended to 2 hours to increase DNA yields. We recommend that you
incubate low yielding samples such as core needle biopsy and fine needle aspirate samples for
2 hours to maximize yield.

Note: Ensure that the incubator loaded with sample tubes has sufficient space to allow the rapid
transfer of heat within the incubator—do not overcrowd with tubes.

2. Securely retighten each tube cap to limit evaporation, then incubate at 90°C for 60 minutes.

* |f using a single incubator, keep the sample in the incubator while the temperature increases.
Start timing when the temperature reaches 90°C.
* Set up the FFPE DNA and RNA Purification Plate 1 during the incubation.

* Prepare the reagents and consumables that are needed by the instrument during the
incubation. See “Prepare the consumables” on page 55.

* Equilibrate the Quantitation Plate to room temperature during the incubation.

3. Allow samples to cool to room temperature for at least 10 minutes before proceeding to lift the
tubes.

4. Lift the tubes. The following steps describe use of the AutoLys M TubelLifter to process up to
24 samples simultaneously. Alternatively, AutoLys M Tube Pliers can be used to process tubes
individually.

a. Ensure that the AutoLys M TubelLifter lever is in Position A (straight up) and the slider is in
Position 1.
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b. Slide the 24-well AutoLys M Tube Rack that contains the lysed samples into the AutoLys M
Tubelifter.
c. Press the lever down from Position A to Position B, then remove the rack from the lifter.

For more information about use of the AutoLys M TubelLifter, see the AutoLys M TubelLifter User
Guide (Pub. No. MANO017676).

AN
( \

@ AutoLys M Tubelifter lever Position A @ AutolLys M TubelLifter slider positions 1 & 2
@ AutoLys M TubelLifter lever Position B
(3 AutolLys M TubeLifter lever Position C

5. Slide the AutoLys M Tube Locking Lid onto the rack, then centrifuge the samples at 2,000 x g for
10 minutes.

IMPORTANT!

. Ensure that the embossed arrow of the AutoLys M Tube Locking Lid points away from the center
of rotation (landscape orientation) when placed in the centrifuge (see the Genexus™ Purification
System User Guide (Pub. No. MAN0018475)).

. Ensure that AutoLys M Tube caps are securely held by the AutoLys M Tube Locking Lid before
you start the centrifugation.

6. Using the AutoLys M TubelLifter or AutoLys M Tube Pliers, separate the filter from the outer tube.
a. Adjust the position of the AutoLys M TubelLifter slider to Position 2.

b. Remove the AutoLys M Tube Locking Lid, then slide the rack into the AutoLys M TubeLifter.
C. Press the lever down from Position B to Position C.
Keep the samples on ice or at 4°C.

Proceed to “Load the instrument and start the run” on page 55.

STOPPING POINT If needed, transfer samples to a separate labelled 1.5-mL Eppendorf™ LoBind™ tube
and store at 4°C for up to 4 days or frozen at -30°C to —10°C for up to 7 days.
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Load the instrument and start the run

This section describes how to perform the following procedures.
* Set up the instrument for use by loading all of the required reagents and consumables.

e Start arun.

Note: Do NOT load any consumables onto the instrument until after the instrument has performed the
prerun UV cleaning.

Materials required

* Genexus™ FFPE DNA and RNA Purification (Part. No. A45532)
— FFPE DNA and RNA Purification Plate 1

— FFPE DNA and RNA Purification Plate 2
— DNase (yellow cap)

— DNase Buffer (blue cap)

- 12-Well Tip Comb

* Genexus™ Nucleic Acid Quantitation (Part. No. A45538)
— Quantitation Plate

— Quantitation Tube
* Genexus™ Purification Supplies 2 (Part. No. A45574)
— 2 Purification Tip Cartridges
— 48-Well Nucleic Acid Archive Plate
— 48-Well Nucleic Acid Archive Plate Seal
¢ 96-Well Nucleic Acid Output Plate
* P200 pipette and filtered tips

Prepare the consumables

Note: Consumables can be prepared during the protease digestion 90°C incubation step to save time.

Remove all cartridges and consumables from their packaging, then place them on the bench at room
temperature. Prepare the following cartridges and consumables.

* Genexus™ Purification Supplies 2

— 2 Purification Tip Cartridges

— 48-Well Nucleic Acid Archive Plate

— 48-Well Nucleic Acid Archive Plate Seal
e 12-Well Tip Comb
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Equilibrate the Quantitation Plate

IMPORTANT! Allow at least 30 minutes for the Quantitation Plate to equilibrate to room temperature.

The Quantitation Plate is required even if your run plan does not include sample quantitation.

The Quantitation Plate can be equilibrated to room temperature during the protease digestion to save

time.

Centrifuge the Quantitation Plate at 1,000 x g for 30 seconds to collect the contents.

Add 1X DNase Digestion Master Mix to the FFPE DNA and RNA Purification Plate 2

Note: Addition of DNase is not required if purifying only DNA (purification protocol FFPE DNA is
selected for the run). Proceed directly to “Add samples to FFPE DNA and RNA Purification Plate 1” on

page 57.

The FFPE DNA and RNA Purification Plate 2 contains magnetic beads in row H.

1. Vortex the DNase Buffer and DNase supplied in the kit for ~5 seconds each, then briefly centrifuge

to collect the contents.

2. In a 1.5-mL low-retention microcentrifuge tube, prepare a 1X DNase Digestion Master Mix as

indicated, where n is the number of samples.

Component

Volume per reaction

DNase Buffer (blue cap)

(n +1) x 99 pL

DNase (yellow cap)

(n+1)x1.0pL

Total volume

(n+1)x100 pL

3. Vortex for ~5 seconds to mix, then briefly centrifuge to collect the contents.

4. Centrifuge the FFPE DNA and RNA Purification Plate 2 at 1,000 x g for 30 seconds to collect the

contents.

5. Carefully remove the plate seal without disturbing the
contents.

6. Pipet 100 puL 1X DNase Digestion Master Mix into each
well that is used in Row A of the FFPE DNA and RNA
Purification Plate 2.

56
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Add samples to FFPE DNA and RNA Purification Plate 1
The FFPE DNA and RNA Purification Plate 1 contains magnetic beads in row B.

Note: You can add the samples to the FFPE DNA and RNA Purification Plate 1 and load the plate as
the final steps of loading the instrument. This can be done to help ensure that other components are
successfully loaded and accepted by the instrument before adding samples of possibly limited supply
to the purification plate.

1. Centrifuge the plate at 1,000 x g for 30 seconds to collect the contents.

IMPORTANT! Do not create bubbles when preparing the plate.

2. Inspect the plate to ensure that the contents of all rows are at the bottom of the wells.

3. Carefully remove the plate seal without disturbing the
contents.

4. Transfer 200 pL of each sample to an individual well in
row A of the prefilled FFPE DNA and RNA Purification
Plate 1.

Add samples to consecutive wells starting with sample 1 in well A1, through sample 12 in well A12
as defined in the run plan. Do not skip wells.

A precipitate can form, but this does not interfere with the DNA binding. Proceed directly to the
next step.

Reagent consumables cannot be reused.

IMPORTANT! Load the plate in the instrument (see page 60) within 15 minutes of adding
samples to the plate.

Start the purification run

1. In the instrument touchscreen, tap Run, then tap to select the run plan that you created for this
run.

Purification Run Plan

t purification run plan

2. Ensure that the correct run plan is selected, then tap Next.
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3. (Optional) Import sample information.

The import overwrites the existing Sample ID and Notes information for each sample. That is, if
the run plan has 6 samples, the sample import file must include information for at least 6 samples.

To import sample information, prepare a CSV sample import file and save it to a USB drive. See .
a. In the Sample Assignment screen, tap Manage Samples.

b. In the Manage Samples screen, tap Import.
c. In the Sample Import screen, tap Import to proceed.

d. Insert the USB drive that contains the sample import CSV file into the USB port on the front of
the purification instrument. In the Sample Import screen, select the USB drive, then navigate
to and select the sample import file.

e. (Optional) Tap Details to view the CSV file that lists the sample names to be imported.

f. Tap Import, then in the Import Successful screen, tap OK.
The imported sample information is shown in the Manage Samples screen. If needed, select
a sample, then tap Edit to modify the Sample ID or Notes.

4. Tap Next.
The instrument performs a 2-minute UV cleaning, then unlocks the door.

5. Lift the instrument door to the stop.

(1) Hold here, then lift.
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Load the Genexus™ Purification System

IMPORTANT!

. Do NOT load any consumables onto the instrument until after the instrument has performed the
prerun UV cleaning.

. Ensure that all components are clean and dry before loading them onto the instrument.

. Ensure that the reagent and quantitation station compartments are free of condensate before loading
components. If needed, use a lint-free wipe to dry the compartment.

Follow the on-screen prompts to load the Genexus™ Purification System.

Load Deck

Screen display for an instrument fully loaded for an FFPE sample purification run.
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Load FFPE DNA and RNA Purification Plate 1 & 2

1. Load the FFPE DNA and RNA Purification Plate 1 (DNA plate) prepared in step 4 of “Add samples
to FFPE DNA and RNA Purification Plate 1” on page 57.

2. Load the FFPE DNA and RNA Purification Plate 2 (RNA plate) prepared in step 6 of “Add 1X DNase
Digestion Master Mix to the FFPE DNA and RNA Purification Plate 2” on page 56.

@ FFPE DNA and RNA Purification Plate 1
position

@ FFPE DNA and RNA Purification Plate 2
position

Load the 12-Well Tip Comb, Purification Tip Cartridges, 96-Well Nucleic Acid Output
Plate, and 48-Well Nucleic Acid Archive Plate
1. Unwrap, then load a new 12-Well Tip Comb.

Ensure that the 12-Well Tip Comb is straight and that the tabs are not bent or broken. If needed,
gently bend the tip comb in the opposite direction to the curvature to straighten the tip comb
before installing it.

() 12-Well Tip Comb position
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2. Unwrap, then load a new 48-Well Nucleic Acid Archive Plate.

@ 48-Well Nucleic Acid Archive Plate
position

Note: Ensure that the 48-Well Nucleic Acid Archive Plate is seated properly. If the plate is curved
or bent, gently bend the plate in the direction opposite to the curvature to straighten the plate
before loading.

3. (Integrated configuration) Load a new 96-Well Nucleic Acid Output Plate into the output plate
position.
The 96-Well Nucleic Acid Output Plate is not required when performing the purification in
standalone configuration. The samples are in the 48-Well Nucleic Acid Archive Plate on completion
of the purification run.
After a Sample to Result purification run, the 96-Well Nucleic Acid Output Plate becomes the
sample plate to be loaded in the Genexus™ Integrated Sequencer.

(1) 96-Well Nucleic Acid Output Plate
position
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4. Unwrap two new Purification Tip Cartridges, remove the cover to expose the pipette tips, then load
the cartridges in positions 1 and 2.

@ Purification Tip Cartridges position 1
@ Purification Tip Cartridges position 2

a. Pull the locking mechanism handle forward (callout 1), then place the tip box in the open
position.

b. Push the locking mechanism handle back (callout 2) to lock the tip box in place.

(1) Unlocked (forward) (2 Locked (back)

Load the quantitation reagents and consumables

IMPORTANT!
. Protect the Quantitation Plate from direct bright light to prevent photobleaching of the preloaded

reagents.
. The Quantitation Plate is required even if your run plan does not include sample quantitation.

. The Quantitation Tube is not required if your run plan does not include sample quantitation.
. Ensure the Quantitation Plate and the Quantitation Tube have equilibrated to room temperature.
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1. Centrifuge the Quantitation Plate at 1,000 x g for 30 seconds to collect the contents.
2. Load the Quantitation Plate in position 2.

() Quantitation Tube position
@ Quantitation Plate position

a. Pull the locking mechanism handle forward, then place the Quantitation Plate in the open
position.

b. Push the locking mechanism handle back to lock the plate in place.

(1) Unlocked (forward) (2 Locked (back)

3. (If needed) Slide and hold the quantitation module cover to the left, then insert the Quantitation
Tube. Touching only the top of the tube, press down firmly to properly seat the tube, then allow
the module cover to close.

WARNING! Do not force the module cover closed. Forcing the module cover closed can
damage the instrument.
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@ Open @ Closed

Confirm that consumables are installed correctly

IMPORTANT! To support correct and safe instrument operation, confirm that all consumables are
installed correctly on the deck before you start a run. The instrument vision system confirms that
required reagents are in place, no reagents are expired, and foil seals are removed. The vision system
does not verify all aspects of the consumable setup before beginning each run.

1. Confirm the following.
¢ Foil seals are removed from the purification plates. Do not remove foil seal from the
Quantitation Plate.

e Each component is at the correct location and in the correct orientation. Press down on all
plates and cartridges to ensure that they are firmly seated in place.

e The Tip Combs are in place.

¢ The Quantitation Plate is in the correct location, is in the correct orientation, and is locked in
place.

¢ (If needed) The Quantitation Tube is firmly seated in the quantitation module.

e Each Purification Tip Cartridge is in the correct location, in the correct orientation, and locked
in place.

If the vision system detects an error, the location indicator does not turn gray in the touchscreen.

2. If needed, tap Help, then accept each warning message appropriately to proceed.
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Start the run

1. When all reagents and consumables are loaded in the purification instrument, tap Next.

2. Close the instrument door by pressing down on both top corners. Ensure that the door is locked
after closing it.

The instrument vision system confirms that all reagents are in place and are not expired.

3. Tap Start.

The time remaining until the purification is complete is displayed, and the interior lighting turns
green.

* |f you need to stop the run for any reason, tap Cancel, then tap Yes to confirm the
cancellation. A canceled run cannot be resumed. You must restart a run from the beginning.

* The interior lighting turns off during quantitation, then turns blue when the run is complete.

¢ [f the instrument encounters a problem during the run, it aborts the run and displays the error
on the instrument touchscreen. The interior lighting turns red.

When the run is complete, the interior light turns blue, and the touchscreen displays Run Complete.
Quantitation results are available immediately. See “View and export quantitation results” on page 68.
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Unload purified DNA and RNA

IMPORTANT! Do not allow purified nucleic acids to sit on the instrument. Store as directed or use in
sequencing reactions within 60 minutes.

1. In the touchscreen, tap Unload.

Run Complete

@

Unload

The door unlocks.

2. Lift the instrument door to access the instrument deck.

(D Hold here, then lift.
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3. (Sample to Result run) Remove the 96-Well Nucleic Acid Output Plate that contains the purified
sample DNA and RNA that is ready for the addition of positive or nontemplate sample sequencing
controls. For more information, see . Store on ice or at 4°C. If quantitation was performed, the
sample concentration information is visible in the Genexus™ Software. Alternatively, determine
sample concentrations manually, if needed.

1.2 3 4 5 6 7 8 9 10 1 12 @PairedpurifiedDNA-A1 and RNA-B1 from sample 1.
o {E880000008AE | grrarz o
-@®®0000C00000 [ g
@@@0O00000000 ® R\A
000000000000
r@@@00000000O0
-0@@0O00000000

H@@@OOOO0O00O000

STOPPING POINT If not sequencing immediately, seal the plate with an Adhesive PCR Plate Foil
(Cat. No. AB0626), then store the plate at —20°C for up to 1 week. For long term storage (>1 week),
transfer the samples to labeled low-retention tubes, then store the DNA samples at —-30°C to —-10°C
and the RNA samples at —90°C to —70°C for up to 36 months.

4. Remove the 48-Well Nucleic Acid Archive Plate that contains the purified sample DNA and RNA.

@ DNA s in wells A1-B4. DNA samples always start in
well A1.

@ RNAis in wells B5-C8. RNA samples always start
in well B5 regardless of how many samples are

r 00000000
Q0000000
C“‘..“‘ purified.
QOO0 0000O0
Q0000000

FOOO

Note: (Purification only configuration) If using the purified DNA or RNA immediately, transfer the
sample to a sample input plate for sequencing. To determine the sample concentrations, see “View
and export quantitation results” on page 68. For more information, see the relevant assay user
guide for Nucleic Acid to Result run guidance.

5. For short-term storage, seal the plate with a 48-Well Nucleic Acid Archive Plate Seal. Store the
plate at —20°C for up to 3 months. For long-term storage (>3 months), transfer samples to labeled
low-retention tubes, then store the DNA samples at —-30°C to —10°C and the RNA samples at -90°C
to —=70°C for up to 36 months.

If the archive plate is thawed during short-term storage, transfer the DNA and RNA into labeled
low-retention tubes. Do not reseal the archive plate with the used plate seal.
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View and export quantitation results

Purification runs that include sample quantitation produce sample concentration results (ng/uL) that
can be accessed after the run is complete. In integrated configuration, view the Run Report that is
available in the Genexus™ Software to see the sample concentrations. In standalone configuration,
sample concentration results can be accessed from the Run Complete screen or the Home screen as

described here.

1. In the Run Complete screen, tap View report.

Run Complete

&

Unload

The Saved Experiment Reports screen opens. See step 4.

2. At any time after unloading and UV cleaning the instrument, sample concentration results can be
accessed through the Home screen. Tap @) (Settings).

SFODEMOO1
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LU

3. In the Settings screen, tap Data Management.

Settings

System tools

Data management

4. Inthe Saved Experiment Reports screen, tap v or A to page through the list. Locate the
Experiment Name of interest, tap in the row to select the experiment, then tap View Report.

Saved Experiment Reports

nent Name

3B_14_sietra_gnxp:

View Report
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5. In the Run Report screen, tap Quant Results to view the sample concentration results. Results
displayed in the Concentration column are in ng/pL.

R_2020_08_07_18_42_02_sierra_gnxp-0016-9-ssiipe

Exp t Delete View Report

6. Insert a USB drive into the USB port on the front of the instrument, then tap Export CSV. Navigate
to the file destination, then tap Save.

Dispose of used consumables and UV clean the instrument

Unload purified nucleic acid samples before disposal of used consumables.

IMPORTANT! Do not allow purified nucleic acids to sit on the instrument. Store as directed or use in
sequencing reactions within 60 minutes.

1. Remove and discard the deep-well sample input plates.
a. Remove the FFPE DNA and RNA Purification Plate 1 from the instrument.

b. Dispose of the liquid waste by tipping the deep-well plate on one corner and pouring the
waste into an appropriate liquid biohazardous waste container.

@ WARNING! Liquid waste contains guanidine thiocyanate, dispose of properly.

c. Dispose of the deep-well plate in an appropriate waste container.
d. Repeat substep 1a through substep 1c to discard the FFPE DNA and RNA Purification Plate 2.

2. Unlock, then remove and dispose of the Purification Tip Cartridges in an appropriate waste
container.
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3. Unlock, then remove and dispose of the Quantitation Plate.

a. Dispose of the liquid waste by tipping the deep-well plate on one corner and pouring the
waste into an appropriate liquid biohazardous waste container.

WARNING! No data are currently available that address the mutagenicity or toxicity of the
Qubit™ RNA BR Reagent (Component A). This reagent is known to bind nucleic acid and is
provided as a solution in DMSO. Treat the Qubit™ RNA BR Reagent with the same safety
precautions as all other potential mutagens and dispose of the dye in accordance with local
regulations.

b. Dispose of the deep-well plate in an appropriate waste container.

4. Open the quantitation module cover, remove and discard the Quantitation Tube, then allow the
module cover to close.

5. Close and lock the instrument door by pressing down on both top corners, then tap Start UV
Clean.

The time remaining in the UV cleaning is displayed. When complete, the instrument is ready to
start a new purification run.

Oncomine™ Precision Assay GX User Guide 71



m Genexus™ Cell-Free Total Nucleic

72

Acid Purification protocol

Plan a purification run (standalone configuration) ......... ... ... . i 74
Prepare the Quantitation Plate . ........... .. i 77
Prepare cell-free plasma from whole blood samples ........... ... ... i i, 78
Load the instrument and starttherun ... .. .. 79
Unload purified cell-free TNA . ... o e e 92

Oncomine™ Precision Assay GX User Guide



Chapter 6 Genexus™ Cell-Free Total Nucleic Acid Purification protocol M
Unload purified DNA and RNA 750

Genexus™ Cell-Free Total Nucleic Acid Purification workflow

Plan a purification run (page 74)

IMPORTANT! If performing a Sample to Result run, plan the run in the
Genexus™ Software. See “Plan a Sample to Result run” on page 35.

To purify samples for use in Nucleic Acid to Result runs or other
nonsequencing applications, run the Genexus™ Purification System in
standalone configuration. Add a new purification run plan or copy-edit an
existing purification run plan that best represents your experiment. Purification
run plans contain instrument settings that are used in sample purification.

Equilibrate the Quantitation Plate to room temperature
(page 77)

The Quantitation Plate requires equilibration to room temperature for at least
30 minutes before use. To save time, experienced users can take the
Quantitation Plate out of 4°C storage before creating a run plan and preparing
samples.

Prepare cell-free plasma from whole blood samples
©) (page 78)

sl Whole blood samples are centrifuged to separate plasma from other
components.

The purification run plan is selected, and the run is initiated. The instrument
performs a UV cleaning, then samples, reagents, and consumables are loaded
onto the instrument.

Start the run (page 91)
After the sample plate, reagents, and consumables are loaded, the instrument
door is closed, and the run is started.

Depending on the number of samples purified, quantification adds ~45 minutes
to the run time.

Load the Genexus™ Purification System (page 79) E
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Genexus™ Cell-Free Total Nucleic Acid Purification workflow

Unload the purified nucleic acids (page 92)
In integrated configuration, remove the 96-Well Nucleic Acid Output Plate and
proceed to sequence the purified sample.

In standalone configuration, remove and seal the 48-Well Nucleic Acid Archive
Plate, then store as directed, or proceed to sequence the purified sample.

Used reagents and consumables are removed from the instrument and the
instrument performs a UV cleaning.

Plan a purification run (standalone configuration)

Note: If running the Genexus™ Purification System in integrated configuration, see “Plan a Sample to
Result run” on page 35 to plan a Sample to Result run in the Genexus™ Software.

In standalone configuration, plan a purification-only run through the instrument touchscreen. After
purification is complete, all purified samples are transferred to an archive plate for storage.

Plan a Genexus™ Cell-Free Total Nucleic Acid Purification run

Create a run plan before you prepare samples and load the samples into the Cell-Free Total Nucleic
Acid Purification Plate 1. However, experienced users can save time by creating the run plan during the
centrifugation steps of sample preparation.

1. Enter your username and password to sign in to the instrument.

2. Tap Run, then tap Add plan.

SFODEMOO1 Purification Run Plan

n run plan

3. Tap in the entry box, enter a unique name for the run plan, then tap Done » Next.
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4. Select the lon Torrent™ Genexus™ Cell-Free Total Nucleic Acid Purification Kit, then tap Next.

Select Kit

Select purifica

5. Select the appropriate purification protocol, then tap Next.

Select Protocol

6. Enable or disable Quantitation after Purification.

Note:

. The Quantitation Plate is required even if Quantitation after Purification is disabled.

. Disabling Quantitation after Purification can reduce the purification run time by up to
45 minutes.

. Quantitation requires up to 5 L of the eluted sample. If the expected sample yield is limiting,
manual sample quantitation using less volume may be preferred to preserve sample.
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Run Options

7. Select the desired elution volume from the dropdown list, then tap Next.

8. (Optional) Change the number of samples and the sample details.
a. In the Manage Samples screen, deselect extra samples (for example, if you run only 4

samples, you must deselect samples 5 and 6). Do not deselect samples from in the middle of
the range (for example, if you run only 4 samples, do not deselect sample 2, 3, or 4.)

b. In the Manage Samples screen, tap on a sample ID to select the sample.

c. Tap Edit, enter a new Sample ID and any Notes, then tap Save.

d. Repeat substep 8b and substep 8c for each additional sample.

e. Tap Next.

Manage Samples

Edit Sample Details

9. (Optional) Import sample information.
The import overwrites the existing Sample ID and Notes information for each sample selected.
In standalone configuration, prepare a CSV sample import file and save it to a USB drive to import
sample information. See page 175.
a. In the Manage Samples screen, select the samples to import sample information, then tap
Import.
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b. In the Sample Import screen, tap Import to proceed.

¢. Insert the USB drive containing the sample import CSV file into the USB port on the front of
the purification instrument. In the Sample Import screen, select the USB drive, then navigate
to and select the sample import file.

d. (Optional) Tap Details to view the CSV file that lists the sample names to be imported.

e. Tap Import, then in the Import Successful screen, tap OK.
The imported sample information is shown in the Manage Samples screen. If needed, edit
imported sample information as described in step 8.

10. Review the Purification Run Plan Details. Tap Edit to change selections. Otherwise tap Next.

Purification Run Plan Details Purification Run Plan

purification run plan

Elution Volume TNA

The new purification run plan appears in the list of available Purification run plans.

Prepare the Quantitation Plate

Prepare the following cartridges and consumables:
* Genexus™ Nucleic Acid Quantitation (Part No. A45538)
- Quantitation Plate
— Quantitation Tube

Equilibrate the Quantitation Plate

IMPORTANT!
. Protect the Quantitation Plate from direct bright light to prevent photobleaching of the preloaded

reagents.
. Allow at least 30 minutes for the Quantitation Plate to equilibrate to room temperature.

. The Quantitation Plate is required even if your run plan does not include sample quantitation.
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Prepare cell-free plasma from whole blood samples

1.

Centrifuge the Quantitation Plate at 1,000 x g for 30 seconds to collect the contents.

2. Place the plate and Quantitation Tube on the bench next to the purification instrument.

Prepare cell-free plasma from whole blood samples

Procedural guidelines

78

IMPORTANT! Store all kit components that contain liquid in the upright orientation.

Perform all steps at room temperature (20-25°C) unless otherwise noted.

Thawing or storing on ice can be substituted with thawing or storing at 4°C (2-8°C refrigerator or
prechilled benchtop cold block).

Blood specimens must be collected in K;EDTA blood collection tubes.

When mixing samples by pipetting up and down, avoid creating bubbles.

When working with whole blood, observe these guidelines.

Wear clean gloves and a clean laboratory coat.

Change gloves whenever you suspect that they are contaminated.

Open and close all sample tubes carefully. Avoid splashing or spraying samples.
Use a positive-displacement pipettor and RNase-free pipette tips.

Clean laboratory benches and equipment periodically with 10% bleach solution and rinse with
70% isopropanol.

When freezing whole blood or bone marrow aspirate samples for later use. We recommend
that you freeze samples in aliquots up to 400 pL at —-90°C to —70°C such that the entire sample
is used for one purification.

When working with cell-free RNA, observe these guidelines.

Wear clean gloves and a clean laboratory coat.

Change gloves whenever you suspect that they are contaminated.

Open and close all sample tubes carefully. Avoid splashing or spraying samples.
Use a positive-displacement pipettor and RNase-free pipette tips.

Clean laboratory benches and equipment periodically with an RNase decontamination solution,
such as RNaseZap™ RNase Decontamination Solution (Cat. No. AM9780) or RNase AWAY™
Decontamination Reagent (Cat. No. 7005-11).

The plate chiller shuts off 60 minutes after run completion. Remove the 96-Well Nucleic

Acid Output Plate (integrated configuration) or 48-Well Nucleic Acid Archive Plate (standalone
configuration) with purified nucleic acids from the instrument within 1 hour of run completion.
Proceed immediately to sequencing, or properly store the nucleic acids until use.
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Before each use of the kit

* [f needed, thaw plasma samples—stored at -90°C to —70°C —at room temperature, then store on
ice or at 4°C until use.

* Keep fresh plasma samples on ice or at 4°C until use.

* Centrifuge purification plates at 1,000 x g for 30 seconds to collect the contents.

Isolate cell-free plasma from whole blood

1. Centrifuge the blood sample at 2,000 x g for 10 minutes at 4°C.
Up to 8 mL of plasma can be used as sample input. One 10 mL tube of whole blood yields
approximately 4 mL plasma.
Centrifuge the sample within 2 hours of blood draw. Ensure that the sample is centrifuged no later
than 6 hours after blood draw.
If a refrigerated centrifuge is not available, chill the sample on ice or in a prechilled 4°C cold block
for 10 minutes, centrifuge at 2,000 x g for 10 minutes at room temperature, then immediately place
the centrifuged sample on ice or 4°C cold block.

2. Transfer the plasma to a new 15-mL or 50-mL conical centrifuge tube. Volume should be 3-5 mL.

IMPORTANT! Do not disturb the buffy coat layer when transferring the plasma layer.

A 1X centrifuged plasma sample can be stored overnight at 4°C, or long term at -90°C to -70°C.

3. Centrifuge the plasma sample at 6,000 x g for 30 minutes at 4°C.
Alternatively, centrifuge the plasma sample at 16,000 x g for 10 minutes at 4°C.

4. Transfer the supernatant to a fresh tube, note the volume of cell-free plasma, then keep on ice or at
4°C until use.

Store cell-free plasma samples at -90°C to —70°C for long term storage.

Load the instrument and start the run

This section describes how to perform the following procedures.
* Set up the instrument for use by loading all required reagents and consumabiles.

e Start arun.

Note: Do NOT load any consumables onto the instrument until after the instrument has performed the
prerun UV cleaning.
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Materials required

* Genexus™ Cell-Free Total Nucleic Acid Purification (Part No. A45535)
— Cell-Free Total Nucleic Acid Purification Plate 1

— Cell-Free Total Nucleic Acid Purification Plate 2
— Cell-Free Total Nucleic Acid Purification Plate 3
- 6-Well Tip Comb

- 12-Well Tip Comb

— Proteinase K (red cap)

— cfTNA Lysis/Binding Solution

* Genexus™ Nucleic Acid Quantitation (Part No. A45538)
- Quantitation Plate
- Quantitation Tube
* Genexus™ Purification Supplies 1 (Part No. A45529)
— Purification Tip Cartridge
— 48-Well Nucleic Acid Archive Plate (not required for integrated configuration)
— 48-Well Nucleic Acid Archive Plate Seal (not required for integrated configuration)

* MicroAmp™ EnduraPlate™ Optical 96-Well Clear Reaction Plates with Barcode (96-Well Nucleic
Acid Output Plate, integrated configuration only)

® 200- and 1000-pL pipettors, and filtered tips
* 1000-puL multichannel pipettor and reagent reservoir (recommended)

Prepare the consumables

Remove all cartridges and consumables from their packaging, then place them on the bench at room
temperature.

Prepare the following cartridges and consumables:
® Genexus™ Purification Supplies 1
— Purification Tip Cartridge
— 48-Well Nucleic Acid Archive Plate
— 48-Well Nucleic Acid Archive Plate Seal
* 12-Well Tip Comb
* 6-Well Tip Comb

* MicroAmp™ EnduraPlate™ Optical 96-Well Clear Reaction Plates with Barcode (96-well output
plate)
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Add cfTNA Lysis/Binding Solution to Cell-Free Total Nucleic Acid Purification

Plate 1 & 3

To prepare the Cell-Free Total Nucleic Acid Purification Plate 1 and the Cell-Free Total Nucleic Acid
Purification Plate 3 for use, add cfTNA Lysis/Binding Solution to the plates.

1. Remove the plate seal from Cell-Free Total Nucleic Acid Purification Plate 1.

2. Add 2.5 mL of cfTNA Lysis/Binding Solution to each well in the plate, A1 through D6.

a.

Attach six 1,000 pL pipette tips on a 1,000 pL multichannel pipettor, then set the volume on
the pipettor to 833 pL.

If the tip spacing of the multichannel pipettor is not adjustable, attach tips into alternate
channels to fit into plate 1 wells.

. Transfer ~70 mL of the cfTNA Lysis/Binding Solution to a 50-100-mL reagent reservoir.

Use one bottle per run to avoid cross-contamination between runs.

. Use the multichannel pipettor to dispense 833 pL cfTNA Lysis/Binding Solution to each well

A1-AB, then B1-B6, and so on. Well A1 is located at the notched corner of the plate.

. Repeat substep 2c two more times to load a total volume of 2.5 mL into each of the 24 wells.

1 2 3 4 5 6

A |25 mL 2.5mL 2.5mL 2.5mL 2.5mL 2.5mL

B |25mL 2.5mL 2.5mL 2.5mL 2.5mL 2.5mL

C |25mL 2.5mL 2.5mL 2.5mL 2.5mL 2.5mL

D |25mL 2.5mL 2.5mL 2.5mL 2.5mL 2.5mL

cfTNA Lysis/Binding Solution loaded in 24 wells of plate 1

. Visually inspect the plate to ensure that the wells are uniformly filled to 2.5 mL, then set the

plate aside until you are ready to add samples. See “Add samples to Cell-Free Total Nucleic
Acid Purification Plate 1” on page 89.

If you are purifying fewer than 6 samples, add cfTNA Lysis/Binding Solution to wells in each
row of the plate columns for the number of samples that you have, but start with wells A1, B1,
and so on.

If a multichannel pipettor is not available, use a single-channel pipettor or repeat pipettor to
add cfTNA Lysis/Binding Solution to the plates. We do not recommend the use of serological
pipettes.

To prevent contaminants from falling into wells after adding the solution, cover the plate
loosely with the original plate seal, or cover with a clean object such as a 96-well plate cover.
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3. Carefully remove the plate seal from Cell-Free Total
Nucleic Acid Purification Plate 3 without disturbing the
contents of the plate.

4. Add 440 pL of cfTNA Lysis/Binding Solution to wells
A1 through AG.

a. Attach six 1,000 pL pipette tips on a 1,000 pL multichannel pipettor, then set the volume on
the pipettor to 440 pL.

b. If needed, transfer additional cfTNA Lysis/Binding Solution from the bottle into the reagent
reservoir. Use the remaining solution from substep 2b.

Use one bottle per run to avoid cross-contamination between runs.

c. Use the multichannel pipettor to dispense 440 L cfTNA Lysis/Binding Solution to each well
A1-AG.

-
o
-
-

OO00000-
OO0000O0"
OO00000-
O000000-
OO000O000-
OO0O00000-
OO000000O~
OOO00O00O0-
OO0000O0-
OO000000O

O000000O

OOO0O0O00O0s

0]0]0]0]0]0]0[0][e]0]0]e.

cfTNA Lysis/Binding Solution loaded in wells A1-A6 of plate 3 (440 uL/well)

* [f you are purifying fewer than 6 samples, add cfTNA Lysis/Binding Solution to row A wells of
the plate columns for the number of samples to purify, but start with well A1.

¢ |f a multichannel pipettor is not available, use a single-channel pipettor or repeat pipettor to
add cfTNA Lysis/Binding Solution to the plates. We do not recommend the use of serological
pipettes.

5. Discard excess cfTNA Lysis/Binding Solution into an appropriate liquid biohazardous waste
container.

A WARNING! Liquid waste contains guanidine thiocyanate. Dispose of waste appropriately.
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Start the purification run

1. In the instrument touchscreen, tap Run, then tap to select the run plan that you created for this
run.

Purification Run Plan

N run plan

2. Ensure that the run plan selected is correct, then tap Next.

3. (Optional) Import sample information.

The import overwrites the existing Sample ID and Notes information for each sample. That is, if
the run plan has 6 samples, the sample import file must include information for at least 6 samples.

To import sample information, prepare a CSV sample import file and save it to a USB drive. See .
a. In the Sample Assignment screen, tap Manage Samples.

b. In the Manage Samples screen, tap Import.
c. In the Sample Import screen, tap Import to proceed.

d. Insert the USB drive that contains the sample import CSV file into the USB port on the front of
the purification instrument. In the Sample Import screen, select the USB drive, then navigate
to and select the sample import file.

e. (Optional) Tap Details to view the CSV file listing the sample names that are to be imported.

f. Tap Import, then in the Import Successful screen, tap OK.
The imported sample information is shown in the Manage Samples screen. If needed, select
a sample then tap Edit to modify the Sample ID or Notes.

4. Tap Next.
The instrument performs a 2-minute UV cleaning, then unlocks the door.
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5. Lift the instrument door to the stop.

(1) Hold here, then lift.

Load the Genexus™ Purification System

IMPORTANT!

. Do NOT load any consumables onto the instrument until after the instrument has performed the
prerun UV cleaning.

. Ensure that all components are clean and dry before loading them onto the instrument.

. Ensure that the reagent and quantitation station compartments are free of condensate before loading
components. If needed, use a lint-free wipe to dry the compartment.

Follow the on-screen prompts to load the Genexus™ Purification System.

Load Deck

@ 96-Well Nucleic Acid Output Plate, not needed when performing the purification in standalone configuration.
@ 48-Well Nucleic Acid Archive Plate, not needed when performing the purification in integrated configuration.
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Load Cell-Free Total Nucleic Acid Purification Plate 2 & 3

1. Carefully remove the plate seal from Cell-Free Total
Nucleic Acid Purification Plate 2 without disturbing the
contents of the plate.

2. Load the 24 deep-well Cell-Free Total Nucleic Acid
Purification Plate 2 in position 2.

@ Cell-Free Total Nucleic Acid Purification
Plate 1 position (do not load yet)

@ Cell-Free Total Nucleic Acid Purification
Plate 2 position

@ Cell-Free Total Nucleic Acid Purification
Plate 3 position

3. Load the 96 deep-well Cell-Free Total Nucleic Acid Purification Plate 3 in position 3.

Note: Ensure that the plate has 440 pL cfTNA Lysis/Binding Solution manually loaded in wells
A1-D6.

Load the tip combs, Purification Tip Cartridge, 96-Well Nucleic Acid Output Plate,
and 48-Well Nucleic Acid Archive Plate

1. Unwrap, then load a new 6-Well Tip Comb and 12-Well Tip Comb.

Ensure that each tip comb is straight and that the tabs are not bent or broken. If needed, gently
bend the tip comb in the opposite direction to the curvature to straighten the tip comb before
installing it.

!

(@ 12-Well Tip Comb position

(f @ 6-Well Tip Comb position
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2. (Standalone configuration only) Unwrap, then load a new 48-Well Nucleic Acid Archive Plate.

The 96-Well Nucleic Acid Output Plate is not required when performing the purification in
standalone configuration.

@ 48-Well Nucleic Acid Archive Plate
position

3. (Integrated configuration only) Load a new 96-Well Nucleic Acid Output Plate into the output plate
position.

After a purification run, the 96-Well Nucleic Acid Output Plate becomes the sample plate to be
loaded in the Genexus™ Integrated Sequencer. The 48-Well Nucleic Acid Archive Plate is not
required when performing the purification in integrated configuration.

(1) 96-Well Nucleic Acid Output Plate
position
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4. Unwrap a Purification Tip Cartridge, remove the cover to expose the pipette tips, then load it in
position 1.

@ Purification Tip Cartridge position 1

a. Pull the locking mechanism handle forward (callout 1, below), then place the tip box in the
open position.

b. Push the locking mechanism handle back (callout 2) to lock the tip box in place.

(1) Unlocked (forward) (@ Locked (back)

Load the quantitation reagents and consumables

IMPORTANT!
. Protect the Quantitation Plate from direct bright light to prevent photobleaching of the preloaded

reagents.
. The Quantitation Plate is required even if your run plan does not include sample quantitation.

. The Quantitation Tube is not required if your run plan does not include sample quantitation.
. Ensure the Quantitation Plate and the Quantitation Tube have equilibrated to room temperature.
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1. Centrifuge the Quantitation Plate at 1,000 x g for 30 seconds to collect the contents.
2. Load the Quantitation Plate in position 2.

() Quantitation Tube position
@ Quantitation Plate position

a. Pull the locking mechanism handle forward, then place the Quantitation Plate in the open
position.

b. Push the locking mechanism handle back to lock the plate in place.

(1) Unlocked (forward) (2 Locked (back)

3. (If needed) Slide and hold the quantitation module cover to the left, then insert the Quantitation
Tube. Touching only the top of the tube, press down firmly to properly seat the tube, then allow
the module cover to close.

WARNING! Do not force the module cover closed. Forcing the module cover closed can
damage the instrument.
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@ Open @ Closed

Add samples to Cell-Free Total Nucleic Acid Purification Plate 1

IMPORTANT!

. Before adding samples, ensure that cfTNA Lysis/Binding Solution is added to the Cell-Free Total
Nucleic Acid Purification Plate 1.

. Prepare and load all reagents and consumables, except the Cell-Free Total Nucleic Acid Purification
Plate 1, on the instrument, before adding Proteinase K to the samples to avoid overdigestion.

. Do not create bubbles when preparing the plate.

. During the wash steps, the Wash Solution may develop inert white or brown particulates that float in
solution. This is not a cause for concern and does not negatively affect performance.

1. Inspect the plate to ensure that the contents of all rows are at the bottom of the tubes. If needed,
centrifuge the plate at 1,000 x g for 30 seconds to collect the contents.

Alternatively, gently flick or tap the plate on the bench to force the reagents to the bottoms of the
tubes.

2. If the plasma sample volume is less than 8 mL, add 1X PBS to a final volume of 8 mL.
Plasma sample volumes less than 8 mL can result in suboptimal performance.

3. Add 50 pL Proteinase K to each sample, then mix by inverting the tube 5-10 times.

4. Transfer each sample into the 4 wells of a single column (2 mL per well) in the prefilled 24 deep-
well Cell-Free Total Nucleic Acid Purification Plate 1.

Add samples to consecutive columns beginning with sample 1 in column 1, through sample 6 in
column 6. Do not skip wells.

1

@ Sample 1
A | 2mL @ Sample 2

o Sample 3
B| 2mL o Sample 4

o Sample 5
clam ® samples
D| 2mL
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ey

5. Load the Cell-Free Total Nucleic Acid Purification Plate 1 with the samples in position 1.

@ Cell-Free Total Nucleic Acid Purification Plate 1 position

Confirm that consumables are installed correctly

IMPORTANT! To support correct and safe instrument operation, confirm that all consumables are
installed correctly on the deck before you start a run. The instrument vision system confirms that
required reagents are in place, no reagents are expired, and foil seals are removed. The vision system
does not verify all aspects of the consumable setup before beginning each run.

1. Confirm the following.

Foil seals are removed from the purification plates. Do not remove foil seal from the
Quantitation Plate.

Each component is at the correct location and in the correct orientation. Press down on all
plates and cartridges to ensure that they are firmly seated in place.

The Tip Combs are in place.

The Quantitation Plate is in the correct location, is in the correct orientation, and is locked in
place.

(If needed) The Quantitation Tube is firmly seated in the quantitation module.

Each Purification Tip Cartridge is in the correct location, in the correct orientation, and locked
in place.

If the vision system detects an error, the location indicator does not turn gray in the touchscreen.

2. If needed, tap Help, then accept each warning message appropriately to proceed.
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Start the run

1. When all reagents and consumables are loaded in the purification instrument, tap Next.

2. Close the instrument door by pressing down on both top corners. Ensure that the door is locked
after closing it.

The instrument vision system confirms that all reagents are in place and are not expired.

3. Tap Start.

The time remaining until the purification is complete is displayed and the interior lighting turns
green.

¢ (Integrated configuration) Quantitation is turned off by default to preserve sample.

¢ [f you have to stop the run for any reason, tap Cancel, then tap Yes to confirm the
cancellation. A canceled run cannot be resumed. You must restart a run from the beginning.

* The interior lighting turns off during quantitation, then turns blue when the run is complete.

¢ If the instrument encounters a problem during the run, it aborts the run and displays the error
on the instrument touchscreen. The interior lighting turns red.

When the run is complete, the interior light turns blue, and the touchscreen displays Run Complete.
Quantitation results are available immediately. See “View and export quantitation results” on page 94.
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Unload purified cell-free TNA

IMPORTANT! Do not allow purified nucleic acids to sit on the instrument. Store as directed or use in
sequencing reactions within 60 minutes.

1. In the touchscreen, tap Unload.

Run Complete

@

Unload

The door unlocks.

2. Lift the instrument door to access the instrument deck.

(@ Hold here, then lift.
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3. (Integrated configuration) Remove the 96-Well Nucleic Acid Output Plate that contains the purified
sample cfTNA that is ready for the addition of positive or nontemplate sample sequencing
controls. For more information, see “Transfer DNA and RNA samples to the sample input plate”
on page 105. Store on ice or at 4°C. Quantitation is turned off by default to preserve the sample.
Determine sample concentrations manually, if needed.

1 2 3 4 5 6 7 8 9 10 M 12 @ cfTNA
~r@0O00000000000

@O 0000000000
c@OO0000000000
c@OOO0O00000000
e@OO0O000000000
F@OO0O000000000
sQO0O0000000000O
HOOOO0OO00000000

The 48-Well Nucleic Acid Archive Plate is not used.

STOPPING POINT If not sequencing immediately, seal the plate with an Adhesive PCR Plate Foil
(Cat. No. AB0626), then store the plate at —20°C for up to 1 week. For long term storage (>1 week),
transfer the samples to labeled low-retention tubes, then store at -90°C to —70°C for up to

12 months.

4. (Standalone configuration) Remove the 48-Well Nucleic Acid Archive Plate, containing the purified
sample cell-free TNA in row A.

© cfTNA

00000 -
OO000O0~
OO00O00 -
O0000 -
OO000O0 -~
O0000-
OO00OO~
OO000OO -

OO000O00O0O0

If using the purified cfTNA immediately, transfer the sample to a sample input plate for sequencing.
To determine the sample concentrations, see “View and export quantitation results” on page 94

if quantitation was performed. Alternatively, determine sample concentrations manually, if needed.
For more information, see the relevant assay user guide for Nucleic Acid to Result guidance.

5. For short term storage, seal the plate with a 48-Well Nucleic Acid Archive Plate Seal. Store the
plate at —20°C for up to 3 months. For long-term storage (>3 months), transfer samples to labeled
low-retention tubes, then store cfTNA samples at -90°C to —70°C for up to 12 months.

If the archive plate is thawed during short-term storage, transfer the cfTNA into labeled low-
retention tubes. Do not reseal the archive plate with the used plate seal.

6. For long-term storage, transfer samples to labeled low-retention tubes, then store cfTNA samples
at -90°C to -70°C for up to 6 months.
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View and export quantitation results

Purification runs that include sample quantitation produce sample concentration results (ng/pL) that can
be accessed after the run is complete. In standalone configuration, sample concentration results can be
accessed from the Run Complete screen or the Home screen as described here.

Note: (Integrated configuration) Quantitation is turned off by default to preserve the sample.

1. In the Run Complete screen, tap View report.

Run Complete

&

Unload

The Saved Experiment Reports screen opens. See step 4.

2. At any time after unloading and UV cleaning the instrument, sample concentration results can be
accessed through the Home screen. Tap @) (Settings).

SFODEMOO1
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3. In the Settings screen, tap Data Management.

Settings

System tools

Data management

4. Inthe Saved Experiment Reports screen, tap v or A to page through the list. Locate the
Experiment Name of interest, tap in the row to select the experiment, then tap View Report.

View Report
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5. In the Run Report screen, tap Quant Results to view the sample concentration results. Results
displayed in the Concentration column are in ng/pL.

Run Report

Standalone

Quant Results

6. Insert a USB drive into the USB port on the front of the instrument, then tap Export CSV. Navigate
to the file destination, then tap Save.

Dispose of used consumables and UV clean the instrument

Unload purified nucleic acid samples before disposal of used consumables.

IMPORTANT! Do not allow purified nucleic acids to sit on the instrument. Store as directed or use in
sequencing reactions within 60 minutes.

1. Remove and discard the deep-well sample input plates.
a. Remove the Cell-Free Total Nucleic Acid Purification Plate 1 from the instrument.

b. Dispose of the liquid waste by tipping the deep-well plate on one corner and pouring the
waste into an appropriate liquid biohazardous waste container.

& WARNING! Liquid waste contains guanidine thiocyanate, dispose of properly.

c. Dispose of the deep-well plate in an appropriate waste container.

d. Repeat substep 1a through substep 1c to discard both the Cell-Free Total Nucleic Acid
Purification Plate 2 and the Cell-Free Total Nucleic Acid Purification Plate 3.

2. Unlock, then remove and dispose of the Purification Tip Cartridges in an appropriate waste
container.
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3. Unlock, then remove and dispose of the Quantitation Plate.

a. Dispose of the liquid waste by tipping the deep-well plate on one corner and pouring the
waste into an appropriate liquid biohazardous waste container.

WARNING! No data are currently available that address the mutagenicity or toxicity of the
Qubit™ RNA BR Reagent (Component A). This reagent is known to bind nucleic acid and is
provided as a solution in DMSO. Treat the Qubit™ RNA BR Reagent with the same safety
precautions as all other potential mutagens and dispose of the dye in accordance with local
regulations.

b. Dispose of the deep-well plate in an appropriate waste container.

4. (If quantitation was performed) Open the quantitation module cover, remove and discard the
Quantitation Tube, then allow the module cover to close.

5. Close and lock the instrument door by pressing down on both top corners, then tap Start UV
Clean.

The time remaining in the UV cleaning is displayed. When complete, the instrument is ready to
start a new purification run.
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B Load the sample plate—Sample to Result run

After you have planned a run in Genexus™ Software, use the run setup guide provided by the software

to load samples in the sample plate.

Chip capacity by sample type

98

Use the following guidance to determine how many samples you can load onto the GX5™ Chip. The
capacity of the GX5™ Chip varies depending on the sample type. Chip capacity information applies to
assays that use system-installed settings only.

IMPORTANT! Changes to system-installed assay settings have not been verified. We recommend
using system-installed assay settings. Consult your local Field Service Engineer before changing default

assay settings.

Table 4 GX5™ Chip max capacity by sample type — Nucleic Acid to Result Run

Capacity for | Capacity for | Capacity for | Capacity for
Assay
1 lane 2 lanes 3 lanes 4 lanes
No controls
Oncomine™ Precision - GX5 - w3.4.2 - 1 3 4 6
Liquid Biopsy cfTNA
Oncomine™ Precision - GX5 - w3.4.2 - 8 16 24 32
Combined - Solid Tumor - DNA
Oncomine™ Precision - GX5 - w3.4.2 - 8 16 24 32
Combined - Solid Tumor - Fusions
Oncomine™ Precision - GX5 - w3.4.2 4 8 12 16
- Combined - Solid Tumor - DNA and
Fusions
With NTC only
Oncomine™ Precision - GX5 - w3.4.2 - 1 3 4 6
Liquid Biopsy cfTNA
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Table 4 GX5 Chip max capacity by sample type — Nucleic Acid to Result Run (continued)

Capacity for | Capacity for | Capacity for | Capacity for
Assay
1 lane 2 lanes 3 lanes 4 lanes
Oncomine™ Precision - GX5 - w3.4.2 - 8 16 24 31
Combined - Solid Tumor - DNA
Oncomine™ Precision - GX5 - w3.4.2 - 8 16 24 31
Combined - Solid Tumor - Fusions
Oncomine™ Precision - GX5 - w3.4.2 4 8 12 15
- Combined - Solid Tumor - DNA and
Fusions
With NTC and PCl']
Oncomine™ Precision - GX5 - w3.4.2 - N/A 2 3 5
Liquid Biopsy cfTNA
Oncomine™ Precision - GX5 - w3.4.2 - 7 15 23 30
Combined - Solid Tumor - DNA
Oncomine™ Precision - GX5 - w3.4.2 - 7 15 23 30
Combined - Solid Tumor - Fusions
Oncomine™ Precision - GX5 - w3.4.2 3 7 1 14
- Combined - Solid Tumor - DNA and
Fusions

1 When running a Nucleic Acid to Report run, the PC cannot be added automatically. One sample must be treated as the positive
control.

Dilute the samples and load the sample plate—Nucleic Acid
to Result run

When performing a Nucleic Acid to Result run on the sequencer, you must quantify and dilute the
samples, then load the sample input plate. If sample purification and quantification was performed
using the Genexus™ Purification System in standalone configuration further sample quantification is
not needed and sample concentrations are available in the instrument software. Alternatively, nucleic
acid samples can be manually purified and quantified using a recommended kit, see “Recommended
materials for nucleic acid isolation, quantification, and quality control” on page 21.

Note: The number of samples that can be purified in a single purification run on the Genexus™
Purification System can exceed the number of samples that can be accommodated in a single GX5™
Chip lane in a sequencing run.
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Quantify nucleic acid samples

Isolate nucleic acid samples using one of the validated procedures and kits that are listed in
“Recommended materials for nucleic acid isolation, quantification, and quality control” on page 21.

IMPORTANT! The correct input amount of nucleic acid is critical for assay success. Use a Qubit™
Fluorometer to accurately measure sample concentration before you proceed to “Dilute the samples (if
needed) and load the sample plate” on page 101.

Analyze 1 pL of nucleic acid sample using a Qubit™ Fluorometer with one of the following assay kits.

Follow the procedure in the corresponding user guide to prepare samples and standards, then calculate

sample concentration.

Sample type Kit

User Guide

DNA Qubit™ dsDNA HS Assay Kit

Qubit™ dsDNA HS Assay Kits User Guide
(Pub. No. MAN0002326)

RNA Qubit™ RNA BR Assay Kit

Qubit™ RNA BR Assay Kits User Guide
(Pub. No. MAN0001987)

Evaluate nucleic acid sample quality

In some cases, the sample concentration that is required for quality control analysis can be different
from the sample concentration that is required for the sequencing reaction.

Note: Typically, cfTNA samples include enough gDNA to complete a successful sequencing run. If you

have a limited amount of sample, you can omit the quality control analysis and proceed directly to
“Dilute the samples (if needed) and load the sample plate” on page 101.

1. (If needed) Dilute a small portion of the sample to the recommended concentration range for

quality control analysis.

2. Analyze 1 pL of each nucleic acid sample on the Agilent™ 2100 Bioanalyzer™ Instrument. For FFPE
DNA samples, you can also use the Agilent™ 4200 TapeStation™ System. Follow the quality control

procedure in the corresponding user guide.

Agilent™ D5000 ScreenTape

Instrument Kit Sample type col:szr?tr: ;Eg:c'{::ge
Agilent™ 2100 Bioanalyzer™ Agilent™ High Sensitivity DNA Kit| FFPE DNA 5-500 pg/uL
Instrument CfTNA
Agilent™ RNA 6000 Nano Kit FFPE RNA 5-500 ng/pL
Agilent™ 4200 TapeStation™ System | Agilent™ D5000 Reagents and FFPE DNA 0.1-50 ng/pL

100
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Dilute the samples and load the sample plate— Nucleic Acid to Result run

When evaluated on the Agilent™ Bioanalyzer™ Instrument, FFPE DNA and FFPE RNA samples typically
exhibit a broad smear that covers a size range of thousands of base pairs. The average size typically
falls between 100 base pairs to ~3,000 base pairs, depending on the age and condition of the original
sample. For best performance, use samples with an average size of =200 base pairs.

FRPE fIA C1: FFPE DNA

25 200 500 1000 2000 A000 nt}: i
wl

Figure 2 Example TapeStation™ trace for an FFPE

Figure 1 Example Bioanalyzer™ trace for an FFPE
DNA sample

RNA sample

When evaluated on the Agilent™ Bioanalyzer™ Instrument, cfTNA samples typically exhibit a distinct
peak of ~170 base pairs, which indicates the cfDNA fraction of an extracted sample. Depending on the
collection method, storage conditions, or transportation conditions, another high molecular weight peak

of >1,000 base pairs can be visible on the Bioanalyzer™ trace (Figure 3).

Figure 3 Example Bioanalyzer™ trace for a cfTNA sample

Note: For instructions about reviewing the size distribution for a sample on the Agilent™ 2100
Bioanalyzer™ System, see the 2700 Expert Software User's Guide (Pub. No. SD-UF0000050), which

can be downloaded from agilent.com.

Dilute the samples (if needed) and load the sample plate

Before you proceed, use a Qubit™ Fluorometer to accurately measure sample concentration. For more
information, see “Quantify nucleic acid samples” on page 100. To run sample controls, select an
appropriate control for your sample type as recommended in “Genexus™ Controls” on page 10.

Nucleic acid samples with concentrations up to 1,024X of the target concentration for an assay
(displayed as default values in the Sample Plate step screen in run planning) are in range for automated
dilution and require no manual dilution. Enter the concentrations during sample run planning at the
Sample Plate step (see “Plan a Nucleic Acid to Result run” on page 38).

101
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Note: You can manually dilute samples to the required concentration to avoid loss of sample due to the
required volume overages during automated dilution.

1.

For samples with concentrations that are out of range for automated dilution, manually dilute the
samples to the required concentration with nuclease-free water as indicated in the run setup guide
(see “Plan a Nucleic Acid to Result run” on page 38).

Table 5 Sample concentration requirements

Sample type | Optimal nucleic acid concentration Verified nucleic acid concentration range
FFPE DNA 0.67 ng/uL 0.33-1 ng/pL
FFPE RNA
cfTNA 1.33 ng/pL 0.33-2.67 ng/pL

Table 6 Sample input requirements

Sample type

On-deck input requirement(!]

Assay input

Solid tumor
(FFPE DNA or RNA)

13.4 ng (Optimal)
6.6 ng—20 ng (Verified range)

10 ng (Optimal)
5-15 ng (Verified range)

Liquid biopsy
(cfTNA)

26.6 ng (Optimal)
6.6 ng-53.4 ng (Verified range)

20 ng (Optimal)
5-40 ng (Verified range)

[ Assay input plus overage.

Add diluted nucleic acid samples to the sample plate at the volume and well positions that are
specified in the run setup guide.

Table 7 Sample volume per well

Sample type Volume
DNA 20 yL
RNA 20 uL
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Figure 4 Example DNA and Fusions Nucleic Acid to Result sample input plate layout

Note: Sample position in the input plate can be rearranged when creating the Nucleic Acid to Result run plan to
ease pipetting.

@ Paired purified DNA-A1 and RNA-B1 from sample 1. C1 + D1 = sample 2, E1 + F1 = sample 3 etc.
@ Paired DNA and RNA negative controls

® DNA
@ No template control (DNA)

® RNA
@ No template control (RNA)
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Figure 5 Example DNA-only or Fusions (RNA-only) Nucleic Acid to Result sample input plate layouts

Note: The examples provided are for sequencing in a single chip lane.

@ DNA-only sample input plate layout
@ DNA

@ No template control (DNA)

X 10]0]0]0]0]0]0]0]0]6]6)
8 @OO0OO0O0O000000
X ]0]0]0]0]0]0]0]0]0]0]e)
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N 10]0]0]0]0]0]0]0]0]0)0)
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s @OO0O0000O0OOO0
HOOOOOOOOOOOO
Figure 6 Example cfTNA N

® cTNA
@ No template control (NTC)
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@ Fusions (RNA-only) sample input plate layout

® RNA
@ No template control (RNA)

ucleic Acid to Result sample input plate layout
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3. Add controls to the sample input plate at the volume and well positions that are specified in the run
setup guide.

4. Seal the plate with a sheet of Thermo Scientific™ Adhesive PCR Plate Foil.

IMPORTANT! Do NOT use other brands of aluminum sealing tape. The use of other plate seals
can affect performance.

5. Place the plate on ice until ready to load in the sequencer.

Load the sample plate—Sample to Result run

104

When performing a Sample to Result sequencing run, the 96-Well Nucleic Acid Output Plate from

the purification instrument can be loaded directly on to the sequencer as the sample input plate for
DNA-only or Fusions (RNA-only) workflows. For the DNA and Fusions sequencing run workflow, purified
and quantified DNA and RNA samples, and no template controls must be transferred to a new 96-well
input plate as specified in the run setup guide.

Note: No template controls included in the run plan are added to the 96-well output plate by the
Genexus™ Purification System.

If positive controls were included in the DNA-only, Fusions (RNA-only), or DNA and Fusions run plan,
you must manually add positive controls to the sample input plate, before loading the plate in the
sequencer. For more information, contact support.

Note: The maximum number of samples that can be run on the Genexus™ Purification System is 12.

Table 8 GX5™ Chip max capacity by sample type — Sample to Result Integrated Run

Capacity for | Capacity for | Capacity for | Capacity for
Assay
1 lane 2 lanes 3 lanes 4 lanes
No controls
Oncomine™ Precision - GX5 - w3.4.2 - 1 3 4 6
Liquid Biopsy cfTNA
Oncomine™ Precision - GX5 - w3.4.2 - 8 12 N/A N/A
Combined - Solid Tumor - DNA
Oncomine™ Precision - GX5 - w3.4.2 - 8 12 N/A N/A
Combined - Solid Tumor - Fusions
Oncomine™ Precision - GX5 - w3.4.2 4 8 12 N/A
- Combined - Solid Tumor - DNA and
Fusions
With NTC only!']
Oncomine™ Precision - GX5 - w3.4.2 - 1 3 4 5
Liquid Biopsy cfTNA
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Table 8 GX5 Chip max capacity by sample type — Sample to Result Integrated Run (continued)

Capacity for | Capacity for | Capacity for | Capacity for
Assay
1 lane 2 lanes 3 lanes 4 lanes
Oncomine™ Precision - GX5 - w3.4.2 - 8 12 N/A N/A
Combined - Solid Tumor - DNA
Oncomine™ Precision - GX5 - w3.4.2 - 8 12 N/A N/A
Combined - Solid Tumor - Fusions
Oncomine™ Precision - GX5 - w3.4.2 4 8 12 N/A
- Combined - Solid Tumor - DNA and
Fusions
With NTC and PC2
Oncomine™ Precision - GX5 - w3.4.2 - N/A 2 3 5
Liquid Biopsy cfTNA
Oncomine™ Precision - GX5 - w3.4.2 - 7 12 N/A N/A
Combined - Solid Tumor - DNA
Oncomine™ Precision - GX5 - w3.4.2 - 7 12 N/A N/A
Combined - Solid Tumor - Fusions
Oncomine™ Precision - GX5 - w3.4.2 3 7 1 12
- Combined - Solid Tumor - DNA and
Fusions

[ NTC must be added to the output plate after the run.
[l NTC and PC must be added to the output plate after the run.

Transfer DNA and RNA samples to the sample input plate

To perform DNA and Fusions sequencing runs the DNA and RNA samples must be transferred from
their respective purification output plates to a new 96-well sample plate for loading onto the sequencer.
If any controls were included in the run plan, you must manually add positive controls and no template
controls to the sample input plate, before loading the plate in the sequencer. For more information
about the appropriate controls see “Genexus™ Controls” on page 10.

For Sample to Result runs nucleic acid sample concentrations are transferred automatically from the
integrated Genexus™ Purification System to the Genexus™ Software. Samples up to 1,024X of the
recommended target concentration for the assay (displayed as default values in the Sample Plate step
screen in run planning) are diluted to the target concentration on the Genexus™ Integrated Sequencer
during the run.
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Note: You can manually dilute samples to the needed concentration to avoid loss of sample due to the
required volume overages during automated dilution.

* DNA and Fusions sequencing runs

a. Add diluted DNA and RNA samples to the sample plate at the volume and well positions that
are specified in the run setup guide.

Table 9 Sample volume per well

Sample type Verified nucleic acid concentration range Volume

DNA 0.33-1 ng/pL 20 pL

RNA 0.33-1 ng/pL 20 pL

2 3 4 5 6 7 8 9 10 11 12
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Figure 7 Example DNA and Fusions Sample to Result sample input plate layout without NTC

Note: Sample position in the input plate cannot be rearranged when creating the Sample to Result run plan.

@ Paired purified DNA-A1 and RNA-B1 from sample 1. C1 + D1 = sample 2, E1 + F1 = sample 3 etc.
@ Paired DNA and RNA positive controls

@ DNA ® RNA

@ DNA positive control @ RNA positive control

b. Add controls to the sample input plate at the volume and well positions that are specified in
the run setup guide.

c. Seal the plate with a sheet of Thermo Scientific™ Adhesive PCR Plate Foil.

IMPORTANT! Do NOT use other brands of aluminum sealing tape.

d. Place the plate on ice until ready to load in the sequencer.

* DNA-only or Fusions (RNA-only) sequencing runs

The 96-Well Nucleic Acid Output Plate generated by the Genexus™ Purification System can be
used directly as the sample input plate for sequencing. Because the number of samples that can
be accommodated in a single GX5™ Chip lane (DNA-only = 8, RNA-only = 32) does not correlate
with the number of samples that can be purified in a single purification batch (DNA or RNA = 12) it
can be preferable to transfer samples to new 96-well sample input plates (for example, multibatch
purification of RNA samples).

a. (If needed) Transfer samples to a new 96-well sample input plate.
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b. Add controls to the sample input plate at the volume and well positions that are specified in

the run setup guide.
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®

®

Figure 8 Example DNA-only or Fusions (RNA-only) Sample to Result sample input plate layouts

Note: The examples provided are for sequencing in a single chip lane.

@ DNA-only sample input plate layout
© DNA
@ No template control (DNA)

@ Fusions (RNA-only) sample input plate layout

® RNA
@ No template control (RNA)

@ DNA positive control @ RNA positive control

* cfTNA sequencing runs

a. Add diluted DNA and RNA samples to the sample plate at the volume and well positions that
are specified in the run setup guide.

Table 10 Sample volume per well

Sample type Verified nucleic acid concentration range Volume
cfTNA 0.33-1 ng/pL 20 yL

A@OOOOOOOOOOO

8 @OOOO0O00O0OO0O00OO

c@OOO0OOOOOOOO

b @OOOOOOOOOOO

E@QOOOOOOOOOOO

F@OOOOOOOOOOO

s @OOOO0O0OOOOOO

H@OOOOOOOOOOO

Figure 9 Example cfTNA Sample to Result sample input plate layout
Note: Sample position in the input plate cannot be rearranged when creating the Sample to Result run plan.
® cNA

@ No template control (NTC)
@ Positive control

b. Add controls to the sample input plate at the volume and well positions that are specified in
the run setup guide.
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c. Seal the plate with a sheet of Thermo Scientific™ Adhesive PCR Plate Foil.

IMPORTANT! Do NOT use other brands of aluminum sealing tape.

d. Place the plate on ice until ready to load in the sequencer.
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After you have planned a run in Genexus™ Software, use the run setup guide provided by the software
to determine which consumables to load in the sequencer. Follow the step-by-step instructions in the
sequencer touchscreen during run setup. The vision system of the sequencer tracks the addition of
consumables in real-time and alerts you if a component is loaded in the wrong position, or if the wrong
quantity is loaded.

Before you begin

1. Remove the library and templating strips from their boxes in the refrigerator or freezer, and ready
them for loading in the sequencer.

a. Equilibrate Genexus™ Strip 1, Genexus™ Strip 2-HD, and Genexus™ Strip 3-GX5™ to room
temperature for 30 minutes.

b. Thaw Genexus™ Strip 4 on ice for 30 minutes. If you are delayed in loading, keep the strips on
ice before proceeding.

Note: These thawing conditions were optimized with strips lying flat on ice. If you are thawing
many strips side-by-side, or if strips are submerged in ice, thaw time can be longer than
30 minutes.

IMPORTANT! Ensure that the strip contents are completely thawed before proceeding.

2. Visually check tube 3 of the Genexus™ Strip 2-HD for precipitation. If needed, flick the tube to
dissolve the precipitate.

Note: If you have a Genexus™ Strip Centrifuge Adapter, you can vortex the strip on a platform
vortexer to dissolve precipitate, then briefly centrifuge the strips using the adapter to collect the
contents at the bottom of the tubes. For more information about obtaining and using the adapter,
see “Centrifuge library and templating reagent strips using the Genexus™ Strip Centrifuge Adapter”
on page 112.

3. Remove primer pool tubes in tube carriers that are needed for the run from the freezer, then thaw
for at least 30 minutes on ice or at 4°C. After thawing, gently tap the primer pool tube or tubes on a
bench surface to ensure that contents are collected at the bottom of the tubes. Keep the tubes and
carriers on ice or at 4°C until you load them in the sequencer.
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4. If you are installing a new Genexus™ Cartridge, thaw the cartridge at room temperature for
30 minutes before installing in the sequencer.

5. Genexus™ Strip 1 and Genexus™ Strip 3-GX5™ contain magnetic beads in one or two positions,
yellow or brown in color, that sometimes get trapped in the upper "keyhole" of the tube. Dislodge
these beads from the keyhole before installing the strip in the sequencer. Use the following
procedure for each strip.

Note: If you have a Genexus™ Strip Centrifuge Adapter, vortex the strips on a platform vortexer

to dislodge air bubbles and magnetic beads or to dissolve precipitate, then briefly centrifuge the
strips using the adapter to collect the contents at the bottom of the tubes. For more information,
see “Centrifuge library and templating reagent strips using the Genexus™ Strip Centrifuge Adapter”
on page 112.

a. Invert the strip 3-4 times to dislodge beads that are
trapped in the keyholes.

b. To remove any remaining beads and liquid from the
keyholes, grasp the strip at one end with the strip
seal facing up, then swing the strip with a rapid,
downward centrifugal arm motion, ending with a
sharp wrist-flick.

c. Grasp the strip at the other end, then repeat the
centrifugal motion.
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d. Check tube positions for significant amounts of beads that remain trapped in keyholes (see
Figure 10), then repeat the centrifugal motion, if needed. It is acceptable if a few beads remain
in the keyhole or on the tube wall, but most should be either in suspension or in a pellet at the
bottom of the tube.

Figure 10  Example Genexus™ Strip 3-GX5™ before (upper) and after (lower) inversion. The carrier has been
removed to show tube contents more easily.

@ Magnetic beads trapped in keyholes @ Magnetic beads dislodged from keyholes

Note:

. It is not necessary to resuspend the magnetic beads completely—it is only necessary to
dislodge most of the beads that may be trapped in the keyhole. The instrument resuspends
the beads during the run when needed.

. Fine bubbles can form above the liquid in some tubes after inversion. These bubbles do not
affect the run.

6. Inspect all strips for large bubbles lodged under the surface of the liquid or at the bottom of each
tube or well. Gently tap the strips on a benchtop to dislodge any bubbles without splashing the
contents onto the upper tube walls. If tapping fails to dislodge a bubble, use the technique that is
described in substep 5b until large bubbles are dislodged.
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Centrifuge library and templating reagent strips using the Genexus™ Strip
Centrifuge Adapter

112

You can use the Genexus™ Strip Centrifuge Adapter as a holder for centrifuging library and templating
strips to collect contents after vortexing the strips. Vortexing and centrifuging strips is recommended
to decrease errors in the workflow due to air bubbles in strip wells or beads trapped near the foil seal.
Users can request this part from a Thermo Fisher Scientific Field Service Engineer.

Note: The Genexus™ Strip Centrifuge Adapter can also be used to centrifuge Genexus™ Primer Pool
Tubes.

Use of the adapter requires a centrifuge with buckets that support the height of the adapter at 44 mm
so that buckets swing freely in the centrifuge rotor when loaded with strips. For more information, see
the Genexus™ Integrated Sequencer User Guide (Pub. No. MAN0O17910).

Genexus™ Strip Centrifuge Adapter
@ 44 mm height

To use the Genexus™ Strip Centrifuge Adapter, follow these steps.

1. After thawing, vortex each strip at maximum speed for 5-10 seconds while rocking the strip from
side to side.

2. Load the strips in the adapters in a balanced orientation, then place each adapter loaded with
strips in the centrifuge. The centrifuge buckets must support the height of the adapters loaded
with strips.

3. Centrifuge the strips at 300 x g for 15 seconds.

4. Remove strips from the adapters, then inspect the strips to ensure that contents have been
collected and air bubbles are not present.

5. If brown magnetic beads are still visible in the tube keyhole near the foil seal, invert the strip to
resuspend the contents, then repeat step 3.

Note: It is not necessary to dislodge all the beads trapped in a keyhole —dislodging most beads is
sufficient.
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Load the sequencer and start a run

6. Repeat step 1 through step 4, if needed, for the remaining library and templating strips to be
loaded in the sequencer.

7. After centrifugation, return Genexus™ Strip 4 to ice or 4°C until you are ready to load the strips in
the sequencer.

Load the sequencer and start a run

IMPORTANT! The GX5™ Chip is needed for the Oncomine™ Precision Assay GX. Ensure that the
correct chip is loaded in step 7.

1. Tap Run on the sequencer home screen to start the loading procedure.

Genexus Integrated Sequencer

2. In the Run Selection screen, select the run that you want to use from the list.

Run Selection

Run List

Cancel
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If you select a run that requires more lanes than are available on a currently installed chip, a dialog
box appears giving you the option to install a new chip, or cancel. If you proceed with a new chip,
a post-chip clean is performed, then the sequencer prompts you to perform the following steps.

* Clear Deck * Clear Sequencing Reagents
* UV Clean * Load Sequencing Reagents
* Load Deck

Note: A post-chip clean takes about 90 minutes to complete.

3. In the Review Run screen, confirm the run selections, then tap Next.

Review Bun

Confirm the

DNA_RNA_8pool

The deck door opens automatically.

Note:

. If the instrument vision system detects consumables loaded on the deck, the sequencer
prompts you to remove the consumables, then starts a UV Clean.

. If all 4 lanes of the installed chip were previously used, the used chip shuttles to the install
position. You are prompted to remove it before the UV Clean starts.

. Select the Do Force Clean checkbox if there will be 1-3 unused lanes on the installed chip
after the run, but you want to start the next run on a new chip after the current run. A force
clean automatically cleans the instrument after the run, eliminating the need for an operator
to manually perform the Clean instrument procedure between the completion of the current
run and the next run. Selecting Do Force Clean makes all lanes of the chip and installed
sequencing reagents unusable after the run
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4. Inthe Load Deck screen, the sequencer instructs you step by step to load each required
consumable in a highlighted position on the deck. The sequencer detects the loading of each
consumable in real time and advances to the next component automatically.

Load Deck

IMPORTANT!

Ensure that you remove the primer pool tube cap or caps before installing the tube carrier on the
deck.

Ensure that you load the correct type of barcode plate, library Strip 2, and templating Strip 3

for the type of run you are setting up. The sequencer displays a warning if you have installed
consumables that are incompatible with the run you have selected, for example, a Genexus™
Barcodes AS plate or Genexus™ Strip 2-AS in an HD run.

Ensure that you remove the lids from all the boxes of Genexus™ Pipette Tips before you load the
boxes in the sequencer.

After removing the tip box lid, visually inspect tip boxes to ensure that all tips are seated level

in the tip rack before and after placing on the instrument deck. If a bent or damaged tip is
suspected, replace the tip box with a new tip box. Reracking of tips from partially used boxes is
not supported and can cause some tips to seat at an angle, which can affect run performance.
Ensure that all tip boxes sit level on the deck by visually inspecting all boxes across the tip
station. Reseat the boxes before starting the run, if needed.

Do not use third-party pipette tips or rerack third-party tips into used Genexus™ Pipette Tips
boxes. Use of third-party tips can result in sequencing run failure.

Load instrument plates, including the PCR plate, barcode plate, enrichment plate, and sample
plate, into position by pressing down firmly and evenly on all sides and corners of each plate.
Check any errors carefully before proceeding. Tap Help to view the errors.
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Note:

. A primer pool tube carrier can only be installed with
the position 1 tube in the back row of the Primer
Pool Tube Station. Follow the guidance in the run U O @
setup guide for loading the primer pool tube carrier or
carriers in the correct position and order in the station.

. If the sequencer cannot read the correct loading of
an unexpired consumable, tap Help in the lower left
corner of the screen to override the block. After using
this override, the name of the consumable will not @ Position 1
appear in the run summary consumables list. ® Position 2

5. For Nucleic Acid to Report and Sample to Report sequencing runs using panel primer tubes, place
the Genexus™ Primer Pool Tube Holder (Cat. No. A40004840) on top of the Genexus™ Primer Pool
Tubes, lining up the holes in the tube holder to the tops of the primer tubes.

@ Genexus™ Primer Pool Tube Holder

6. Ensure that all the primer pool tube carrier barcodes are visible and are accurately shown as
loaded in the instrument software.

IMPORTANT! The instrument cannot detect if the Genexus™ Primer Pool Tube Holder is
improperly placed. Ensure that the tube holder is correctly positioned before proceeding.

When used with a single primer pool tube, the tube holder can move after placement. This
movement has not demonstrated an effect on run performance in our testing.
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7. If prompted, insert a new GX5™ Chip and Genexus™ Coupler. Insert the chip into the chip install
slot with the chip notch oriented down and toward the front of the instrument.

@ Notched corner of chip

Note: A chip shuttle under the deck moves the installed chip to loading and sequencing positions
during the run.

IMPORTANT! Insert the Genexus™ Coupler so that it is level to properly align with the GX5™ Chip.
A coupler that is installed at an angle or is not level will not align properly to the chip and can result
in a failed run.

8. When the deck consumables have been loaded, lock the library and templating strips in place by
sliding the latches toward the rear of the deck.

Note: We recommend that you load the sample plate last.

Load Deck
ode | VI

Cancel

If a chip is detected and the strip latches are closed, the Close Deck Door screen appears.
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9. Close the deck door, then tap Next.

Close Deck Door

Close the deck door, then press Next

* |f you installed a new chip in the sequencer, the sequencer prompts you to open the
sequencing reagents bay doors to empty the waste and remove used sequencing reagents
bay consumables. Proceed to step 10.

¢ If you are using a chip that was previously installed and has sufficient lane capacity for the run,
the sequencer starts the run.

IMPORTANT! The cartridge and bottles in the sequencing reagents bay must be replaced every
time that a new chip is installed, regardless of how many lanes were used in the previous chip.

10. Follow on-screen instructions to empty the waste in the Waste carboy, remove waste pipette
tips, remove the used Genexus™ Bottle 1, Genexus™ Bottle 2, Genexus™ Bottle 3, and Genexus™
Cartridge, then tap Next.

Clear Sequencing Reagents

Empty and replace the waste container
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IMPORTANT!
. Ensure that you empty and replace the Waste carboy and the waste pipette tip bin.
. After replacing the emptied Waste carboy, ensure that you reinsert the waste tube into the

carboy.
. Follow all applicable local, state/provincial, and/or national regulations when recycling or

disposing of consumables and liquid waste.

11. |Install a new Genexus™ Bottle 1, Genexus™ Bottle 2 (two required), Genexus™ Bottle 3, and
Genexus™ Cartridge.

Load Sequencing Reagents

IMPORTANT!

. Before installing, gently invert each Genexus™ Bottle 2 five times to mix—avoid vigorous mixing.
Inspect the plastic nozzles for any pinches or deformations. To avoid pinching or folding of the
plastic nozzle, install the bottles straight-on, not at an angle.

. The installed reagents can be used for up to 14 days on the sequencer with full performance.
After 14 days, you may observe reduced performance.

After reagents are installed, the Close Sequencing Reagent Bay Door screen appears.
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12. Close the sequencing reagents bay doors.

Close Sequencing Reagent Bay Door

After the doors are closed, the sequencer starts the run.

At the beginning of the run, the instrument chip coupler check verifies the chip, checks for leaks,
then calculates run time.

Run Workflow Checking for leaks

Calculating time

A sequencing run encompasses the following stages.
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1. Starting 5. Pre-sequencing

2. Initializing 6. Sequencing

3. Library Prep 7. Cleaning

4. Templating

At each stage, the instrument shows the time remaining on the touchscreen.

Note: The time remaining shown on the screen does not include run analysis time.

Sequencing

‘ Qﬂ‘ .k&"o
& %.

00:31:24
Library Prep

%’%ﬂ Il“:&&

When the run finishes, the sequencer displays the Run Complete screen.

Note: If all the lanes of a chip are used in a run, the used chip remains engaged in the sequencer
until a new run is started. The chip then shuttles to the install position, and you are prompted to
remove the chip before loading the deck with new consumables.
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Clear the instrument deck and perform a UV Clean

After a run completes, remove used consumables from the deck and perform a UV Clean to ready the
instrument for the next run.

1. In the Run Complete screen, tap Next to start removal of used consumabiles.

Sequencing

Run
Complete

The deck door opens.

2. In the Clear Deck screen, the sequencer provides step-by-step instructions by highlighting the
components to be removed. Unlock the library and templating strips by sliding the latches toward
the front of the deck, then remove the used strips. Remove the remaining deck components
specified by the sequencer.

Clear Deck

P 1 in position 1
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3. If panel primer tubes were used, remove the Genexus™ Primer Pool Tube Holder and discard the
primer pool carriers from the deck.

Note: If the Genexus™ Primer Pool Tube Holder shows reagent droplet accumulation from normal
operation, it should be cleaned before proceeding. For more information, “Clean the Genexus™
Primer Pool Tube Holder” on page 181.

4. Place the Genexus™ Primer Pool Tube Holder back on top of the Primer Pool Tube Station on the
deck and store it there until next use.

IMPORTANT! Leave the Genexus™ Primer Pool Tube Holder in this location for the UV Clean step
and to help reduce contamination.

5. Inspect the Genexus™ Filter in the liquid waste disposal port and verify that no standing liquid is
present. If standing liquid is present, manually remove the liquid with a pipette, then pull out the
filter. Test the filter with water to determine if a clog is present.

¢ If the Genexus™ Filter is clogged, replace it with a new filter. For more information, see the
Genexus™ Integrated Sequencer User Guide (Pub. No. MAN0017910).

¢ |f the Genexus™ Filter does not appear to be clogged, a line clog downstream of the filter is
implicated. Contact Technical Support and report a possible deck liquid waste line clog.
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6. When finished, close the deck door, then tap Next.

Close Deck Door

A two-minute UV Clean starts.
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7. After UV cleaning, if all the chip lanes were used, the sequencing reagents bay doors unlock. Open
the doors, remove used components from the bay and empty the Waste carboy, then tap Next.

Clear Sequencing Reagents

IMPORTANT! Do not discard or remove the conical bottles, unless alerted by the sequencer to
replace the bottles after a conical bottle flow rate test. For more information, see the Genexus™
Integrated Sequencer User Guide (Pub. No. MANOO17910).

IMPORTANT! Follow all applicable local, state/provincial, and/or national regulations when
recycling or disposing of Genexus™ Integrated Sequencer consumables and liquid waste.

CAUTION! The Genexus™ Bottle 1 (small waste bottle) contains small amounts of formamide.
Dispose of this waste appropriately.

8. After removal of used components, close the sequencing reagents bay doors, then tap Next.
The sequencer returns to the home screen.
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Use the Results menu to review run results and data analysis and perform data management tasks.
You can view results sorted by sample or by run.

Oncomine™ Precision Assay GX

The Oncomine™ Precision Assay GX cfTNA assay workflow is a hotspot-only assay. In addition, the
Oncomine™ Precision Assay GX FFPE assay workflow reports non-hotspot de novo (non-targeted)
variants detected in the sample. These de novo variants are usually found in unknown or unidentified
genes.

Hotspots are amino acid positions that exhibit recurrent somatic mutations. Based on empirical
evidence, the hotspots targeted by the assay are derived from genomic representations of observed
alleles for select hotspot codons as well as less-frequently observed variants and are expected to
provide selective advantage to tumor cells.

Hotspots, or variant alleles of interest, for the assay are defined in a browser extensible data (BED) file.
Hotspot BED files instruct the variant calling pipeline to call out the defined variant alleles in output files,
including evidence for the presence of a variant and the filtering thresholds that can disqualify a variant
candidate. Variant calls and the filtering metrics for each hotspot allele are reported in the output variant
call format (VCF) file, including data for "ABSENT" or "NO CALL" variants.
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Results navigation bar overview

After you select a run result or a sample result, a results navigation bar appears and allows you to easily
toggle between different results screens for each run. You can quickly switch between run-level results,
assay-level results, and sample-level results for the run.

Assay-level results include assay metrics, such as final read data. Assay metrics are also shown in
the Run Report tab. For more information, see the Genexus™ Software help system or the Genexus™
Software 6.8 User Guide (Pub. No. MAN0026409).

Samples that are run with the same assay in the same run share the same Run Report. All other results
are specific to the sample and are shown in the sample results.

Results / OPA_Fus_w3.1.0_4s¥ / OPAFusionsw3.1.0¥ / SRTestSamplol¥

Select Sample

SRTestSampl01

SRTestSampl02

SRTestSampl01 QC Key Findings

Sample Details
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Callout

Dropdown
menu

Description

Run Name

The run name is listed. Multiple runs are listed only if the run has been reanalyzed. For
more information, see “Reanalysis” on page 178.

Select Assay

You can click the assay name of interest to view assay metrics for the run.

You can toggle between different assays used in the run. If only one assay is associated
with the run, only one assay name is listed.

Some results from a plugin that is included in the run, such as the customer support
archive (CSA) plugin, apply to all of the samples for an assay in a run. In this case, the
results from assay-level plugin are shown in the Plugins tab when you select an assay but
do not select any samples for the run. For more information about plugins, see “Review
plugin results in Genexus™ Software” on page 150.

You can choose Select Assay from the dropdown list to remove the assay selection.
Removing the assay selection opens the Run Summary tab for the run selected in the Run
Results dropdown list.

Select
Sample

You can click a sample name to view the sequencing results for the sample. You can click
a different sample name to view other sample results for other samples in the run for the
assay that is selected in Select Assay.

You can choose Select Sample from the dropdown list to remove the sample selection.
Removing the sample selection opens the Run Report tab for the assay selected in the
Select Assay dropdown list.

For Sample to Result runs that include a positive control, results for the positive control
are shown when you select Control Sample.

For Sample to Result runs that include a non-template control (NTC), results for the NTC
are shown only in the QC tab under Sample QC. The NTC sample is not listed in the Select
Sample dropdown list.
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View sample results

1.

Click Results » Sample Results to view sequencing results, including DNA variant and fusion
calls, for a particular sample.

In the Sample Name column, click a sample name.

In the Results screen, click the tabs to view the different types of sample-specific results and data.

Tab

Description

QC

The quality metrics for the sample sequenced in the run. For more information, see “View the QC
results” on page 129.

Key
Findings

An overview of the results for the sample, including Sample Details, Key Metrics, Key Variants and
Coverage Graphs. For more information, see “View key findings” on page 129.

Variants

Detailed variant results for SNVs/Indels, Fusions, and CNVs For more information, see “View SNV/
INDEL results” on page 137, “View Fusion results” on page 141, and “View CNV results” on
page 146.

Plugins

Results generated from the plugins associated with the assay used to analyze the sequenced
sample. For more information, see “Review plugin results in Genexus™ Software” on page 150.

Reports

You can download and generate summaries of run results. There are two types of reports:

* Run Reports - include assay metrics and the record of reagents that were used in a run. For
more information, see “Download a run report” on page 159.

¢ Variant Reports — include the variant results for each sample in a sequencing run, reagents used,
and QC evaluation metrics. For more information, see “Download a variant report” on page 160.

View the QC results

You can view the quality control (QC) metrics for each sample that was sequenced in a run in Genexus™
Software.

To view QC metrics, in the Results / Sample Results screen, click a sample name in the Sample
Name column. In the Results screen, click the QC tab.

For details about QC metrics, see the Genexus™ Software help system.

The QC status for each metric is indicated beneath each QC test (Run QC, Templating Control QC-
CF-1, Sample QC-DNA, Sample QC-RNA and if applicable, Purification QC, NTC QC-DNA, and
NTC QC-RNA).

View key findings

You can view Sample Details, a summary of the metrics for the run, biomarker results and the Variants
matrix for genes that were assayed in the run in Genexus™ Software.

You can view the Key Findings screen for a sample starting from either sample results or run results.
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In the menu bar:

¢ Click Results » Sample Results, then click a sample name.

* (Click Results » Run Results to open the Results / Run Results screen, then then click a run
name in the Run Name column, click a run name to open the Run Summary screen, You can then
select an assay from the Select Assay dropdown list and a sample name from the Select Sample
dropdown list.

Genexus DX | lon Torrent Dashboard

Results ( CC_Run3_5ak_31May2021 |mported_Reanalyzed ¥ [ ODxET cfTNAW2.7.0-0.0.15¥ [ SRTestSamplel3 ¥

SRTestSamplel8 QC Key Findings Variants Reports

You can toggle between different assays used in a run with the Assays dropdown list at the top of the
screen.

Review the key findings. For more information, see “View key findings” on page 129.

Key Findings

The Key Findings table shows details about the sample, a summary of key metrics for the run, and
coverage plots for genes assayed in the run.

Note: The Key Findings table is by default the first view that is first shown for sample results.

Table 11 Sample Details

Section Description
Sample Name A unique identifier representing the sample.
Collection Date The date that the sample was collected.
Gender The biological sex of the sample: Female, Male, or Unknown.
Sample Type A term that describes the sample, for example, FFPE, DNA, DNA & RNA.

Application Category | The application type of the sample.

Cancer Type The type of cancer that is represented by the sample.
Cancer Stage The stage of the cancer from which the sample was collected.
%Cellularity The percentage of tumor cellularity in the sample. This is a whole number between

1 and 100. The % Cellularity attribute is entered when a sample is created. The attribute is
applicable to FFPE samples only. The attribute is shown but not required.
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Section

Description

Target Coveragel'l

Target base coverage
at Nx

The percentage of reference genome bases covered by at least N reads.

Amplicon Summary

Average Base
Coverage Depth

The average number of reads of all targeted reference bases. This is the total number of
base reads on target divided by the number of targeted bases, and therefore includes any
bases that had no coverage.

Uniformity Of Base
Coverage

The percentage of bases in all targeted regions (or whole genome) with a depth of coverage
>20% of the mean read coverage. Cumulative coverage is linearly interpolated between the
nearest integer base read depths.

Percent Reads On
Target

The percentage of filtered reads that are mapped to any targeted region relative to all
reads mapped to the reference. A read is considered on target if at least one aligned base
overlaps at least one target region. If no target regions (file) was specified, this value is the
percentage of reads passing uniquely mapped and/or non-duplicate filters, or 100% if no
filters were specified.

Uniformity of
Amplicon Coverage

Uniformity of molecular coverage for all amplicons. This metric is generated from the
MolecularCoverageAnalysis plugin.

[l Metrics are shown only for analyses that run the coverageAnalysis plugin.

View the Key Variants matrix

The Key Variants matrix provides a color-coded visual representation of the variant results. When the
application category of the sample is Cancer or Cancer (Germline) the genes that are shown in the
Key Variants matrix are determined by the filter chain and the gene list applied to the results. You can
change the filters that are applied to expand or restrict the genes that are shown.

Each tile in the Key Variants matrix represents one gene and indicates whether a variant is detected
or not. Note that a single gene is represented with multiple tiles when there are multiple mutations
detected in that gene.
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You can view a color-coded visual summary of variant results in Genexus™ Software.

1. In the menu bar, click Results » Sample Results.

2. Click a sample name.
The Results screen opens to the Key Findings tab, which shows the Sample Details, Key
Metrics, the Key Variants, and the Coverage Graphs.

3. Refine the genes that are shown in the Key Variants matrix.

Action Procedure

Hide genes that were not Select or deselect the Not Assayed checkbox.
included in an assay but are
in a gene list.

Refine the genes that are a. Click Edit Filters.
shown in the Key Variants

matrix b. To refine or expand the genes, change one or both of the filters.

* Select a different filter chain or no filter chain.

* Select a different gene list or no gene list.

For more information, see the Genexus™ Software help system or
the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409).

c. Click Save.
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SRTestsampled4  gc Key Findings ~ Variants Plugins  Reports
Sample Details

SRTestSampledd t Male Core Needle Biopsy tegor Non-Small Cell Lung tag: 40

29 APR 2018 (CNB) Solid Tumar Cancer Stage |
Key Metrics

Target Coverage

'_IZ.-U.'Z-;}'-' ] . . 99.57%

Amp!imn Summary

6751 94.10% 97.20%

00 9 6 0

hrrw-w- Dececred | Ot Varlars Dewmsed e Devecoed Pt Aasayed Mot Assayed (4) Oncomine Variants (5.14) filter chain and Non-Small Cell Lung Cancer gene list applied Edit Filters

KRAS SNV/indel ALK BRAF EGFR

KRAS G13D

ange: p.Glyl3Asp
lele Frequency: 0.3%

MET MTRK2 NTRK3 ERBB2

NTRK1 RET ROS1

Example Key Variants matrix

@ Color coded legend to the variant tile matrix.
Key Variants Detected —A gene is present in the gene list, variants are annotated by the Oncomine™ Variant
Annotator plugin, and the variants are Key Variants. Genes that are called are listed in the Variants tab with Present
in the Call column. Key Variants are listed in the Variants tab, with a value of Yes in the Key Variant column.
For more information about gene lists, see the Genexus™ Software help system or the Genexus™ Software 6.8 User
Guide (Pub. No. MAN0026409).
Other Variants Detected —A gene is present in the gene list and variants are annotated by the Oncomine™ Variant
Annotator plugin, but the variants are not Key Variants. Genes that are called are listed in the Variants tab with
Present in the Call column. Variants that are not Key Variants are listed in the Variants tab, with a value of No in the
Key Variant column.
None Detected —A gene is present in the gene list but no variants are annotated by the Oncomine™ Variant
Annotator plugin.

Not assayed —A gene is present in the gene list, but is not included in the panel used in the assay.
@ Checkbox to hide or show genes that are not assayed.

@ Edit filters—Allows you to select an available filter chain and gene list. Changes of the filter chain or gene list change
the genes that appear in the Key Variants matrix.

@ Variant Name —The name of the variant. The Variant Name is a hyperlink to the pileup for the variant in the
Variants tab.
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View the amplicon coverage

You can view DNA exon amplicon coverage in Genexus™ Software to help you determine whether

the sequencing reads across a gene are uniform and sufficient. The default genes that are shown are
determined by the gene list that is designated as default for the cancer type of the sample. You can also
view amplicon coverage graphs for more genes. These amplicon coverage graphs provide a high-level
overview of coverage. More detailed coverage information is also available in the software.

1. In the menu bar, click Results » Sample Results.

2. Click a sample name to open the Key Findings tab in the Results screen.
3. Scroll to the amplicon Coverage Graphs.

4. Review the coverage graphs.

5. To show coverage graphs for more genes, scroll to the bottom of the screen. Click Show
Coverage for Gene, then select the gene of interest.

6. You can adjust the amplicon coverage graph with the pointer and the buttons in the upper right
corner of each graph. The coverage graphs change to show coverage for the selected gene.

Action Procedure
Zoom in on a region of interest. Click @ one or multiple times.
Zoom out for an expanded view. Click @ one or multiple times.
Revert to the default view. ¢ (Click @ one or multiple times.
¢ (Click Reset.
Move the image left or right in the screen. | After you zoom in, click-drag at any position in the image.

Note: Amplicons that extend beyond the gene start or end coordinates are not displayed in the
amplicon coverage graph. Coverage graphs are affected for 6 genes due to this issue: DDX41, ZRSR2,
CALR, CSF3R, ANKRD26, and CEBPA. Sequencing results and variant calls are not affected.
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Example amplicon coverage graph

Shown here is an example of an amplicon coverage graph for the KRAS gene.

KRAS Coverage

]
Damsy

el
|
D

@ Base coverage is shown on the y-axis on a logarithmic scale.
@ The location of the known hotspots are denoted with gray bars.

@ The location and span of the amplicons are represented with orange bars. You can hover the mouse over an orange
bar to view the amplicon name.

@ The location and span of the transcript track is denoted with green bars. You can hover the mouse over the green bar
to view the exon number.

(® The line along the x-axis is broken to indicate that the graph is discontinuous to show exons.
@ The genome coordinate position is shown on the x-axis.

@ Called variants are indicated with a vertical line above the blue coverage plot. The variants noted in the graph depend
on the filter chain applied to the results in the Key Variants matrix. For more information, see the Genexus™ Software
help system or the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409).

You can place the pointer over the hotspots that are represented with gray lines to view the hotspot name.
@ You can adjust the amplicon coverage graph. For more information, see “View the amplicon coverage” on page 134.

View variant results

You can view detailed variant results in the Variants table. In the default view, all variants are listed.
You can also limit the types of variants that are shown and toggle between different variant results:
SNVs/Indels, Fusions, and CNVs.

Table 13 Variant Tables

Variant type Description

SNVs/Indels| ® SNVs: missense and nonsense single nucleotide variants. Multi-nucleotide variants are
also included.

* Indels: insertion and deletion variants.

Fusions Translocations of genetic material.

CNVs Copy number variations (CNVSs) are variations of the number of copies of a given gene.
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Search and filter variant results

You can search and filter to narrow the list of results that are shown in the variant tables. You can
apply filters to columns of information that appear in the screen. The filters, available at the top of each
column, narrow the list of information in any columns to which filters are applied.

For more information, see the Genexus™ Software help system or the Genexus™ Software 6.8 User
Guide (Pub. No. MAN0026409).

1. In the menu bar, click Results » Sample Results.

2. Click a sample name in the Sample Name column.

3. In the Results screen, click the Variants tab.

4. Select the variant class to display the results: SNVs/Indels, Fusions, or CNVs.

5. In the table of variants, in the column heading of
interest, click Y (Filter). Ty Pf—'( ) Call

* |n the search field, enter at least 3 characters, then

click Filter. =E
* Select the checkbox in the row of each filter that ? oo
you want to apply, then click Filter. snp ;
del

The options that are available depend on the column
and variant class. For example, you can filter data in snp
the Type column to show one specific variant type.

del
6. Click {] Clear Filters to remove all filters and view )
the full list of run results.

The column or columns to which you applied a filter change Clear Filter
to reflect the filter and selected options. wh
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System-installed filter chains

The following Genexus™ Software system-installed filter chains are available for use with the
Oncomine™ Precision Assay GX results.

Note: System-installed filter chains are locked and cannot be changed.

System-installed Description
filter chain P
Oncomine™ Default filter chain that is optimized for reporting detected variants in FFPE samples
Extended 6.8 with the Oncomine™ Precision Assay GX. This filter chain includes all Oncomine™-
annotated variants and variants that can be relevant to cancer due to their inclusion in
one or more of the following classes.
* Non-targeted fusions.
® CNV variants with FILTER value of GAIN or LOSS.
¢ Likely somatic mutations based on dbSNP, 5000Exomes, EXAC, and UCSC
Common SNPs annotation source databases. The minor allele frequencies range
lies between 0.0 and 1.0E-6. Mutations must also be non-synonymous and occur
in exonic or splice-site regions.
¢ Variants with ClinVar annotations of pathogenic or likely pathogenic.
No Filter Select this filter chain to remove a previously applied filter chain and view all called
variants.
View SNV/INDEL results

The SNVs/Indels table lists the calls and other information for the SNV and INDEL variants that are
analyzed in each sample in a run.

To view the SNVs/Indels table for a sample, click Results » Sample Results in the menu bar, then in
the Sample name column, click the name of the sample of interest. Click the Variants tab, then click
SNVs/Indels. To export the data in tabular format, click Export in the upper right corner of the screen.

Molecular Tag and Hybrid-based variant calling

The Oncomine™ Precision Assay GX analysis of sequencing data from cfTNA samples uses Molecular
Tags, or Unique Molecular Indices (UMIs), to remove systematic and homopolymer errors when calling
SNV and Indel variants. Alternative allele variant calls are supported by families/molecules, resulting in a
very low limit of detection.

The Oncomine™ Precision Assay GX analysis of sequencing data from DNA samples uses UMIs to
remove homopolymer errors when calling SNV and Indel variants. Alternative allele variant calls are
supported by reads. Because both tags and reads are used in the variant calling algorithm, this
approach is referred to as the "Hybrid" method.
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SNVs/Indels table
The data displayed in the SNVs/Indels table depends on the assay that was used in the run.

You can filter the results list in the table using filtering tools and filter chains. For more information,
see the Genexus™ Software help system or the Genexus™ Software 6.8 User Guide (Pub. No.
MANO0026409).

Column Description

User Classifications User-defined classification to select from the list.

For more information, see the Genexus™ Software help system or the Genexus™ Software
6.8 User Guide (Pub. No. MAN0026409).

Variant ID The name of the hotspot as defined in the Browser Extensible Data (BED) file.
Click the link to view more annotation information. For more information, see .

Click the link to view more annotation information.

Variant Name The name of the variant.

Key Variant Indicates whether the variant is a key variant.
Possible values are Yes or No.

This information is available if the Apply Oncomine Variant Annotations checkbox is
selected in the assay used in the run.

Locus The chromosome and position of the detected variant.
Oncomine Variant The type of SNV or INDEL at the locus based on Oncomine™ annotations.
Class

This information is available if the Apply Oncomine Variant Annotations checkbox is
selected in the assay used in the run.

Oncomine Gene The change in molecular function of the altered gene product due to the mutation, based
Class on Oncomine™ annotations:

* Gain-of-function—The altered gene product has a new molecular function or pattern
of gene expression compared to the wild-type gene

* Loss-of-function—The altered gene product lacks the molecular function of the wild-
type gene

This information is available if the Apply Oncomine Variant Annotations checkbox is
selected in the assay used in the run.

Gene The gene name.

AA Change Identification of the amino acid change using Human Genome Variation Society (HGVS)
nomenclature.

Ref The reference base or bases at that locus.

Alt The alternate base or bases at that locus.
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Column

Description

Type

The type of variant that is detected.
* snp (single nucleotide polymorphism)
*  mnp (multi-nucleotide polymorphism)
* ins (insertion)
¢ del (deletion)
e complex
e FLT3-ITD

Call

Indicates the presence or absence of an SNV/Indel variant. When the default filter chain
is applied, only the variant calls that are designated with PRESENT (HOMOZYGOUS) or
PRESENT (HETEROZYGOUS) are displayed in the results table. To view all calls, including
calls that do not pass the required filter thresholds, apply the No Filter option or download
the Variants (VCF) file (see “Results files” on page 153).
¢ PRESENT (HOMOZYGOUS) or PRESENT (HETEROZYGOUS)—Indicates a high
confidence call that passes all filter thresholds at a given variant position.
— When the default filter chain is applied, PRESENT (HOMOZYGOUS) or PRESENT
(HETEROZYGOUS) indicates the presence of the ALT (alternative) allele.

— When the No Filter option is applied or when viewing the Variants (VCF) file,
Present does not imply the presence of the ALT (alternative) allele. To infer the
presence of the ALT allele, see the Alt column.

* NO CALL—Although some evidence for the presence of a variant exists, the call does
not pass one or more filters that are required for a high confidence variant call.

* ABSENT —Indicates that the variant is unlikely to be present in the sample.

Call Details

The reason why a variant is reported as NO CALL.

Phred QUAL Score

The relative probability of either the "reference" hypothesis interval [0,cutoff], or the
"variant" hypothesis interval [cutoff,1], Phred-scaled (-10*log10). A higher score means
more evidence for the variant call.

Raw Read Depth

Total read coverage across amplicon containing SNV/Indel hotspot locations. Count of
chip-level reads aligned at this locus that participate in variant calling.

Effective Read Depth

The number of reads covering the position.

Alt Allele Read The number of reads containing the alternate allele.
Counts

Coverage The number of total reads at a locus, wild-type + alt allele.
Nuc Change The position and identity of the nucleic acid change.

Allele Frequency

The number of variant read counts divided by the total number of read counts for the
sample.

Allele Frequency (%)

The allele frequency, represented as a percentage.

Allele Ratio

The relative frequency of each allele.

Oncomine™ Precision Assay GX User Guide

139



o

D

View sample results

Chapter 9 Review data and results

(continued)
Column Description
Mut/WT The ratio of mutant allele to wild-type allele.
Zygosity Describes whether the variant is homozygous (0) or heterozygous (1).

Filtered Read
Coverage

Coverage at the position considering only filtered reads.

Allele read Count

The number of reads detected for the allele. The Allele Read Count filter sets the minimum
count of the genotype alleles.

Raw Alt Allele Read
Counts

The number of unfiltered reads containing the alternate allele.

PPA

Possible Polyploidy Alleles (PPA).

A value of Yes indicates variants that are PPA alleles. A value of No indicates variants that
are not PPA alleles.

Homopolymer Length

The number of consecutive identical nucleotides adjacent to a variant.

P-Value

The probability value for the detection of variant calls.

Mol Depth

The reports number of interrogated DNA molecules containing target. This metric defines
the limit of detection at a hotspot position in a particular run and sample. For reference
calls, molecular depth provides a measurable metric that serves as confirmation of variant
absence among a large number of interrogated molecules. For instance, if molecular depth
is 1,500, you can have high confidence that no variant is present at =0.2% variant allele
frequency. If molecular depth is =2,500, you can have high confidence that no variant is
present at =0.1% variant allele frequency.

WT Mol Counts

The number of detected molecules containing the wildtype allele.

Alt Allele Mol Counts

The number of detected molecules containing the alternate allele.

Mol Freq %

Molecular frequency percentage. The percentage of alternate allele reads over total reads
at the locus.

% LOD

the limit of detection (LOD) of a variant allele expressed as a percentage of the WT allele.
LOD is the lowest possible variant frequency in the sample that can be detected by the
system with a true positive rate greater than 98% for FFPE samples or 95% for cfTNA
samples. LOD is dependent on the molecular read depth at the locus. %LOD is reported
when there are no variant calls for the gene.
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View Fusion results

You can view calls and other information for the fusions that are analyzed for each sample in a run.

1. To view the Fusions table for a sample, click Results » Sample Results in the menu bar, then in
the Sample name column, click the name of the sample of interest.

2. Click the Variants tab, then click Fusions.

3. To export the data in tabular format, click Export in the upper right corner of the screen.

Fusions table

The data displayed in the Fusions table depends on the assay that was used in the run.

You can filter the results list in the table using filtering tools and filter chains. For more information,
see the Genexus™ Software help system or the Genexus™ Software 6.8 User Guide (Pub. No.

MANO0026409).

Column

Description

User Classifications

A user-defined classification selected from the list.

For more information, see the Genexus™ Software help system or the Genexus™ Software
6.8 User Guide (Pub. No. MAN0026409).

Variant ID

The name of the fusion target as defined in the BED file.

Click the link to view more annotation information. For more information, see .

Variant Name

The name of the variant.

For more information, see the Genexus™ Software help system or the Genexus™ Software
6.8 User Guide (Pub. No. MAN0026409).

Key Variant Indicates whether the variant is a key variant.
Possible values are Yes or No.
This information is available if the Apply Oncomine Variant Annotations checkbox is
selected in the assay used in the run.

Locus The chromosome positions in the reference genome that define the fusion junction.

Oncomine Variant
Class

Oncomine variant class annotation that indicates fusion type based on Oncomine™
annotations. This information is available if the Apply Oncomine Variant Annotations
checkbox is selected in the assay that is used in the run.

Oncomine Gene Class

The change in molecular function of the altered gene product due to the mutation, based
on Oncomine™ annotations:

* Gain-of-function—the altered gene product has a new molecular function or pattern
of gene expression compared to the wild-type gene

¢ Loss-of-function—the altered gene product lacks the molecular function of the wild-
type gene

This information is available if the Apply Oncomine Variant Annotations checkbox is
selected in the assay used in the run.
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Column

Description

Genes (Exon)

The name of fusion target and representative acceptor and donor exons.

Read Counts

The frequency that the fusion was detected in the sample.

Type

Assay type, (for example, Fusion, RNA exon variant (exon skipping), RNAExon Tile, Proc
Control).

Call

Indicates the presence or absence of a fusion or RNA exon variant. When the default filter
chain is applied, only the fusion/RNA exon variant calls that are designated with PRESENT
are displayed in the results table. To view all calls, including calls that do not pass the
required filter thresholds, apply the No Filter option or download the Variants (VCF) file (see
“Results files” on page 153).

* PRESENT—indicates a high confidence call that passes all filter thresholds at a given
variant position.

* ABSENT—indicates the absence of a fusion due to a variant call that falls below
thresholds.

* NO CALL—although some evidence for the presence of a fusion exists, the call does
not pass one or more filters that are required for a high confidence fusion call.

Call Details

The reason for reporting a fusion as NO CALL or ABSENT.

Read Counts Per
Million

The number of fusion read counts detected per million total reads.

Oncomine Driver
Gene

The gene believed to be associated with increased oncogenic properties. The gene is
inappropriately activated by the fusion.

Gene Isoform

The name of the fusion target as defined in the BED file.

Mol Cov. Mutant

The median molecular coverage across a fusion amplicon.
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Column

Description

Imbalance Scorel'l

Each fusion gene exhibits a characteristic Imbalance Score threshold. Scores that exceed
the threshold value indicate a high likelihood of the presence of the fusion in the sample.
Imbalance score calculation starts with the normalization of reads in the exon-tiling
amplicons of the gene, followed by correction with a baseline that represents expression
values in normal samples. Reads for observed imbalance scores come from samples.
Baseline scores come from normal, fusion-negative samples and are stored in the exon tile
assay baseline file for the assay.

Imbalance score = Observed imbalance (in samples) / Expected imbalance (in the baseline)
where

Observed imbalance = 3' of breakpoint (in samples) / 5' of breakpoint (in samples)

¢ 3' of breakpoint is the sum of the normalized reads of amplicons 3' of a predicted
breakpoint for the gene in the sample.

* 5' of breakpoint is the total normalized reads of the amplicons for the gene in the
sample.
Expected imbalance = 3' of breakpoint (in the baseline) / 5' of breakpoint (in the baseline)

* 3' of breakpoint is the sum of normalized baseline values of amplicons 3' of the
breakpoint for the gene.

¢ 5'of breakpoint is the total normalized baseline values of the amplicons for the gene.

Imbalance P-Valuel'l

The statistical significance of measure of imbalance relative to a control gene.

Predicted Break-point
Rangel'!

The exonic range for predicted fusion break point in exon tiling assays.

Ratio To Wild Typel'!

The molecular ratio for exon skipping assays relative to wild type control amplicons.

Norm Count Within
Genelll

Exon skipping assay coverage normalized to molecular coverage of wild type (WT) MET
control amplicons.

[ Column appears only in analyses that use the exon tiling fusion detection method.

View RNA Exon Variants

The RNA Exon Variant data view displays a bar graph summary of intragenic exon rearrangements or
fusions. The displayed RNA exon variants are defined in the BED file that is associated with an assay.
The RNA Exon Variant data view is available for all RNA and fusion assays.

1. In the menu bar, click Results » Sample Results.

2. In the Sample name column, click the name of the sample of interest.

3. Click the Variants tab, then click Fusions.

The Fusions table opens to display fusions results. For more information, see the Genexus™
Software help system or the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409).

4. In the top right corner of the screen, click Visualization » RNA Exon Variant, then review the RNA
Exon Variants plot.

Oncomine™ Precision Assay GX User Guide 143


https://www.thermofisher.com/search/results?query=MAN0026409

n Chapter 9 Review data and results
0 View sample results

Representative RNA Exon Variant plots
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The X-axis represents specific exon variants, where each variant is labeled with a gene ID followed by a sequence of adjacent
exons. The Y-axis measures the read counts for each variant, normalized to the wild type.
@ Example result where only the wild type EFGR (EFGR.EGE7) was detected.

@ Example result where RNA exon 2-7 deletion occurred in the EFGR gene. The deletion of exons 2-7 resulted in an increase of
normalized read counts for the EFGR variant that contains the intragenic fusion of exon 1 and exon 8 (EFGR.E1E8.Del1) and a
decrease of normalized read counts for the wild type EFGR (EFGR.E6E7).

To return to the table view of fusions, click X (Remove) next to the Visualization dropdown menu.

View RNA Exon Tile Fusion Imbalance

The RNA Exon Tile Fusion Imbalance data view provides a visual representation of the RNA fusion
imbalance analyses.

Driver genes, for example ALK, RET, NTRK1, have amplicons that span exon-exon junctions to probe
the expression difference between the 3’ and the 5’ regions of the gene.

An imbalance score is calculated for each driver gene in a sample to quantify the magnitude of the
expression imbalance change between the two parts of the gene. For example, the 3’:5’ ratio in ALK;
and the 5:3’ ratio in FGFR2.

Note:

. The exon tiling method for fusion detection and the RNA Exon Tile Fusion Imbalance data view
are specific to the Oncomine™ Precision Assay GX and Oncomine™ Comprehensive Assay Plus GX
assays.

. The exon tiling method for fusion detection and the RNA Exon Tile Fusion Imbalance data view are
not enabled in the Oncomine™ Precision Assay GX cfTNA assay.

1. In the menu bar, click Results » Sample Results.

2. In the Sample name column, click the name of the sample of interest.
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3. Click the Variants tab, then click Fusions.
The Fusions table opens to display fusions results. For more information, see the Genexus™
Software help system or the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409).

4. In the top right corner of the screen, click Visualization » RNA Exon Tile Fusion Imbalance, then
review the RNA Exon Tile Fusion Imbalance plots.

Representative RNA Exon Tile Fusion Imbalance plots
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@ The Fusion Imbalance Call: Imbalance Score & P-value plot shows the imbalance scores and p-values for all the genes in
the selected sample. The dashed gray lines mark the threshold for an imbalance call, which is applied to all genes across all
samples. Points that fall within the blue shaded area of the plot represent imbalance-score positive genes (==). All other points
that are outside of the blue shaded area represent imbalance-score negative genes (O). Control genes are marked with ‘

@ The Normalized Read Depth by Gene plot shows the mean read counts of each gene that is captured on the chip for the
selected sample. For each gene, the read counts are normalized to the number of amplicons.
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@ The Sample Coverage for Imbalance Analysis plots show the expression profile for each exon-exon tiling amplicon for each
gene. The Y-axis represents the corrected molecular counts. The X-axis represents individual exon-exon junctions, which are
listed from 5’ to 3'. The imbalance score and p-value are listed in the panel of each gene that was called positive for fusion.

@ Baseline (a cluster of gray lines), generated from a fusion-negative sample.

@ Test sample corrected read coverage (blue line), normalized to the baseline. Each point on the line represents a unique

exon-exon junction that was covered by the assay and normalized to the baseline.
@ Predicted range for the fusion break point for a fusion-positive gene (dashed red line).

@ Sample coverage profile for the control gene (orange line).

@ If the collected data are insufficient to determine an imbalance score, the SAMPLE NOT VALID FOR <gene> IMBALANCE
ANALYSIS message appears in the panel for that gene.

To return to the table view of fusions, click X (Remove) next to the Visualization dropdown menu.

View CNV results

The CNVs table lists the calls and other information for the copy number variants (CNVs) analyzed in

each sample in a run.

To view the CNVs table for a sample, click Results » Sample Results in the menu bar, then in the
Sample name column, click the name of the sample of interest. In the Variants tab, click CNVs to
display the data. To export the data in tabular format, click Export in the upper right corner of the

screen.
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CNVs table

The data displayed in the table depend on the assay that was used in the run. Columns not displayed
by default can be added or removed from the table through the Columns dropdown list. You can filter
the results list in the table using filtering tools and filter chains.

IMPORTANT! (FFPE samples only) If the %Cellularity value for a sample is set to <100, then the
magnitude of copy number gain or loss can be decreased.

For more information, see the Genexus™ Software help system or the Genexus™ Software 6.8 User
Guide (Pub. No. MAN0026409).

Column Description

User Classifications | A user-defined classification selected from the list.

Variant ID The identifier of the CNV variant.

Click the link to view more annotation information.

Variant Name The standardized name of the variant.

Key Variant Indicates whether the variant is a key variant.
Possible values are Yes or No.

This information is available if the Apply Oncomine Variant Annotations checkbox is
selected in the assay that is used in the run.

Locus The starting position of the first amplicon covering the CNV gene.
Oncomine Variant Annotation that indicates whether CNV is an amplification or deletion.
Class

This information is available if the Apply Oncomine Variant Annotations checkbox is
selected in the assay that is used in the run.

Oncomine Gene The change in molecular function of the altered gene product due to the mutation, based on
Class Oncomine™ annotations.

* Gain-of-function—The altered gene product has a new molecular function or pattern of
gene expression, compared to the wild-type gene.

* Loss-of-function—The altered gene product lacks the molecular function of the wild-
type gene.

This information is available if the Apply Oncomine Variant Annotations checkbox is
selected in the assay that is used in the run.

Gene The gene name.

Copy Number The copy number of a CNV gene locus per genome.

Relative Fold Ratio of the gene copy number to the copy number of the chromosome arm on which the
Difference gene is situated.
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(continued)
Column Description
Call Indicates the presence or absence of a CNV. When the default filter chain is applied, only
the CNV-positive calls that are designated with PRESENT (GAIN) and PRESENT (LOSS)
are displayed in the results table. To view all calls, including calls that do not pass the
required filter thresholds, apply the No Filter option or download the All Variants (VCF) file
(see “Results files” on page 153).
* PRESENT (GAIN)—A CNV-positive call that indicates gene amplification; a high
confidence variant call that passes all filter thresholds.
* PRESENT (LOSS)—A CNV-positive call that indicates gene deletion; a high confidence
variant call that passes all filter thresholds.
* PRESENT —Indicates a high confidence call that passes all filter thresholds.
e ABSENT—The absence of a variant; result is below the detection threshold for a CNV
call.
* NO CALL—Although some evidence for the presence of a variant exists, the call does
not pass one or more filters that are required for a high confidence variant call.
P-Value The statistical significance of the CNV ratio measurement.
Call Details The reason for reporting a CNV as NO CALL.
Subtype The CNV subtype.
¢ BigDel—Deletion of at least one exon.
* BigDup—Duplication of at least one exon.
¢ GeneCNV—Whole BRCA1/BRCA2 gene deletion or duplication.
¢ NOCALL—Read count differs from baseline by non-integer amount; evidence for a
BigDel or BigDup call is weak.
* REF—Read count matches reference baseline.
¢ ARM-—Aneuploidy of a chromosome arm.
CNV Confidence The CNV confidence interval associated with the call. The 5% lower confidence bound
(Optional) value is the ploidy estimate, where there is a 5% chance that the true ploidy is below that
value. The 95% upper confidence bound is the ploidy estimate, where it is 95% certain that
the true ploidy is below that value.
Valid CNV Amplicons | The number of amplicons spanning the CNV call.
(Optional)
Type (Optional) The type of variant that is detected.
* CNV—Copy number variant
* LOH—Loss of heterozygosity
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Compare sample results

In Genexus™ Software, you can compare variant results across samples and create customized
comparison plots. To compare samples from different assay runs, the research application (such as
DNA or DNA and Fusions) must be comparable. That is, results from a research application must
include the type of results from the other research application. For example, results generated from
DNA-only assay runs cannot be compared to results generated from Fusion-only assays. Comparisons
that can be made are:

DNA-only vs DNA-only

DNA-only vs DNA and Fusions
DNA and Fusions vs Fusions-only
Fusions-only vs Fusions-only

In the menu bar, click Results » Sample Results.

Select the checkbox in the row of each sample that you want to compare, then click (|l Compare.

Note: Compare is not enabled until at least two samples are selected.

The Results / Compare screen opens and displays a list of variants and variant information in the
Compare Samples table. The Oncomine™ Extended filter chain is the default filter chain that is
applied to the data that are displayed in the tables. Only variants with a Variant ID are shown.

In the Compare Samples table, select the checkbox in the row of one or more variants of interest
to view the variants plot (see callout 1 in Figure 11).

Customize the variant view if needed.

Option Description
Customize table Click Table Columns, then select the columns that you want to view in the table,
columns or deselect the columns that you want to hide (see callout 2 in Figure 11).
Customize plot Click Chart Options (see callout 3 in Figure 11). In the Preferences dialog box,
axes select the desired X-axis, then select the desired Y-axis for each variant type.
Change the From the Filter Chain dropdown list, select a filter that you want to apply to the

default filter chain | variants that appear in the Compare Samples table (see callout 4 in Figure 11).
For a description of system-installed filters, see the Genexus™ Software help
system or the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409).

Click Export Variants to download the information in the Compare Samples variant table for the
selected variants.

See callout 5 in Figure 11.
The information is downloaded in XLSX format.

Click Download Chart to download the variants plot in PNG format (see callout 6 in Figure 11).
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Figure 11 Compare variants

@ Select one or more variants to compare in the variants plot.

@ Customize columns that appear in the Compare Samples table.

@ Customize the X-axis and Y-axis that appear in the variants plot.

@ Select a filter chain to filter the results that appear in the Compare Samples table.

(®) Download in XLSX format, the information in the Compare Samples variant table for the selected variants.
(6) Download a PNG file of the plot.

Review plugin results in Genexus™ Software

In Genexus™ Software, you can review plugin results in the Results screen for a sample.

Each plugin that was selected for an assay during assay creation is listed in the Plugins tab.

Results / [Runname] v / [Assay name] v /[Sample name] v
[Sample name] QC Key Findings Variants Plugins Reports

Review coverageAnalysis plugin results

The coverageAnalysis plugin generates a Coverage Analysis Report. This report includes read
statistics and several charts. The statistics and charts that are presented depend on the library type
for the analysis.

The report summary lists the barcode, the sample, the number of mapped reads, the percentage of on
target reads, mean base coverage depth, and base coverage uniformity.

You can download coverageAnalysis plugin output files from the Results screen for a sample. For more
information, see the Genexus™ Software help system or the Genexus™ Software 6.8 User Guide (Pub.
No. MAN0026409).

1. In the menu bar, click Results » Sample Results.

2. In the Sample Results screen, in the Sample Name column, click the sample of interest.
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3. Click the Plugins tab.
A summary table of the coverage analysis, by barcode, is included in the coverageAnalysis
summary pane.

4. (Optional) From the Executed At dropdown list, select an alternate timestamp, if available, to view
additional reports.

5. (Optional) Click [3 View Log to view the coverageAnalysis log.

6. (Optional) Click Ti] Delete to delete the coverageAnalysis plugin output for the selected timestamp.

IMPORTANT! If you click Ti] Delete, the report is deleted without the appearance of the

confirmation window. Ensure that you intend to delete the report before clicking [il Delete.

7. Click --- (More) » Download Files to download coverageAnalysis plugin results files.

Note: Sometimes the file name can be too long to open in applications such as Microsoft™
Excel™. To resolve this problem, right-click the file and click Save As to rename the downloaded
file.

8. In the coverageAnalysis summary pane, in the Barcode Name column, click the link in the row of
the barcode of interest.

The detailed Coverage Analysis Report for the barcode opens in a separate window.

Review molecularCoverage Analysis plugin results

The molecular Coverage Analysis plugin generates a Molecular Coverage Analysis Report. This report
includes molecule statistics and several charts. The report summary lists the barcode, the sample, the
median molecular coverage, the molecular uniformity, the median reads per functional molecule, and
the median percentage of functional reads. Additional details regarding molecular coverage are also
provided on a per-barcode basis, along with amplicon information that is included in the BED file.

You can download molecular Coverage Analysis plugin output files from the Results screen for a
sample. For more information, see “Results files” on page 153.

For more information on how to review and interpret read statistics and output files, see the Genexus™
Software help system or the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409).

Note: For Oncomine™ Precision Assay GX, the molecular Coverage Analysis output is applicable to
liquid biopsy assays only.

1. In the menu bar, click Results » Sample Results.
2. In the Sample Results screen, in the Sample Name column, click the sample of interest.

3. Click the Plugins tab.
A summary table of the coverage analysis, by barcode, is included in the molecularCoverage
Analysis summary pane.

4. (Optional) From the Executed At dropdown list, select an alternate timestamp, if available, to view
additional reports.
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5. (Optional) Click [3 View Log to view the molecular Coverage Analysis log.

6. (Optional) Click Ti] Delete to delete the molecular Coverage Analysis plugin output for the selected
timestamp.

IMPORTANT! If you click Til Delete, the report is deleted without the appearance of confirmation

dialog window. Ensure that you intend to delete the report before clicking [i] Delete.

7. Click : (More) » Download Files to download coverageAnalysis plugin results files.

Note: Sometimes the file name can be too long to open in applications such as Microsoft™
Excel™. To resolve this problem, right-click the file and click Save As to rename the downloaded
file.

8. In the molecularCoverage Analysis summary pane, in the Barcode Name column, click the link
in the row of the barcode of interest.

The detailed Molecular Coverage Analysis Report for the barcode opens in a separate window.

Download results files for a sample result

You can download results files for a sample result in Genexus™ Software.

1. In the menu bar, click Results » Sample Results, or Results » Run Results, then do one of the
following procedures.

Option Selection

Download files for a sample

Download results files for a In the Results / Sample Results screen, place the pointer over the row
sample from the list of sample | of a sample of interest, then click Download Files.

results.

Download resullts files for a 1. In the Results / Sample Results screen, in the Sample Name

selected sample from the

column, click the sample name of interest.
Results screen.

2. Click -+ (More Options) » Download Files.

Download files for a run or assay

Download results files for a In the Results / Run Results screen, place the pointer over the row of
run from the list of run results. | a run of interest, then click Download Files.

Download results files for a 1
selected run or assay from the
Results screen.

. In the Results / Run Results screen, in the Run Name column,
click the run name of interest.

2. Click the run or assay of interest from the results navigation bar.
3. Click -+ (More Options) » Download Files.

2. In the Download Files dialog box, select the files to download, then click Download.
For information about the files, see “Results files” on page 153.

The selected results files are downloaded in one ZIP folder.
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The following files can be downloaded from the View Results screen for each sample. The files that are
available for download vary depending on the assay used. Results files include the sequencing data,
results from the analyses, such as variant files, and audit and log files. For a list and descriptions of
plugin output files, see the Genexus™ Software help system or the Genexus™ Software 6.8 User Guide
(Pub. No. MAN0026409).

Option

File name

Description

Variants

Filtered Variants
(.vef)!!

<Filter name> filtered.vcf

Summary of filtered variant results in variant
call format (VCF).

All Variants (.vcf)[!]

Oncomine <LibPrepID>
<analysisID>.vcf

Summary of variant results in variant call
format (VCF).

Snvindel (.tsv)

Snvindel.tsv

File that lists SNV/INDEL variant results in tab-
separated value format (TSV).

Fusion (.tsv)

Fusion.tsv

File that lists fusion results in tab-separated
value format (TSV).

CNV (.tsv) Cnv.tsv File that lists copy number variant results in
tab-separated value format (TSV).

Sequencing Results

DNA Unmapped Bam | <barcode> Unmapped DNA barcode BAM file; output

File (.bam)

_rawlib.basecaller.bam

after mapping reads to reference.

DNA mapped bam
file (.bam)

merged.bam

Mapped BAM file of combined barcode reads.

DNA Mapped Bam
Index File (.bai)

merged.bam.bai

Mapped BAM Index file.

DNA Basecaller
FASTAQ File (.fastq)

<barcode> rawlib.
basecaller.fastqg

FASTQ file of the DNA barcodes used.

DNA Processed Bam
File

merged.bam.ptrim.bam

Mapped BAM file of combined barcode reads.

DNA Processed Bam
Index

merged.bam.ptrim.bam.bai

Mapped BAM index file.

RNA Unmapped Bam
File (.bam)

<barcode> rawlib.
basecaller.bam

Unmapped RNA BAM file; output of base
calling, contains unmapped reads.

RNA Mapped Bam
File (.bam)

<barcode> rawlib.
basecaller alignments.bam

Mapped BAM file of combined barcode reads.

RNA Mapped Bam
Index File (.bai)

<barcode> rawlib.
basecaller alignments.bam.bai

Mapped BAM index file.
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Option

File name

Description

RNA Basecaller
FASTAQ File (.fastq)

<barcode> rawlib.
basecaller.fastqg

FASTQ file generated from the unmapped
BAM file of the RNA barcodes used.

Test Fragment
Basecaller FASTAQ
File (.fastq)

rawtf.basecaller.fastqg

FASTQ file for the test fragment.

Audit and Log

Analysis Log File

analysis.log

Analysis log file.

Run Summary/?l

Info.csv

Contains information about the run and
analysis, including software version details,
sample details, library details, run details,
assay details, reagent and consumable
information, run and sample QC metrics, and
instrument summary.

Run Audit PlannedRun-AuditTrail.pdf Contains all audit records pertaining to the
run.

Reports

Report <language> <sampleName> <mode> |A PDF report that contains sample-specific

_<templateName> <assayName>
<date>.pdf

results. For more information, see “Variant
report” on page 159.

Sample Summaryt®!

Info.csv

Contains information about the run and
analysis, including software version details,
sample details, library details, run details,
assay details, reagent and consumable
information, run and sample QC metrics, and
instrument summary.

Troubleshooting Files

Log Filesl analysis.log Analysis log file.
summary.<timestamp>.log Start and end time for each time an assay
module is executed for the analysis.
various.err Analysis pipeline logs used by field service
. engineers for troubleshooting.
various.out
Info.csv Contains information about the run and
analysis, including software version details,
sample details, library details, run details,
assay details, reagent and consumable
information, run and sample QC metrics, and
instrument summary.
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Option File name Description

Log Filesl4 PlannedRun-AuditTrail .pdf Contains the audit trail of the run plan in PDF
format.

Otherl¥ analysis.ini Analysis configuration files, including

analysisSamples.3son secondary and tertiary INI files.

VCF Files analysis.vcf Summary of variant results in variant call

format (VCF).

' You can view the extracted files individually, or upload a VCF file to a software application that accepts VCF files, such as lon
Torrent™Oncomine™ Reporter software.

[ Files are available only for assays from Genexus™ Software version 6.2 and earlier.
Bl Files are available for both custom and system installed assays in Genexus™ Software version 6.6.
¥ Separate folders are generated for each sample. If included in the run, separate folders are also generated for an NTC and positive control.

Review run results

Use the Results / Run Results screen, runs that are pending, in progress, or completed are listed.
Runs with a status of failed, aborted, or stalled are also listed.

You can search the list of results when you click Y (Filter) in a column of interest, then entering a full or
partial run or assay name, or other applicable filter term.

The following run information appears in the Results / Run Results screen.

Column Description
Run Name The unique name of the run given when it was created in the software. Click a run name to
open the Run Summary.
Runs that are reanalyzed are listed with ¢& (Reanalysis) after the run name.
Assay Name The name of the assay selected for the run. You can view the Assay Name and corresponding
Assay Full Name for all assays in the Assays » Manage Assays screen.
Run Status The status of the run. For example, Analysis In Progress, Executing Plugin, Analysis

Completed, Terminated, Archival: In Progress, Purification In Progress, or Purification
Completed).

Total Samples

The total number of samples in a run.

PCR Plate Number

A unique identifier for the 96-well plate used for library preparation and templating. For more
information, see “Assign the PCR Plate” on page 157.

Started On

The date and time when the run was started.

Updated On

The date and time when the last action was completed on the run.

Users with appropriate permissions can perform the following actions in the Results / Run Results

screen.
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Option

Description

that are available depend on the type of run.

Actions | Available action links for a run are shown when you place the pointer over the row of a run. The actions

¢ BAM Uploader—Upload run information to another Genexus™ Software server or to lon Reporter™
Software for further analysis. BAM Uploader is not available for BAM run results or for archived runs

in which BAM files have been removed.

* Audit—View the audit trail for the run.

¢ CSA—Download customer support archive (CSA) log files for the run to help with troubleshooting.

¢ Assign PCR Plate—Enter a unique identifier for the 96-well plate used for library preparation and
templating. This action is available only in Sample to Result and Nucleic Acid to Result runs after the

run completes.

* Download Files—Select the Variants, Reports, Sequencing Results, Audit and Log, and

Troubleshooting Files to download.

View the run summary

The run summary provides an overview of the run. The information that is displayed includes the

name of the assay used in the run, sample locations, information about the reagents used in the run,
primer tube positions, and instrument information. Metrics from sample purification are also provided, if
applicable.

1.

In the menu bar, click Results » Run Results.

2. In the Run Name column, click the run name of interest.

The Run Summary tab opens.

3. Review the run summary.

156

Action

Procedure

View the assay metrics. In the Assays section, click the assay name of interest.

a 96-well sample plate.

View the sample locations in an image of |In the Sample Locations section, click PCR Plate View.

Reanalyze a run with a new assay. In the upper right corner of the screen, click
+++ (More Options) » Reanalyze.

Run plugins on the sequencing data after |In the upper right corner of the screen, click

Software for further analysis.

a sequencing run is complete. +++ (More Options) » Run Plugin.
Download customer support archive In the upper right corner of the screen, click
(CSA) log files for the run to help with .-+ (More Options) » CSA.

troubleshooting.

Upload results to another Genexus™ In the upper right corner of the screen, click
Software server or to lon Reporter™ .-+ (More Options) » BAM Uploader.

View the history of variant classifications. |In the upper right corner of the screen, click
-+« (More Options) » Variant Audit.

View the run report. Click the Run Report tab.
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Assign the PCR Plate

In Sample to Result and Nucleic Acid to Result workflows, Genexus™ Software allows you to track
and associate a run with the PCR plate used in the run. The PCR plate is the 96-well plate that is used
for library preparation and templating. You can assign a unique identifier, a PCR Plate Number, to runs
that have a status of Library Preparation Completed, Sequencing Completed, or Run Completed.
The PCR plate number that you enter is shown in the Run Results screen and if needed, can help you
track libraries and troubleshoot. Later, if you sequence the remaining libraries in a different sequencing
run and assign the PCR plate number to the run, you can easily search for and find all run results
associated with the libraries in the PCR plate.

1. In the menu bar, click Results » Run Results.

2. In the Run Results screen, place the pointer over the row of a run of interest, then click Assign
PCR Plate number.

3. In the Assign PCR Plate Number dialog box, confirm, edit, or enter the PCR Plate Number.

The PCR plate number must be between 1 and 10 characters. Only alphanumeric characters
(numbers 0 to 9 and letters A to Z), period (.), underscore (_), or hyphen (-) are allowed. Spaces are
not allowed.

4. Click Submit to associate the PCR plate with the run.

View assay metrics and the run report

The run report provides detailed information about a run, such as the Total Bases and Final Reads. For
runs with multiple assays, metrics are provided for each assay in the run. The run report contains the
assay metrics for all assays in the run.

For runs with only one assay, the run report and assay metrics show the same information for assay
metrics. In addition to the metrics for the assay, the run report shows information about the run and the
instruments used in the run.

1. To view the Run Report, in the Results / Run Results screen, in the Run Name column, click the
run name of interest. In the Run Summary screen, click the Run Report tab.

The Run Report is assay-specific and cannot be viewed within the sample results screens. To
view the Run Report, ensure that Select Sample is selected in the Select Sample dropdown
menu.

2. Click Results » Run Results to view sequencing results for a particular sample.

3. In the Run Name column, click the run name of interest.

Action Procedure

View the run report Click the Run Report tab.

View the assay metrics for a single | In the Select Assay dropdown list at the top of the screen,
assay select the assay of interest.
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For more information, see the Genexus™ Software help system or the Genexus™ Software 6.8 User
Guide (Pub. No. MAN0026409).

Assay metrics and the run report

158

The run report provides detailed information, such as chip metrics for the run, well, and lon Sphere™
Particles (ISPs) statistics. For runs with multiple assays, metrics are provided for each assay in the run.
Sequencing metrics are shown at the top of the screen, followed by sample-specific metrics in the Run
Samples table. Read data for individual samples for the assay are listed in the Run Samples table.

Barcode-specific metrics for barcodes that are included in the run are listed in the Barcodes With
Reads Reported table, which follows the Run Samples table. The CSA file for the run contains
information for barcodes that are not assigned to samples in the run. Information in the CSA file can
help you troubleshoot results, if needed. For more information, see the Genexus™ Software help system
or the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409).
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For descriptions of each assay metric, see the Genexus™ Software help system or the Genexus™
Software 6.8 User Guide (Pub. No. MAN0026409).

View resequencing metrics
For assays that include resequencing, you can view resequencing metrics when a run is complete.

1. In the menu bar, click Results » Run Results.
2. In the Run Results screen, in the Run Name column, click the run name of interest.

3. In Select Assay, select the assay name of interest.
The assay metrics for the sequencing run are shown.

4. Click Resequencing Metrics.
The resequencing metrics for the assay are shown.
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Variant report

Download a run report

You can download a run report summary in PDF format. The run report includes assay metrics and the
record of reagents that were used in a run. For information about the contents of the run report, see the
Genexus™ Software help system or the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409).

If you entered extraction kit barcodes for samples when you prepared library batches or when you
planned the run, the extraction kit barcodes are listed in the run report.

1. In the menu bar, click Results » Sample Results.
2. In the Sample Results screen, in the Sample Name column, click the sample name of interest.

3. Click the Reports tab.

Multiple panes including a Run Report pane, a Variant Report pane, and any panes for
customized reports that have been generated are shown.

4. Inthe Run Report pane, click Download Report to download a run report summary in PDF
format.

Variant report

A variant report is a PDF report of the results for each sample in a sequencing run. You can use
a system-installed report template. For system installed report templates, the assay used in the run
determines the data that are included in the report.

Alternatively, you can customize the layout and contents of a variant report.

To automatically generate a variant report for each sample during data analysis of a run, enable
Generate Report in the Setup step when you plan the run (for more information, see Chapter 4, “Plan
and manage runs”). Alternatively, if you did not enable this feature, you can generate a variant report for
each sample after a run is complete. For more information, see the Genexus™ Software help system or
the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409).

When a variant report has been generated for a sample, it is available for download in two places:

* Alink is available in the Results / Sample Results screen when you place the pointer over the row
for that sample. Click the link to download the PDF.

* A Download Report button is available in the Variant Report pane in the Reports tab.

Variant reports can be electronically or manually signed by users. Electronically signed reports have

[r (Sign off) after the sample name in the Sample Results screen. The electronic signature is included
in the footer of the report. If included, electronic signatures also appear in the Electronic Signature
section of the report. A sample name followed by & (Locked) indicates that the variant report is
locked. For more information, see “Sign off on the run results” on page 160.

For more information about variant reports and report templates, see the Genexus™ Software help
system or the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409).
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F5¥ Chapter 9 Review data and results
Variant report
Download a variant report

You can download a variant report for a sample result of interest from the Results / Sample Results
screen.

Note: The variant report is also available for download as part of the results files in the Results screen
for a specific sample. For more information, see “Results files” on page 153.

1. In the menu bar, click Results » Sample Results.

2. In the Sample Results screen, place the pointer over the row of the sample of interest, then click

Report.
Genexus [ lon Torrent Dashboard Samples Runs RESTS Assays .Iﬂ =3 g
Resuit
Non Archived = Selected Samples: 0 Lo C'H
Sample Name Y AssayName Run Name Y  Sample Status T

tSampleor & & OPA CFTNA w3.0. CFT sign Tags | Audit | Not SA | Variant Audit | Reanalyze i

A ZIP file that contains the PDF report downloads automatically.

3. Extract the downloaded files, then open the PDF file in an appropriate viewer.

Sign off on the run results

Multiple users can sign variant reports. In the Results / Sample Results screen, a sample name
followed by [ indicates that the sample results are signed off by at least one user. A sample name
followed by & indicates that the variant report is locked. After a variant report is locked, the report

is no longer available to be signed by any other user. The signature information appears in the variant
report PDF file. For more information, see “Variant report” on page 159.

Multilanguage support for PDF report generation is provided.

This feature allows you to meet Title 21 CFR Part 11 of Federal Regulations that establishes the
United States Food and Drug Administration regulations on electronic records and signatures, password
policies, and user activity auditing.

Permission to sign reports must be enabled in order to sign reports. An administrator-level user
manages electronic signature permissions for user accounts. For more information, see the Genexus™
Software help system or the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409).

1. In the menu bar, click Results » Sample Results.
2. In the Sample Results screen, in the Sample Name column, click the sample result of interest.
3. In the upper right corner of the screen, click --- (More Options) » Sign Off.

4. In Password, enter the password.
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Variant report

In the Electronic Signature dropdown list, select the meaning of the signature.

Administrator-level users configure the meaning of electronic signatures. One type of signature is
designated to lock a variant report when the report is signed.

In the Report Template dropdown list, select the report template that you want to use.

The option to select the report template is available only before the variant report has been signed
by any user.

In Sign Off Comments, enter a comment.

In Report Name, change the name of the report if needed.

The option to change the report name is available only before the variant report has been signed
by any user.

In Select Your Language, change the language of the report if needed.

The option to change the language is available only before the variant report has been signed by
any user.

In Footer Field, enter any text that you want to appear in the footer of the PDF report pages.

If you entered footer information in the Footer Field when you created a report template, the
same footer information appears in the Electronic Signature dialog box. You can enter new footer
information to override the report template.

Click Sign Off to confirm the electronic signature.

The report is signed. If the signature is designated to lock the report, the variant report is signed and
locked.

For information to download the signed report, see “Download a variant report” on page 160.
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Oncomine™ Precision Assay GX

Observation

Possible cause

Recommended action

The number of assigned GX5™ Chip
lanes is 2X more than expected when
planning a run for FFPE samples using
the Oncomine™ Precision - GX5 -
w3.4.2 - Combined - Solid Tumor -
DNA and Fusions assay.

In the Samples step of run
plan creation, FFPE DNA
and FFPE RNA samples
are assigned to an assay
separately.

When entering samples for use with the
Oncomine™ Precision - GX5 - w3.4.2

- Combined - Solid Tumor - DNA and
Fusions assay, in the Add New Sample
dialog box, select DNA & RNA from
Sample Type dropdown list (see “Enter
samples in the Genexus™ Software” on
page 34). The minimum reads assigned
to each FFPE sample that includes DNA
and RNA is 3,000,000. Each sample is
assigned as a DNA and RNA set on the
plate layout when planning the run. When
the run completes, the results display
both DNA and Fusions results for the
sample.

High byproduct peak is observed in the
Read Length Histogram for an FFPE or
catnap sample.

Read Length Histogram

In the Results > Run Results > View
Results screen for the sample, click QC to
review the Read Length Histogram.

The quality of the FFPE
sample is poor due

to crosslinking, which
cannot be measured by
the Agilent™ Bioanalyzer™
Instrument or TapeStation.
Chemical fixation of tissue
can cause excessive
crosslinking of samples,
resulting in poor DNA or
cDNA amplification.

Repeat the sequencing run using a good
quality FFPE sample.

Use a sample control in your sequencing
run to determine if the quality of your
sample is poor (see “Recommended
sample controls” on page 21).
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Oncomine™ Precision Assay GX

Observation

Possible cause

Recommended action

High byproduct peak is observed in the
Read Length Histogram for an FFPE or
catnap sample.

Read Length Histogram

In the Results > Run Results > View
Results screen for the sample, click QC to
review the Read Length Histogram.
(continued)

Sample input is low due to
the use of incorrect sample
concentration, dilution, or
volume.

Ensure sample concentration and dilutions
as described in “Quantify nucleic acid
samples” on page 100 and “Dilute the
samples (if needed) and load the sample
plate” on page 101, then repeat the
sequencing run using the correct sample
concentration and volume.

Significantly lower number of reads
observed for the last one or two
samples.

Note: The number of reads for each
sample that was used in a run can
be viewed in the Run Metrics screen
of the run results, in the Total Reads
column of the Run Samples table.

When setting up the

run, reagents were not
collected at the bottom of
the strips. This can cause
insufficient reagent volume
for the last few samples.

Before you load the reagents into

the sequencer, prepare the strips as
described in “Before you begin” on

page 109, then repeat the sequencing run.

cfTNA sample — CNV QC failed.

Details: The MAPD QC metric did not
fall within the range that was specified
by the assay.

The extraction of cfTNA
was unsuccessful.

Use the recommenced kits for

cfTNA extraction and carefully follow
the manufacturer's protocol. For

more information, see “Recommended
materials for nucleic acid isolation,
quantification, and quality control” on
page 21.

Ensure that the extracted cfTNA samples
pass quality control before starting the
sequencing run. For more information, see
“Evaluate nucleic acid sample quality” on
page 100.

DNA is degraded.

Follow the instructions from the blood
collection tube manufacturer for sample
collection and storage.

Use the RNaseZap™ RNase
Decontamination Solution to
decontaminate your workspace before
sample processing.

Use a sample control in your sequencing
run to determine whether the quality of
your sample is poor (see “Recommended
sample controls” on page 21).
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Genexus™ Integrated Sequencer—general and QC troubleshooting

Observation

Possible cause

Recommended action

Fusion QC failed.

Details: The RNA Expression Ctrls
Detected QC metric did not fall within
the range that was specified by the
assay.

The RNA yield from cfTNA
or FFPE sample was low.

Use the recommended kits for sample
preparation. For more information, see
“Recommended materials for nucleic
acid isolation, quantification, and quality
control” on page 21.

RNA was degraded in
cfTNA or FFPE samples.

Follow the instructions from the blood
collection tube manufacturer for sample
collection and storage.

Store cfTNA samples at —80°C to prevent
RNA degradation.

Use a sample control in your sequencing
run to determine whether the quality of
your sample is poor (see “Recommended
sample controls” on page 21).

Genexus™ Integrated Sequencer—general and QC

troubleshooting

Observation

Possible cause

Recommended action

A consumable is not recognized by the
sequencer after loading on the deck

The consumable (for
example, a strip, pipette
tip box) is correctly
placed but is not
completely inserted into
its position, causing it
to be misaligned with its
expected position.

Ensure that the consumabile is pressed
completely into place. Apply firm pressure
on the item so that it fits snugly into its
deck position.

The barcode of the
consumable is not
readable by the
instrument.

Tap Help in the lower left corner of the
Load Instrument screen and follow on-
screen instructions to override the block
manually. Note that the name of the
consumable does not appear in the list of
consumables in the run summary.

If the behavior continues in subsequent
runs, contact Technical Support.

Consumable version
does not match the
Genexus™ Software
version. For example, a
consumable compatible
with Genexus™
Software 6.6 is installed
in a sequencer updated
for Genexus™ Software
6.8.

Ensure that you are using consumables
compatible with the software installed on
the sequencer.

164

Oncomine™ Precision Assay GX User Guide



Appendix A Troubleshooting

Genexus™ Integrated Sequencer—general and QC troubleshooting

Observation

Possible cause

Recommended action

A consumable is not recognized by the
sequencer after loading on the deck
(continued)

The expiration date of
the consumable has
passed.

Ensure that you load consumables that
have not exceeded their expiration dates.

The instrument camera
is not functioning
properly.

If no other cause can be found for the
issue, there may be a problem with the
camera. Contact Technical Support.

Run Status = Failed

Details: In the Genexus™ Software Run
Result screen, the Run Status for a
completed run is listed as "Failed". In
the Sample Results screen, the Sample
Status is listed as "BaseCallingActor
FAILED".

Chip calibration failed
due to a chip problem,
or an instrument
problem.

Repeat the run with a new chip. If
the problem persists, contact Technical
Support.

A lane that has been used is not crossed
out in the sequencer screen

Details: After completion of a run, the
lane used in the run was not crossed out,
so that the next run could reuse the lane.

A chip problem caused
a datacollect failure to
read efuse.

In the sequencer screen, tap

Settings » Clean instrument to perform
a clean instrument. For details, see

the Genexus™ Integrated Sequencer User
Guide (Pub. No. MANOO017910). After
cleaning, start a new run.

Note: The Clean instrument procedure
renders remaining sequencing reagents
and unused lanes on the installed chip
unusable in a sequencing run after the
cleaning.

The number of sample reads is low, CF-1
metrics pass QC, but read ratio of inline
controls is low

Details: If CF-1 reads per lane,
accuracy, and mean AQ20 read length
are good, and read ratio of inline
controls (endogenous vs. spike-in) is
low (<< 3), a problem with sample

input is indicated. For more information,
see “Troubleshoot Genexus™ Integrated
Sequencer performance with CF-1 and
inline controls” on page 168.

Nucleic acid input may
have been insufficient,
and/or the nucleic acid
was degraded.

For a sample run, requantify nucleic acid
samples and/or perform sample QC to
ensure that the expected nucleic acid input
and size was loaded.

If needed, reisolate and purify nucleic acid
samples.

The number of sample reads is low, but
CF-1 metrics pass QC, and read ratio of
inline controls is normal

Details: If CF-1 metrics passed QC, and
read ratio of inline controls is normal

(~ 3), a problem in library preparation
unrelated to sample input or quality

may be indicated. For more information,
see “Troubleshoot Genexus™ Integrated
Sequencer performance with CF-1 and
inline controls” on page 168.

One or more of the
Genexus™ Strip 1
strips used in the run
had magnetic beads
trapped in the tube 5
keyhole.

Repeat the run with strips that you have
verified have no trapped beads. For more
information, see “Before you begin” on
page 109.

An incorrect assay was
selected for the run,

or library amplification
parameters were not
optimal.

Ensure that you have selected the correct
assay and reviewed assay parameters.
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Genexus™ Integrated Sequencer—general and QC troubleshooting

Observation

Possible cause

Recommended action

The number of sample reads is low, but
CF-1 metrics pass QC, and read ratio of
inline controls is normal

Details: If CF-1 metrics passed QC, and
read ratio of inline controls is normal

(~ 3), a problem in library preparation
unrelated to sample input or quality

may be indicated. For more information,
see “Troubleshoot Genexus™ Integrated
Sequencer performance with CF-1 and
inline controls” on page 168.

(continued)

Library strips

were inadequately
equilibrated to room
temperature (Genexus™
Strip 1), or incompletely
thawed (Genexus™
Strip 2-AS or Genexus™
Strip 2-HD) before
loading in the
sequencer.

Ensure that Genexus™ Strip 1 strips are
fully equilibrated to room temperature, and
Genexus™ Strip 2-AS strips are completely
thawed before loading in the sequencer.

The number of sample reads is low, and
CF-1 metrics fail QC

Details: If CF-1 metrics failed QC, a
problem in templating or sequencing

is indicated. For more information,

see “Troubleshoot Genexus™ Integrated
Sequencer performance with CF-1 and
inline controls” on page 168.

One or more of the
Genexus™ Strip 3-GX5™
strips used in the

run may have had

an excessive amount
of magnetic beads
trapped in the tube 6 or
7 keyhole.

Repeat the run with strips that you have
verified have no trapped beads. For more
information, see “Before you begin” on
page 109.

Template strips

were inadequately
equilibrated to room
temperature (Genexus™
Strip 3-GX5™), or
incompletely thawed
(Genexus™ Strip 4)
before loading in the
sequencer.

Ensure that Genexus™ Strip 3-GX5™ strips
are fully equilibrated to room temperature,
and Genexus™ Strip 4 strips are completely
thawed before loading in the sequencer.

The sequencing chip or
coupler was faulty or
leaky.

Repeat the run with new chip and coupler.
If low performance continues, contact
Technical Support.

The run was started
>14 days after the

last initialization was
performed, or on an
expired initialization.

Perform a Clean instrument procedure
(Settings » Clean instrument), install new
a chip, and new sequencing reagent
bottles and cartridge in the sequencing
reagents bay, then repeat the run.

Note: Reagents are stable on the
sequencer for 14 days, after which you
may experience reduced performance.
For further information, see Appendix
A: Troubleshooting in the Genexus™
Integrated Sequencer User Guide
(Pub. No. MANO017910).
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Appendix A Troubleshooting

Genexus™ Integrated Sequencer—general and QC troubleshooting

Observation

Possible cause

Recommended action

Panel primer tubes lifted from the
Genexus™ Primer Pool Tube station

The tubes became
loose.

Use the Genexus™ Primer Pool Tube
Holder to secure the tubes in place. For
information about using the Genexus™
Primer Pool Tube Holder, see “Load the
sequencer and start a run” on page 113.

Sample QC passes, but CF-1 Mean AQ20
Read Length QC fails

Reads were filtered due
to low quality ISPs
caused by too much
library input in the
templating reaction.

Recover the unused pooled sample library
from the run, then plan and perform a
Library to Result run with diluted library.

1. To recover the pooled sample libraries
from well E4 of the PCR amplification
plate after the run, follow the
procedure described in the Recover
the pooled sample libraries section in
the Genexus™ Integrated Sequencer
User Guide (MANO017910).

2. Add the recovered pooled sample
libraries to well A1 of a new sample
plate and dilute.

* For a4-lane run, add 49 pL of
the pooled libraries to well A1,
then add 91 pL of nuclease-free
water or Low TE to bring the total
volume to 140 pL.

* Fora2-lane run, add 28 pL of the
pooled sample libraries to well
A1, then add 52 pL of nuclease-
free water or Low TE to bring the
total volume to 80 pL.

3. Pipet the contents of well A1 up and
down 4-5 times to mix.

4. Plan and perform a Library to Result
run with the diluted library. For
more information, see the Genexus™
Integrated Sequencer User Guide
(MANO0017910).
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Appendix A Troubleshooting
Troubleshoot Genexus™ Integrated Sequencer performance with CF-1 and inline controls

Troubleshoot Genexus™ Integrated Sequencer performance
with CF-1 and inline controls

You can use quality control results to troubleshoot Genexus™ Integrated Sequencer runs to help identify
the cause of performance problems. If you select the Include Inline Controls checkboxes for DNA and
RNA in the Reagent step when you create an assay (see ), you include the inline control analysis in

the post-run results analysis. Inclusion of a set of six control amplicons (covering a range of amplicon
length) and spike-in nucleic acid into sample library preparation reactions helps determine whether poor
performance is due to insufficient sample input and/or poor sample quality, or is unrelated to sample
input and quality. With 10 ng sample input, the read ratio of endogenous sample reads to spike-in
control reads is expected to be ~3. Using more than 10 ng sample input results in a proportionally
higher read ratio. For example, if you load 20 ng of sample, the read ratio should be ~6.

The CF-1 templating control serves as a check on templating and sequencing performance that is
independent of library preparation.

Use the following table as a guide to help identify the source of performance problems. For
recommended actions, see the troubleshooting topics under “Genexus™ Integrated Sequencer—
general and QC troubleshooting” on page 164.

Run diagnostic

QC category Sample input Library preparation Templating or
Successful run and/or quality problem unrelated to Sequencing
problem sample problem
Sample QC (endogenous Passed Failed Failed Failed

sample reads)

Read ratio for inline controls Normal Low Normal or variable —
(endogenous to spike-in reads) | Read ratio ~3 Read ratio <<3

Templating Control QC - CF-1 Passed Passed Passed Failed
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Appendix A Troubleshooting
Genexus™ Software

Observation

Possible cause

Recommended action

Cannot sign in
to the Genexus™
Software

You have either forgotten
your password or are
signed out due to several
failed login attempts.

Contact the Genexus™ Software system administrator.

Batch sample
import fails

One or more entries

in the sample-import
spreadsheet contains
special characters, lines
breaks, unexpected
spaces, incorrect entry
length, incorrect date
formatting, or other
formatting errors.

Check each entry for correct formatting, correct any errors,
and repeat the import.

Blank rows were copied
into the sample-import
template file from a
different source.

Rows that appear empty can contain hidden formatting that
conflicts with the import function. Start with a clean sample-
import template file, and be careful to copy only those rows
that contain actual data.

The sample import
spreadsheet contains a
nonunique sample name.

Every sample name in the software must be unique. Ensure
that the spreadsheet does not contain any duplicate sample
names, then repeat the import. Note that the system check is
not case-sensitive, so a sample name of ABC1 conflicts with
abc1.

The headings in

the sample import
spreadsheet do not match
the sample attributes in
the software.

The headings must match the sample attributes in the
software exactly. Check the headings for spelling or other
errors.

Map a sample attribute if needed.

Cannot upload my
panel or hotspots

Issues with BED file
format or files do not end
in.bed.

Ensure your file is in the correct BED format and has a .bed
extension.

Variants tab is
missing hotspot
entries

Details: The
remaining entries
are present.

Hotspot BED file contains
entries that are incorrectly
formatted.

Check that BED file entry is correctly formatted. See the
following examples:

SNP entry: chr1 2337276 2337277 SVA_322 0 +
REF=C;0BS=T;ANCHOR=G AMPL

Deletion entry: chr1 201341175 201341180 SVA_497 0 +
REF=AGAAG;OBS=;ANCHOR=C AMPL

Insertion entry: chr1 236978992 236978992 SVA_621 0 +
REF=;0BS=TCTG;ANCHOR=T AMPL

Ensure that the REF values match the actual reference
coordinate of hg19.
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Observation Possible cause Recommended action
No information for The wrong hotspot or BED 1. Check the hotspot and BED files associated with the
my loci of interest in | file is associated with the assay. If either is incorrect, create a new assay.
the results assay. 2. Plan a new run for the sample or sample library with the

correct assay.
3. Repeat sequencing of the sample or sample library.

The results of the The instrument disk space | Clear disk space on the sequencer. For more information,

run do not appear is full. see "Manually delete run data" in the Genexus™ Integrated

in the Results / Run Sequencer User Guide (Pub. No. MAN0017910).

Results screen

Cannot download The run failed. Create an assay with the correct configuration for the samples,
run result files then reanalyze the samples.

170 Oncomine™ Precision Assay GX User Guide


https://www.thermofisher.com/search/results?query=MAN0017910

Oncomine™ Precision Assay GX
Genexus™ reagent strip and panel tube fill volume guide
Create a template for importing samples in standalone configuration purification run plans . ..
Lane usage by sample type
Fusion detection methods
No-template controls
Reanalysis
Example metrics for a successful sequencing run

Clean the Genexus™ Primer Pool Tube Holder

Generate a variant report

Supplemental information

Oncomine™ Precision Assay GX

Oncomine™ Gene

Variant type class Oncomine™ Variant class Annotation criteria
Copy number Gain-of-Function Amplification SVTYPE = "CNV"
amplification FILTER = "GAIN"

Occurs in a designated copy-gain gene

Copy number Loss-of-Function Deletion SVTYPE = "CNV"
deletion FILTER = "LOSS"
Occurs in a designated copy-loss gene
Gene fusion Gain-of-Function Fusion SVTYPE = "Fusion"
FILTER = "PASS"
Is a targeted fusion isoform
RNA exon variant | Gain-of-Function RNAExonVariant SVTYPE = "RNAExonVariant" or "Fusion"

FILTER = "PASS"

Is a targeted RNA exon variant
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(continued)

Variant type Oncon;:::\s (EEhE Oncomine™ Variant class Annotation criteria
Expression Gain-of-Function | Expressionlmbalance SVTYPE = "RNAExonTiles"
imbalance FILTER = "PASS"

Record meets Targeted Isoforms Detected
Requirement

Loss-of-function | Loss-of-Function Truncating Positive mutation call

truncating Functional impact is frameshift block

non-hotspot substitution, frameshift deletion, frameshift

mutation insertion, or nonsense
Occurs in a loss-of-function gene

Missense hotspot | Gain-of-Function Hotspot Positive mutation call

mutation Loss-of-Function Functional impact is missense
Transcript and coding syntax occur in
predefined missense hotspot list

In-frame hotspot | Gain-of-Function Hotspot Positive mutation call

mutation Loss-of-Function Functi(?n, transc.:ript,land coding synta?(
occur in predefined in-frame hotspot list

Splice site hotspot | Gain-of-Function Hotspot Positive mutation call

mutation Loss-of-Function Transcript, Iocgtion., and exon oceur in
predefined splice site hotspot list

Intronic hotspot | Gain-of-Function Hotspot Positive mutation call

mutation Loss-of-Function Transcript, location, and coding syntax
occur in predefined intronic hotspot list

Gain-of-function | Gain-of-Function Hotspot Positive mutation call

truncating hotspot Function, transcript, and coding syntax

mutation occur in predefined truncating hotspot list
Occurs in a gain-of-function gene

Loss-of-function | Loss-of-Function Truncating Positive mutation call

truncating hotspot Function, transcript, and coding syntax

mutation occur in predefined truncating hotspot list
Occurs in a loss-of-function gene

MNV hotspot Gain-of-Function Hotspot Positive mutation call

mutation Loss-of-Function Transcript and coding syntax occur in MNV
hotspot list
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Variant type

Oncomine™ Gene
class

Oncomine™ Variant class

Annotation criteria

EGFR exon 19
deletion

Gain-of-Function

EGFRExon19Deletion

Positive mutation call

Functional impact is nonframeshift deletion,
nonframeshift block substitution

Deletion impacts codons 744-761 of EGFR

EGFR exon 20
insertion

Gain-of-Function

EGFRExon20Insertion

Positive mutation call

Functional impact is nonframeshift
insertion, nonframeshift block substitution

Insertion impacts codons 762-775 of EGFR
or variant is in EGFR exon 20 insertion
confirmed list

ERBB2 exon 20
insertion

Gain-of-Function

ERBB2Exon20Insertion

Positive mutation call

Functional impact is nonframeshift
insertion, nonframeshift block substitution

Insertion impacts codons 770-783 of
ERBB2

KIT exon 11 Gain-of-Function KITExon11Deletion Positive mutation call

deletion Functional impact is nonframeshift deletion,
nonframeshift block substitution
Deletion impacts codons 550-580 of KIT
Alternatively, mutation occurs in splice site
flanking the 5' end of exon 11

KIT exon 11 Gain-of-Function |  KITExon11Insertion Positive mutation call

insertion Functional impact is nonframeshift
insertion, nonframeshift block substitution
Insertion impacts codons 550-580 of KIT

MET exon 14 Gain-of-Function | METExon14Skipping Positive mutation call

skipping Location is splice site in MET exon 14, is

intronic >= 4bp deletion in 30 nucleotides
preceding MET exon 14, or variant is in
MET Exon 14 Skipping confirmed list

PDGFRA exon 18
deletion

Gain-of-Function

PDGFRAExon18Deletion

Positive mutation call

Functional impact is nonframeshift deletion,
nonframeshift block substitution

Deletion impacts codons 841-847 of
PDGFRA

For more information, see the Genexus™ Software help system or contact support.
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Genexus™ reagent strip and panel tube fill volume guide

You can use the figures below to check for appropriate fill volume of library and template strip tubes,
and Oncomine™ Precision Assay GX primer pool tubes. Print this page at 100% and keep as a
reference. If a fill volume appears inaccurate, contact Technical Support to report the problem. "E"
indicates an empty tube.

(D) Genexus™ Strip 1 (4) Genexus™ Strip 4
@ Genexus™ Strip 2-HD @ Assay primer pool tubes
(3 Genexus™ Strip 3-GX5™
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Create a template for importing samples in standalone
configuration purification run plans

To use the Import function to import sample information from a USB drive into a standalone

configuration run plan for the Genexus™ Purification System, add the sample information to a CSV
file with a specific format. Follow these steps to create an import template file with a plain text editor, or
with Microsoft™ Excel™ software.

1. Use the format in the follow examples to set up two columns in a CSV file for Sample Name and
Notes. Populate the sample rows with sample hame and notes.

1 Sample MName,Notes

2 C5W
3 CSV
- CSV
5 C5V
6 C5V
7 CSV
B CSV
g C5W
10 CSV
11 CSV
12 CSV

OFE csv

Sample
Sample
Sample
Sample
Sample
Sample
Sample
Sample
Sample
Sample
Sample
Sample

1,C5V motes for sample
2,05V notes for sanmple
3,C5V notes for sample
4,C5V notes for sample
5,C5V notes for sample
€,C5V notes for sample
7,205V notes for sample
8,C5V notes for sample
9,C5V notes for sample
10,C5V notes for sample 10
11,C5V notes for sample 11
12,C5V notes for sample 12

LT T SR I PR BT L S8 B

@ Example file if in a plain text editor.

A

Sample Mame
CSW Sample 1
CSW Sample 2
CSV Sample 3
CSV Sample 4
CSV Sample 5
CSV Sample 6
CSV Sample 7
CSV Sample 8
CSV Sample 9
11 |CSV Sample 10
12 |CSV Sample 11
(2) 13 |GV Sample 12

(= =R = T T S TE R E T

—
[ ]

Motes

C5W notes for sample 1
CSW notes for sample 2
CSW notes for sample 3
CSW notes for sample 4
CSW notes for sample 5
C5W notes for sample 6
CSW notes for sample 7
CSW notes for sample 8
CS5V notes for sample 9
C5V notes for sample 10
C5V notes for sample 11
CSW notes for sample 12

(2 Example file in Microsoft™ Excel™ software.

The Sample Name field populates the Sample ID field in the instrument screen.

2. Save the file using a CSV file format to a USB drive.

IMPORTANT!

. Do not add extra spaces in the headings, or add other columns in either file type.

. If you transfer files between macOS™ and Windows™ computers, extra characters that can cause
errors can be added to files. Check for the presence of hidden characters, then delete if found.

. An alert is shown if fewer samples are in the CSV file than are selected for the run, or if two samples
have the same name in the CSV file. No samples are imported until the error is corrected.
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Lane usage by sample type

The capacity of the GX5™ Chip varies depending on the sample type. Table 14 provides GX5™ Chip lane
usage information for run configurations with smaller sample batch sizes. For other run configurations,
including larger batch sizes, use the following lane usage and sample plexy recommendations.

* For plasma cfTNA samples, the assay is configured to accommodate 1.5 samples per GX5™ Chip
lane (or 6 samples on a single GX5™ Chip).

* For FFPE DNA+RNA samples, the assay is configured to accommodate 4 samples per GX5™ Chip
lane.

* For FFPE DNA-only or RNA-only samples, the assay is configured to accommodate 8 samples per
GX5™ Chip lane.

Table 14 Lane usage by sample type for small sample batch sizes

Sample type Number of available lanes Capacity
cfTNA 4 6 samples
FFPE DNA+RNA 1 4 samples

2 8 samples
FFPE DNA-only or RNA-only 1 8 samples

Fusion detection methods
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Note: For fusion variants detected by expression imbalance alone (RNAExonTiles), we recommend
verifying the result using an orthogonal method.

The Oncomine™ Precision Assay GX uses the targeted panel design in combination with software
algorithms to detect known and novel gene fusion isoforms. The assay employs the following methods
to detect fusions.

Targeted method

In the targeted fusion detection method, panel primers are designed to target specific exon-exon
junctions of fusions where the driver gene, the partner gene, and the breakpoint between the driver and
the partner gene are known. The sequencing reads are mapped to a reference file that contains only the
known gene fusions.

Non-targeted method

In the non-targeted fusion detection method, the panel primers are used to detect fusions between
novel combinations of known driver and partner genes. The sequencing reads are mapped to a broader
reference, such as the whole exome. Mapping the reads to a broader reference allows for the detection
of multiple configurations of driver and partner genes as well as detection of novel breakpoints between
the known partner and driver genes.
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Exon tiling method

The exon tiling method is a partner agnostic fusion detection method that enables the discovery of
novel fusion isoforms and breakpoints. In this method, the primers are designed to target a subset

of exon-exon junctions of several driver genes (see Figure 12). Each driver gene in the test sample is
analyzed individually. After the sequencing reads undergo normalization and baseline correction, the
software measures the intragenic 3’ to 5’ expression ratio for each gene and compares the ratio to the
baseline (normal sample). Genes that do not undergo a fusion event are expected to have a 3’ to 5
expression ratio similar to the baseline (see Figure 13). Genes that undergo a fusion event typically have
a 3’ to 5’ expression ratio greater than the baseline (see Figure 14). The imbalance score measures the
magnitude of change in 3’ to 5’ expression ratio relative to the baseline. For each driver gene in which
fusion was detected, the software also predicts the most likely position of fusion breakpoint. This allows
for discovery of novel fusion breakpoints.

Imbalance score = Observed imbalance (test sample) + Expected imbalance (normal sample)

For example, if the observed (test sample) 3’ to 5’ expression ratio is 3, although the expected 3’ to 5’
imbalance for a wild type transcript is 1.5, the imbalance score is 2. Typically, an imbalance score of
>1.75-2 is indicative of a gene fusion event.

The significance of the expression imbalance is measured by the imbalance p-value. The p-value

measures the significance of the imbalance at the predicted breakpoint compared to the negative
control gene in the sample. Both, the p-value and the imbalance score are used to determine the

occurrence of a fusion event.

Exon 1 Exon 2 Exon 3 Exon 4 Exon 5 Exon 6 Exon 7 Exon 8

B am B a= B> a= B> am
B a= B a= B a=

Figure 12 Representative primer design for an exon tiling assay

5000

Read counts

1 2 3 4 5 6 7 8 9

Amplicon index (5' to 3' introns)

Figure 13 Example coverage profile for a sample with no fusion present In this example, no fusion is present
in the sample. The wild type transcript has uniform coverage of 3’ and 5’ introns.
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20000
15000

10000 O—

5000 :

0 T T T T T T T T T
1 2 3 4 5 6 7 8 9

Amplicon index (5' to 3' introns)

Read counts

Figure 14 Example coverage profile for a sample with fusion present In this example, a mixture of wild type
and fusion transcript is present in the sample. The presence of the fusion transcript accounts for the elevated expression
of the 3’ gene region.

@ Predicted fusion breakpoint

No-template controls

You can select to include a no-template control (NTC) when you plan a run in Genexus™ Software.
NTCs do not contain nucleic acid but are processed in a run alongside test samples. NTCs are used to
monitor contamination or primer-dimer formations that could produce false-positive results. Data that is
generated from the NTC is displayed in the sample QC results. For more information, see “View the QC
results” on page 129.

Reanalysis

178

If a run fails to meet one or more QC parameters defined by the assay, you can adjust the assay
parameters and reanalyze a run or a sample from the run.

Reanalysis of runs can start from the alignment, basecalling, or signal processing steps. A sample can
be reanalyzed starting only from the alignment step.

For more information, see the Genexus™ Software help system or the Genexus™ Software 6.8 User
Guide (Pub. No. MAN0026409).
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Example metrics for a successful sequencing run

The following tables summarize example metric values that have been observed from successful

sequencing runs.

IMPORTANT! The values provided in these tables are examples only. The default QC metric values are
embedded in the system-installed assay. If needed, you can set values based on your own internal data

and the quality of samples that you typically test in the lab.

Table 15 Example metrics for FFPE DNA+RNA isolated from tumor FFPE samples

Metric Value
Run QC
Key Signal 59-82
Percent Loading 75-95%
Raw Read Accuracy 98-99%

Templating QC - CF-1 Control

Average Reads Per Lane

14,000-57,000

Base Call Accuracy 93-99%

Mean AQ20 Read Length (bp) 80-130

Sample QC - DNA

MAPD 0.17-0.50

Mapped Reads

350,000-2,300,000

Mean AQ20 Read Length (bp) 54-92
Mean Read Length (bp) 56-99
Uniformity Of Base Coverage 76-99%

Sample QC - RNA

Mapped Reads

12,000-310,000

Mean Read Length (bp)

36-102

RNA Expression Ctrls Detected

3-7
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Table 16 Example metrics for cfTNA isolated from normal plasma

Metric Value
Run QC
Key Signal 57-73
Percent Loading 89-98%
Raw Read Accuracy 98-99%

Templating QC - CF-1 Control

Average Reads Per Lane

39,000-63,000

Base Call Accuracy 98-99%
Mean AQ20 Read Length (bp) 94-116

Sample QC - DNA

MAPD 0.15-0.41

Mapped Reads

5,700,000-15,000,000

Mean AQ20 Read Length (bp) 77-93
Mean Read Length (bp) 82-101
Median Molecular Cov 325-2,315

Median Read Cov

10,000-56,000

Uniformity Of Base Coverage

94-99%

Sample QC - RNA

Mapped Reads

150,000-670,000

Mean Read Length (bp)

82-102

RNA Expression Ctrls Detected

6-7
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Clean the Genexus™ Primer Pool Tube Holder

Use this procedure to clean the Genexus™ Primer Pool Tube Holder.

Note: Dispose of all waste in appropriate liquid or solid waste containers.

1.

2.

Inspect the Genexus™ Primer Pool Tube Holder for signs of reagent accumulation.
Using lint-free wipes, wipe the Genexus™ Primer Pool Tube Holder with 70% isopropanol.

Place the Genexus™ Primer Pool Tube Holder back on top of the Primer Pool Tube Station on the
deck and allow to air-dry.

When the Genexus™ Primer Pool Tube Holder is dry, proceed with the UV Clean.

Generate a variant report

When generating a customized report, you can update any report template selections. For more
information about results files, see “Results files” on page 153.

1.

2.

In the menu bar, click Results » Sample Results.

In the Results / Sample Results screen, click the sample of interest in the Sample Name column.
Click the Reports tab.

In the Variant Report pane, click Generate Report.

In the Generate Report dialog box, enter a name for the report, an optional description, and select
the report template and language of the report.
a. If the report template includes an image from the results, select the images to include in the
report.

b. If the custom text that was designated as Editable on Report Generation when the report
template was created, enter text if needed.

If you have previously generated a variant report that has not been locked and then you select the
same report template that was used to generate the variant report, the new report and any new
selections you make override the previous variant report.

Click Generate.
A ZIP file that contains all the selected reports and other files is downloaded.

Reports that have been generated are available for download in the Reports tab and in the Sample
Results screen.
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Safety

WARNING! GENERAL SAFETY. Using this product in a manner not specified in the user
documentation may result in personal injury or damage to the instrument or device. Ensure that
anyone using this product has received instructions in general safety practices for laboratories and
the safety information provided in this document.

. Before using an instrument or device, read and understand the safety information provided in the
user documentation provided by the manufacturer of the instrument or device.

. Before handling chemicals, read and understand all applicable Safety Data Sheets (SDSs) and use
appropriate personal protective equipment (gloves, gowns, eye protection, and so on). To obtain
SDSs, visit thermofisher.com/support.

Biological hazard safety

A
A
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WARNING! Potential Biohazard. Depending on the samples used on this instrument, the surface
may be considered a biohazard. Use appropriate decontamination methods when working with
biohazards.

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids, infectious agents,

and blood of humans and other animals have the potential to transmit infectious diseases.

Conduct all work in properly equipped facilities with the appropriate safety equipment (for example,
physical containment devices). Safety equipment can also include items for personal protection,

such as gloves, coats, gowns, shoe covers, boots, respirators, face shields, safety glasses, or
goggles. Individuals should be trained according to applicable regulatory and company/ institution
requirements before working with potentially biohazardous materials. Follow all applicable local,
state/provincial, and/or national regulations. The following references provide general guidelines when
handling biological samples in laboratory environment.

. U.S. Department of Health and Human Services, Biosafety in Microbiological and Biomedical
Laboratories (BMBL), 6th Edition, HHS Publication No. (CDC) 300859, Revised June 2020
cdc.gov/labs/bmbl

. Laboratory biosafety manual, fourth edition. Geneva: World Health Organization; 2020 (Laboratory
biosafety manual, fourth edition and associated monographs)
who.int/publications/i/item/9789240011311
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Chemical safety

WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards, ensure laboratory personnel
read and practice the general safety guidelines for chemical usage, storage, and waste provided
below. Consult the relevant SDS for specific precautions and instructions:

. Read and understand the Safety Data Sheets (SDSs) provided by the chemical manufacturer
before you store, handle, or work with any chemicals or hazardous materials. To obtain SDSs, see
the "Documentation and Support" section in this document.

. Minimize contact with chemicals. Wear appropriate personal protective equipment when handling
chemicals (for example, safety glasses, gloves, or protective clothing).

. Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with
sufficient ventilation (for example, fume hood).

. Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer
cleanup procedures as recommended in the SDS.

. Handle chemical wastes in a fume hood.

. Ensure use of primary and secondary waste containers. (A primary waste container holds the
immediate waste. A secondary container contains spills or leaks from the primary container.
Both containers must be compatible with the waste material and meet federal, state, and local
requirements for container storage.)

. After emptying a waste container, seal it with the cap provided.

. Characterize (by analysis if needed) the waste generated by the particular applications, reagents,
and substrates used in your laboratory.

. Ensure that the waste is stored, transferred, transported, and disposed of according to all local,
state/provincial, and/or national regulations.

. IMPORTANT! Radioactive or biohazardous materials may require special handling, and disposal
limitations may apply.

WARNING! HAZARDOUS WASTE (from instruments). Waste produced by the instrument is
potentially hazardous. Follow the guidelines noted in the preceding General Chemical Handling
warning.
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Documentation and support

Related documentation

Document Publication number
Genexus™ Integrated Sequencer User Guide MANO0017910
Genexus™ Integrated Sequencer Quick Reference MANO0017912
Genexus™ Purification System User Guide MANO0018475
Genexus™ Primer Pool Tube Holder Product Information Sheet MAN1001399
Genexus™ Software 6.8 User Guide MANO0026409

Genexus™ Software help system

Available in the software

lon Reporter™ Software 5.16 User Guide

MANO0019148

lon Reporter™ Software 5.16 Help

Available in the software

Oncomine™ Reporter User Guide MANO0018068
Qubit™ dsDNA HS Assay Kits User Guide MANO0002326
Qubit™ RNA BR Assay Kits User Guide MANO0001987

Agilent™ 2100 Bioanalyzer™ System: 2100 Expert Software User's Guide

SD-UF0000050 (available at agilent.com)

Note: For additional documentation, see “Customer and technical support”.
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Customer and technical support

Customer and technical support

Visit thermofisher.com/support for the latest service and support information.
* Worldwide contact telephone numbers
* Product support information
- Product FAQs
— Software, patches, and updates
— Training for many applications and instruments
® Order and web support

* Product documentation
— User guides, manuals, and protocols

— Certificates of Analysis
— Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers, contact the
manufacturer.

Limited product warranty

Life Technologies Corporation and its affiliates warrant their products as set forth in the

Life Technologies' General Terms and Conditions of Sale at www.thermofisher.com/us/en/
home/global/terms-and-conditions.html. If you have questions, contact Life Technologies at
www.thermofisher.com/support.
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